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Welcome
This manual includes embedded video files 
that help demonstrate features that are more 

easily explained in video format. If you receive a 
warning about Acrobat not being able to connect 
to a flashserver while trying to play the file, please 
refer to “Using the Embedded Media Files” on page 
1 in your Anime Studio Tutorial Manual for 
instructions on how to disable the warning.
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Chapter 1: Introduction
Anime Studio is a complete animation system for creating 
2D anime and cartoons. This document is the user’s 
manual, containing useful information to get you started, 
as well as a detailed reference to all of Anime Studio’s 
features.

If you’re just getting started using Anime Studio, the best 
place to begin is with the quick start tutorials, which 
appear in “Quick Start” on page 3 in your Anime 
Studio Tutorial Manual.  Choose Help > Tutorials to open 
the manual in PDF format. This section will give you a quick 
overview of how Anime Studio works, and what you can 
do with it. Even if you’ve used Anime Studio in the past, you 
might want to give the tutorials a quick read to see what’s 
changed in this version.

If you’ve been using Anime Studio for a while now, and 
you want more information on some specific feature or 
interface element, choose the section that interests you 
from the table of contents.

Finally, if you’re having a problem that just isn’t answered 
in this document, please see “Appendix B: Technical 
Support” on page 295. We want to do everything we 
can to make using Anime Studio a fun and productive 
experience.

Demo Limitations
If you haven’t purchased a copy of Anime Studio, then 
the program will be running in demo mode. While in demo 
mode, Anime Studio still allows you access to all features 
of the program. Anything you can do in the full version 
you can do in the demo. Also, any files you create with 
the demo version of Anime Studio will still work fine if you 
purchase the full version.

The demo version has just three limitations: First, you can 
only run the demo version of Anime Studio for 30 days. 
Second, you cannot import any external file formats 
including images and movies. Third, you cannot export 
your animations to other formats (QuickTime, AVI, Flash, 
etc.).

To purchase Anime Studio, go to http://store.smithmicro.
com/.
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New Features in Anime Studio 10

Major New Features

• Transform Bones Tool: A single tool now allows you to 
translate, rotate, and scale bones. See “Transform 
Bone” on page 68 for more information.

• New Drawing Tools, include:

 � Blob Brush Tool: The new Blob Brush tool allows 
you to quickly and easily create vector shapes 
and outlines by painting on the screen. See “Blob 
Brush” on page 42 for more information.

 � Eraser Tool: Allows you to erase portions of a 
selected shape. See “Eraser” on page 44 for 
more information.

 � Point Reduction Tool: Allows you to reduce the 
number of points in a selected object by painting 
over the areas you want to optimize. See “Point 
Reduction” on page 45 for more information.

• Transform Points Tool: The Translate Points, Rotate 
Points, and Scale Points tools have been combined 
into a single tool. See “Transform Points” on page 29 
for more information.

• Freehand Tool: Points are automatically hidden when 
you use the Freehand tool so that you can get a more 
accurate preview while you draw. See “Freehand” on 
page 36 for more information.

• Multiple Document Support: Anime Studio now allows 
you to open more than one document at a time, and 
switch from one to another in a tabbed interface. See 
“Open...” on page 231 and “Show Document Tabs” 
on page 273

• Keyboard Shortcut Editor: The Help > Edit Keyboard 
Shortcuts command allows you to create and save 
your own keyboard shortcut configurations. See 
“Edit Keyboard Shortcuts” on page 280 for more 
information.

• Multiple Shape Selections: The Select Shape tool now 
allows you to select multiple shapes so that you can 
change fill, stroke, or both simultaneously. Basic color 
controls have also been added in the options bar. See 
“Select Shape” on page 48 for more information.

• Frame Zero and Sequencer: Each layer now has its 
own “frame zero”, allowing you to perform actions 
normally confined to frame zero when the start point of 
a layer has been moved to a negative frame value.
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• Hide Points and Bones to reduce clutter in your 
document window, with the following commands:

 � The Draw > Hide Selected Points command hides 
selected points so that you do not accidentally 
select them while editing other nearby points. The 
objects associated with those points are still visible 
in the document window. See “Hide Selected 
Points” on page 261 for more information.

 � The Draw > Show All Points command unhides 
points that have previously been hidden. 
See “Show All Points” on page 262 for more 
information.

 � The Bones > Hide Selected Bones command allows 
you to hide selected bones to make it easier 
to focus on specific bones in your scene. See 
“Hide Selected Bones” on page 265 for more 
information.

 � The Bones > Show All Bones command unhides 
bones that have previously been hidden. 
See “Show All Bones” on page 265 for more 
information.

• Paint Bucket Tool: The Paint Bucket tool now allows 
you to fill closed shapes that are not welded. The fill is 
created as a separate object. See “Paint Bucket” on 
page 54 for more information.

• GPU Acceleration allows higher quality display of 
strokes and transparencies in images.

• Multiple Layer Editing: Select multiple layers, including 
layers of different types, and apply changes to multiple 
layers at the same time. See “Editing Multiple Layers” 
on page 129 for more information. 

• Variable Width Curves: Line widths are now calculated 
based on percentage values. See “Line Width” on 
page 59 for more information.

• Particle Layers: Particle layers can now use arbitrary 
shapes to generate particles. See “Particle Layers” on 
page 122 and “Particles Tab” on page 221.

• Blur improvements and Threshold: Any feature that uses 
blur (layer blurs, shadows, shading, various fill effects) 
now accepts floating point blur radius values. This 
allows for blurs that can be animated more accurately 
between keyframes. Threshold works in conjunction 
with blur. Thresholds can be applied to layers, shadows, 
and shading to produce smoother transitions in corners. 
You’ll find new Threshold options in Layer Shadows, 
Layer Shading, and in some of the fill effects.
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Blur and threshold options are found in the 
following sections: “Layer Shadow” on page 

142; “Layer Shading” on page 142; “Shaded Fill 
Effects” on page 169; “Soft Edge Fill Effects” on 
page 170; “Shaded Fill Effects” on page 169; and 
“Drop Shadow” on page 173

• Colorization of layers: The new Colorize Layer 
feature allows you to overlay a color on a layer. See 
“Colorizing” on page 137.

• Media Plugins/Export Animation: More video formats 
are supported in Windows and Macintosh versions. 
See “Export Animation...” on page 240 for more 
information.

• Content Library Updates: The Library palette now 
uses the same color scheme that you specify in 
Preferences.

• Preview image saved with project: When saving 
documents, a preview thumbnail is saved with the 
project. See “Save” on page 231.

• Automatic Update checking: See “Automatic Update 
Checking” on page 11 for more information.

• Activation, Serial, and License Management: Anime 
Studio now prompts you to activate and serialize your 
software. See “Activating Anime Studio” on page 
6

System Requirements

Windows: 

• Windows® 7, 8, 8.1 or newer

• 1.3 GHz Pentium 4 or newer, Athlon 64 or newer 

• 2 GB RAM recommended

• 700 MB free hard drive space minimum

• OpenGL enabled GPU recommended

• 1024x768 display (1280x800 recommended)

• DVD-ROM drive (physical version only)

• Internet connection for product activation 
recommended

• Windows® Internet Explorer® 9 or newer
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Macintosh: 

• Macintosh® OS X 10.8, 10.9 or newer 

• 64-bit OS required

• 1.3 GHz Intel Processor or newer

• 2 GB RAM recommended

• 700 MB free hard drive space minimum

• 1024x768 display (1280x800 recommended)

• DVD-ROM drive (physical version only)

• Internet connection for product activation 
recommended

During installation, the Anime Studio installer 
checks to see if a previous installation of the 

same installer exists on your system. The installer will 
prompt you to uninstall the previous version before 
continuing (recommended).

Activating Anime Studio
After you install Anime Studio, you will be prompted to 
enter your serial number and activate your Anime Studio 
license. If the product has not yet been activated, will be 
prompted to activate your Anime Studio installation at 
launch time. If you do not activate your serial number, the 
product will deserialize.

After you enter your serial number, your 
license must be activated within seven days.

Activation requires an internet connection

A product that has not been activated will run in trial mode 
until the trial period expires. If the trial period has expired, 
you must activate it in order to use the product.

Getting Started
After you install Anime Studio, you might want to familiarize 
yourself with the many features contained in the program.

When you start Anime Studio, a splash screen presents the 
following options:
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• Introductory Tutorial: Opens the Tutorial Manual, which 
you can also open using the Help > Tutorial Manual 
command from the Anime Studio menu.

• Bonus Content Pack: Opens your Web browser to the 
Content Paradise web site, specifically to the Anime 
Studio bonus content page. A Content Paradise 
account and valid Anime Studio serial number are 
required to add the free content to your shopping 
cart. You can also navigate to this page by choosing 
the Help > Download Bonus Content Pack command 
from the Anime Studio menu.

• Register Your Product: Opens your Web browser to 
the Smith Micro registration page, where you are 
prompted to enter registration information for your 
Smith Micro software products. You can also navigate 
to this page by choosing the Help > Register Your 
Product command from the Anime Studio menu.

• ContentParadise.com: Opens your Web browser to 
the Content Paradise home page, where you can 
order content for Anime Studio and other Smith Micro 
software products. You can also navigate to this page 
by choosing the Help > Buy Content command from 
the Anime Studio menu.

• Don’t Show This Again: Choose this command to 
prevent the splash screen from opening each time you 
start Anime Studio.

 Splash Screen

Creating a Content Folder
When you first start Anime Studio, you will be asked if you 
want to create a folder to store your custom content.  
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After the content folder is created, a hierarchy of folders 
appears beneath it. Any content stored in these locations 
will appear in the “My ...” folders in the Librarty (such as 
“My Characters” in the Characters library and so on. This 
allows you to store user-created word balloons, brushes, 
and other custom items that you can use in Anime Studio.  
In addition, the support files for the Tutorial manual can also 
be found in the Custom Content folders.

 Choosing a content folder.

The choices are as follows:

• Choose: Select this option to browse to the folder that 
you want to use for your Anime Studio content. After 
you select/create the folder, choose OK.

• Not Now: Choose this option if you want to set up the 
folder at a later time. You will be prompted with this 
dialog the next time you start Anime Studio.

• Never: Choose this option if you do not want to set up 
a folder, and no longer want to receive this prompt 
when you start Anime Studio.

If you choose to never show the dialog that 
prompts you to create a content folder, you 

can choose the  Help > Set Custom Content Folder 
command at any time to specify a content folder 
location.

Choosing Your Startup Mode
When you first start Anime Studio Debut, you are asked if 
you want to start in Standard Mode, or Beginner Mode.

 Choosing your startup mode.

You can also switch to and from Beginner Mode by 
checking or unchecking the Beginner Mode option in 
the upper-right corner of the Anime Studio user interface. 
When you check that option, the tool box on the left side 
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displays the most commonly used tools as shown in the 
next figure.

 Beginner Mode option

Standard Mode
If you choose Standard mode, various tools appear in the 
tool bar at the left side of the interface. If the number of 
tools feels overwhelming to you as a new user of Anime 
Studio, you can configure Anime Studio to display the most 
commonly used tools, along with introductory videos that 
show you how to use them.

 Standard UI

Beginner Mode
If you are new to Anime Studio, you may find that the 
beginner’s interface will be a good place to start.
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 Beginner Mode UI

When in the Beginner Mode, the tool box displays the 
following:

• Draw Tools: Displays the Select Points, Transform 
Points, Transform Points, Transform Points, Add Point, 
Freehand, Draw Shape and Delete Edge tools. For more 
information on these tools, see “Chapter 3: The Draw 
Tools” on page 25.

• Fill Tools: Displays the Select Shape, Create Shape, and 
Paint Bucket tools, all discussed in “Chapter 4: Fill Tools” 
on page 48.

• Bone Tool: Displays the Manipulate Bones tool, 
discussed in “Chapter 5: Bone Tools” on page 65.

• Layer Tools: Displays the Transform Layer tool, discussed 
in “Chapter 7: Layer Tools” on page 87.

• Workspace Tools: Displays the Pan tool, discussed in 
“Chapter 9: Camera and Workspace Tools” on page 
116.

• Tool Tip: As you hover the mouse over any tool, a 
Tool Tip displays the name of the tool, along with a 
keyboard shortcut that you can use to select the tool 
at any time.

• Tool Help: When a tool is selected, an extended 
description of the tool appears in the lower section 
of the tool box. The description also includes basic 
instructions on how to use the selected tool.

• Video Button: Click the Video button in the extended 
description area to watch a video that shows you how 
to use the selected tool.
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 Beginner Mode Tools

Automatic Update Checking
The first time you start Anime Studio, you will be asked if 
you want to be notified of automatic updates. The dialog 
options are as follows:

 Software Update dialog

• Check Automatically: Anime Studio will automatically 
check for software updates upon startup.

• Don’t Check: Select this option if you do not want to 
be notified of updates. You can update Anime Studio 
at any time by choosing the Help > Check for Updates 
command.

You can change your update notification 
preference at any time in the Options tab of 

the Preferences dialog. See “Options Tab” on page 
252 for more information.
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Chapter 2: License
Anime Studio Debut 10

End User License Agreement and 
Limited Warranty
PLEASE READ THIS END USER LICENSE AGREEMENT (“EULA”) 
CAREFULLY BEFORE INSTALLING AND USING THE SOFTWARE.  
BY CLICKING THE “AGREE” BUTTON WHEN INSTALLING THE 
SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE 
TERMS OF THIS EULA.  IF YOU DO NOT AGREE TO THE TERMS 
OF THIS EULA, CLICK ON THE “DISAGREE” BUTTON.  IF YOU 
DO NOT AGREE TO THE TERMS OF THIS EULA, YOU MAY NOT 
USE OR ACCESS THE SOFTWARE.  USING OR ACCESSING 
ANY PART OF THE SOFTWARE INDICATES THAT YOU AGREE 
TO THE TERMS OF THIS EULA.

This EULA is between you (both the individual installing the 
Software and any single legal entity on behalf of which 
such individual is acting) (“you” or “your”) and Smith 
Micro Software, Inc. and/or its affiliates (collectively or 
individually, “SMSI”).

1. General
You agree to use the Software, Documentation and 
Content only for lawful purposes.  Any use of the Software, 
Documentation or Content other than as granted in 
this EULA must be by SMSI’s prior written consent.  SMSI 
maintains an ongoing EULA enforcement program.  
Violation of any provision of this EULA automatically 
terminates this EULA.  SMSI reserves all other rights that it 
may have for violation of this EULA.

2. Definition
“Content” means animations, characters, clothing, faces, 
hair, geometries, images, documentation, materials, 
meshes, morphs, motion files, props, scripts, textures, bump 
maps, transparencies, and similar files and data created or 
modified with the intent of being used within the Software 
and/or third party applications.

“Documentation” means all written material in any form 
for installation and use of the Software provided by or 
made available by SMSI, or its authorized representatives 
or agents.

“Legitimate Uses” means (a) creating tutorials, books, or 
other educational materials using images of the Software 
interface or Content for sale, distribution, public display, or 
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public performance, provided such materials are intended 
to educate users as to use of the Software; (b) creating 
original Content for sale, distribution, public display, or 
public performance; (c) creating materials for use with 
either Restricted Content or Other Content; (d) creating 
rendered animations or rendered still images based 
on Restricted Content contained with the “Character 
Wizard” feature of the Software; or (e) creating characters 
or props based on Restricted Content in proprietary file 
formats (meaning, MOHO, ANME and any subsequent/
compressed formats), where the original (or modified) art, 
texture or other Restricted Content files are not distributed 
with such characters or props.

“Other Content” means Content that is not Restricted 
Content or Unrestricted Content.  Other Content may be 
subject to license terms imposed by the Other Content’s 
original creator.

“Restricted Content” means all Content included with 
or part of the Software that is not Unrestricted content, 
including without limitation mesh objects (geometry) 
in any format, files in proprietary file formats (meaning, 
MOHO, ANME, and any subsequent/compressed 
formats), images, materials, texture, transparency maps, 
Documentation, vector-based content, and SMSI’s 
proprietary data.  Except as otherwise expressly permitted 
by this EULA, Restricted Content extracted or exported 
from the Software remains Restricted Content.  Except as 

authorized in this EULA, Restricted Content may only be 
used exclusively on one (1) computer.

“Software” means the SMSI computer software and 
associated files (e.g. Content) delivered via the 
accompanying physical media or electronic media.  
“Software” means to also include any upgrades, updates, 
bug fixes or modified versions or backup copies of the 
Software supplied to you by SMSI or an SMSI authorized 
representative or agent (whether or not for a fee).  
“Software” does not include TPS (defined below).

“Unrestricted Content” means Content included with 
or part of the Software that is specifically identified in 
the Documentation or listed in this EULA as Unrestricted 
Content.  This version of the Software contains no 
Unrestricted Content.

3. Software License
A)  Subject to the terms and conditions of this EULA and 
your payment of the applicable license fee, SMSI grants 
you a limited, personal, nontransferable and non-exclusive 
license (without right to sublicense): (i) to use a single 
copy of the Software (except as expressly permitted in the 
Documentation) solely for your own internal use on a single 
computer (as set forth in Subsection E below of this Section 
3) either loaded in the temporary memory (i.e., RAM) of 
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a computer, or installed on the permanent memory of 
a computer (e.g., hard disk and compact disk) or, on a 
temporary basis, on a backup system if such equipment 
is inoperative, consistent with the limitations specified or 
referenced in this EULA and the Documentation; (ii) to use 
the Documentation provided with the Software in support 
of your authorized use of the Software; and (iii) to copy the 
Software to make one (1) archival copy of the Software 
for your personal archival or backup purposes, and to 
make sufficient number of copies for Legitimate Uses or the 
intended use described in the Documentation, provided 
that all titles and trademark, copyright and restricted rights 
notices are reproduced on all such copies.  Any other uses 
of the Software, including without limitation the Software 
interface, other than those granted in this EULA must be 
expressly pre-approved by SMSI in writing.  The terms of 
this EULA will govern any upgrades and updates, unless 
accompanied by a separate license, in which case, the 
terms of that separate license agreement will govern 
accordingly.

B) The Software is protected by copyright and other 
intellectual property laws and international treaties.  As an 
express condition of this EULA, you must reproduce on the 
backup copy the SMSI copyright notice in the following 
format: “Copyright (C) 2004-2014 Smith Micro Software, 
Inc. All Rights Reserverd.”  This express condition extends 
to any further updates, software patches, or bug fixes 

made available to you by SMSI, whether distributed on 
floppy disk, compact disk, or in an electronic format via 
download, BBS, forum, FTP, e-mail, etc.

C) The Software (not including the media on which 
the Software may be provided) is licensed to you, 
not sold.  You expressly acknowledge that SMSI, Lost 
Marble, Inc., and/or their respective licensor(s) have a 
valuable proprietary interest in both the Software and the 
Documentation.  All title, ownership, interest and rights in 
and to the patent, copyright, trademark, trade secret and 
any other intellectual property rights in the Software (and 
any derivative works thereof) and the Documentation (and 
any derivative works thereof) not expressly granted to you 
by this EULA remain with SMSI, Lost Marble, Inc. and/or their 
respective licensor(s).  You do not acquire any other rights, 
express or implied, in the Software (and any derivative 
works thereof) and the Documentation (and any derivative 
works thereof) other than those rights expressly granted 
under this EULA.  Without limiting the generality of the 
foregoing, SMSI, Lost Marble, Inc. and/or their respective 
licensor(s) retain all title, ownership, interest and rights in 
and to the patent, copyright, trademark, trade secret and 
any other intellectual property rights in the copy of the 
Software contained on your archival media, and all of the 
terms of this EULA apply to such archival copy as if it were 
the original SMSI-produced copy of the Software that was 
furnished to you when you paid the licensing fee.
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D) Portions of the Software include third party software 
and other copyrighted material (collectively, “TPS”).  
Acknowledgements, licensing terms, restrictions and 
disclaimers of such TPS are contained in the “About Box” of 
the Software and your use of such TPS is governed by such 
respective terms.  Any terms of this EULA that differs from 
the terms of any TPS are offered by SMSI alone, and not by 
any other licensor.

E) Except as otherwise expressly permitted in the 
Documentation, you will only use the Software on a single 
computer at any given time, meaning that you must treat 
the Software “like a book.” “Like a book” means that the 
Software may be used by any number of people and may 
be installed and activated on up to three (3) computers 
so long as no possibility exists of the Software being used 
at more than one (1) computer at any given time.  More 
than one person at a time cannot read the same copy of 
a book, and this restriction applies to the Software.

F) The licenses granted in this EULA do not allow you to 
use the Software on a computer that you do not own or 
control, and you may not distribute or make the Software 
available over a network where it could be used by 
multiple computers or devices at the same time.

4. Restrictions
A) You will not, and will not permit any third party to, 
use, copy, modify, derive, or transfer the Software or 
Documentation, or any copy, modification, derivation, 
or merged portion thereof, in whole or in part via any 
means or for any purpose whatsoever except as expressly 
permitted in this EULA or the Documentation.  You will 
not, and will not permit any third party to, modify, adapt, 
translate, rent, lease, loan, resell for profit, or create 
derivative works based upon the Software or any part 
thereof.  The Software contains trade secrets in its human 
readable form and, to protect them, you will not, and will 
not permit any third party to, reverse engineer, decompile, 
disassemble, or otherwise reduce the Software to any 
human readable form without the express prior written 
consent of SMSI or except to the extent expressly permitted 
by applicable law.  You will not relicense, sublicense, 
rent, lease, or lend the Software for third-party training, 
commercial time-sharing or service bureau use.  You will 
not, and will not permit any third party to, debug, bypass, 
circumvent or defeat any security features of, or interfere 
with the normal functionality and operation of the Software 
for any reason whatsoever without the express prior written 
consent of SMSI or except to the extent expressly permitted 
by applicable law.  If the Software is an upgrade to a 
previous version of the Software, you must possess and 
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maintain a valid license to such previous version in order to 
use the upgrade.

B) You, your employees, and/or authorized agents must 
protect the Software’s confidentiality and act to enforce 
your obligations under this EULA.  You cannot distribute or 
otherwise make the Software or Documentation available 
to any third party via any means whatsoever, public 
or private, for any purpose, commercial or not, unless 
explicitly allowed by this EULA.

C) You assume full responsibility for your selection of the 
Software to achieve your intended results and for the 
installation, use, and results you obtain from the Software.  
SMSI has no obligation to provide support, maintenance, 
upgrades, modifications or new releases under this EULA.

5. Content License
A) Subject to the terms and conditions of this EULA and 
your payment of the license fee, SMSI grants you a limited, 
personal, nontransferable and non-exclusive license 
(without the right to sublicense):

1) To reproduce, prepare derivative works based upon, 
distribute, publicly display and publicly perform the 
Unrestricted Content for any lawful purpose other than 
to create a product which is intended to compete 

with the Software or to create new content which is 
intended to compete with the Restricted Content.

2) To prepare derivative works based upon the 
Restricted Content solely for Legitimate Uses and lawful 
uses.

3) To reproduce, prepare derivative works based 
upon, distribute, publicly display, and publicly perform 
content you create using Restricted Content, provided 
that such use of Restricted Content shall be solely for 
Legitimate Uses and lawful uses.

B) Notwithstanding the foregoing, nothing shall limit SMSI’s 
right to independently create, develop, own, market, 
distribute, license, sublicense, import, export, sell, or 
otherwise exploit any content or materials similar to any 
derivative works based upon the Content.

C) Other Content included with the Software and 
Documentation is subject to third-party rights and 
is copyrighted and owned by the Other Content’s 
original creator(s).  You may use the Other Content in 
accordance with all applicable license terms imposed 
by the Other Content’s original creator(s).  SMSI makes no 
representations as to the quality, suitability, functionality, 
or legality of the Other Content and you hereby waive 
any claim you might have against SMSI with respect to the 
Other Content.
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D) You will not, and will not permit any third party to, use, 
copy, modify, derive, sell, distribute, transfer or sublicense 
the Restricted Content, the Unrestricted Content, or the 
Other Content or any copy, modification, derivation, or 
portion thereof, in whole or in part via any means or for any 
purpose whatsoever, except as expressly permitted in this 
EULA or the Documentation.

E) You expressly acknowledge that SMSI, Lost Marble, 
Inc. and/or their respective licensor(s) have a valuable 
proprietary interest in the Restricted Content and the 
Unrestricted Content.  All title, ownership, interest and 
rights in and to the patent, copyright, trademark, trade 
secret and any other intellectual property rights in the 
Restricted Content (and any derivative works thereof) 
and the Unrestricted Content (and any derivative works 
thereof) not expressly granted to you by this EULA remain 
with SMSI, Lost Marble, Inc. and their respective licensor(s).  
You do not acquire any other rights, express or implied, in 
the Restricted Content (and any derivative works thereof) 
and the Unrestricted Content (and any derivative works 
thereof) other than those rights expressly granted under this 
EULA.

F) Except as otherwise expressly permitted in the 
Documentation or unless otherwise provided for herein, 
you will only use the Content on up to one (1) computer at 
any given time (the same as the Software license allows), 
meaning that you must treat the Content “like a book.”  

SMSI is pleased to offer site licenses (“Site License”) for 
multiple simultaneous users.  Please contact SMSI at the 
address below for details.  If you purchased a Site License, 
you may distribute the Restricted Content between all 
computers containing valid copies of the Software, other 
SMSI products, and/or other software able to process 
Restricted Content.

6. Collection and Use of Your 
Information
A) Upon your first installation of the Software, you will 
have the option to register the Software with SMSI.  If you 
choose to register the Software with SMSI, you agree that 
SMSI and/or its affiliates may collect and process such 
information about you and the Software in order to enable 
SMSI to: (i) notify you of updates, bug fixes and/or modified 
versions of the Software; (ii) provide support and assistance 
of the Software; (iii) notify you of new version offerings of 
the Software; and (iv) comply with all applicable laws 
and/or regulations, or the requirements of any regulatory 
authority or government agency.

B) In addition, upon your first installation of the Software, 
you will have the option to “opt-in” to participate in SMSI’s 
efforts to improve the usability, experience, functionality 
and performance of its products and services.  Your 
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participation to allow SMSI to collect such usage statistics 
is voluntary.  And, you may “opt out” at any time.  If you 
choose to participate, SMSI may collect and use certain 
information related to your use of the Software and 
aggegrate such data that includes information about: 
(i) your computer, such as Operation System, screen 
resolution, RAM capacity, CPU frequency, number of 
monitors; (ii) data about the Software, such as abnormal 
terminations, number of runs, program version; and (iii) 
information about separate feature usage, such as menu 
options or buttons selected.  This data ((i) through (iii) 
above) is (I) collected anonymously, unless you opt to 
provide your details (as noted above) and (II) tied up to 
your personal account through an anonymous unique 
identifier (i.e., it will not include any personal identifiable 
data (e.g., e-mail address, name, gender, age, home/
work address, and telephone number).  If you are not 
comfortable sharing the foregoing described information in 
detail, please choose not to participate.

C) Any information collected is done and utilized in 
accordance with SMSI’s Privacy Policy.  Your election to 
use the Software indicates your acceptance of the terms 
of the SMSI Privacy Policy, so please review the policy 
carefully and check our website at the following URL to 
review updates:  http://www.smithmicro.com/.  Further, 
if you are located in the European Economic Area (EEA), 
your use of the Software constitutes consent by you to 

SMSI’s and/or its affiliates’to the transfer of such information 
to a location outside the EEA.

7. Term; Termination
A) This EULA remains in full force and effect until terminated.  
You may terminate this EULA at any time by returning 
or destroying both the Software and Documentation, 
together with all copies, modifications, and merged 
portions of the Software and the Documentation in any 
form.  SMSI is in no way obliged to issue refunds.  SMSI may 
terminate this EULA at any time upon your breach of any of 
the provisions hereof.

B) Upon termination, you will immediately cease all use of 
the Software, and you must return or destroy the Software, 
Documentation, and all copies, modifications, and 
merged portions of the Software and the Documentation 
in any form and certify in writing your compliance of this 
paragraph to SMSI.  Termination of this EULA for any reason 
in no way limits SMSI’s right to continue enforcing all rights 
provided by law and does not entitle you to a refund of 
your license fees, except as provided herein.  All provisions 
of this EULA that protect SMSI’s proprietary rights continue in 
full force and effect after termination.

http://www.smithmicro.com/
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8. Export Law Assurances
Export and re-export of this Software and Documentation 
is governed by the laws, restrictions and regulations of 
the United States and applicable export and import laws, 
restrictions and regulations of certain other countries 
(collectively, “Export Laws”).  You will comply with all such 
Export Laws.  Export or re-export of this Software and/or 
Documentation (including any direct product thereof) 
to any entity on the Denied Parties List and other lists 
promulgated by various agencies of the United States 
Federal Government is strictly prohibited.  In addition, 
if the Software is identified as an export controlled item 
under the Export Laws, you represent and warrant that 
you are not a citizen of, or located within, an embargoed 
or otherwise restricted nation (e.g., Iran, Syria, Sudan, 
Cuba and North Korea) and that you are not otherwise 
prohibited under the Export Laws from receiving the 
Software.

9. Limited Warranty and Disclaimer
A) SMSI warrants that any media on which the Software 
may be provided will be free from defects in materials and 
workmanship under normal use for a period of ninety (90) 
days from the date of original purchase.  Your exclusive 
remedy and SMSI’s entire liability under this limited warranty 

will be for SMSI, at its option, to replace the Software media 
or refund the purchase price of such Software media.  
This limited warranty is offered solely by SMSI and does 
not apply to any third party product, software, content 
or service offerings.  THE ABOVE WARRANTIES ON MEDIA 
ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, AND SMSI EXPRESSLY DISCLAIMS ALL 
OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, SATISFACTORY 
QUALITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT.

B) TO THE EXTENT NOT PROHIBITED BY APPLICABLE LAW, 
THE SOFTWARE, RESTRICTED CONTENT, UNRESTRICTED 
CONTENT, AND DOCUMENTATION ARE LICENSED TO YOU 
“AS IS” WITH ALL FAULTS, WITHOUT WARRANTY, CONDITION 
OR REPRESENTATION, EXPRESS OR IMPLIED, OF ANY KIND, 
INCLUDING WITHOUT LIMITATION, MERCHANTABILITY, 
PERFORMANCE, SECURITY, SATISFACTORY QUALITY, NON-
INFRINGEMENT OF THIRD PARTY RIGHTS, OR FITNESS FOR A 
PARTICULAR PURPOSE.

C) YOU ACKNOWLEDGE THAT THE SOFTWARE MAY NOT 
(I) SATISFY ALL YOUR REQUIREMENTS, (II) BE FREE FROM 
DEFECTS, OR (III) OPERATE WITHOUT INTERRUPTION OR 
ERRORS.  IN ADDITION, DUE TO CONTINUAL DEVELOPMENT 
OF NEW TECHNIQUES FOR INTRUDING UPON AND 
ATTACKING NETWORKS, SMSI DOES NOT WARRANT THAT THE 
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SOFTWARE WILL BE FREE OF VULNERABILITY TO INTRUSION 
OR ATTACK.

D) THE FOREGOING LIMITED WARRANTY IS NEITHER A 
SERVICE NOR A SUPPORT CONTRACT.  NO ORAL OR 
WRITTEN INFORMATION OR ADVICE GIVEN BY SMSI, ITS 
EMPLOYEES, DISTRIBUTORS, DEALERS, REPRESENTATIVES 
OR AGENTS SHALL INCREASE THE SCOPE OF THE ABOVE 
WARRANTIES OR CREATE ANY NEW WARRANTIES.  YOU 
MAY HAVE ADDITIONAL WARRANTY RIGHTS UNDER LAW 
WHICH MAY NOT BE WAIVED OR DISCLAIMED.  SMSI DOES 
NOT SEEK TO LIMIT YOUR WARRANTY RIGHTS TO ANY EXTENT 
NOT PERMITTED BY LAW.  This Section 9 and Section 10, 
below, shall survive any termination of this EULA, howsoever 
caused, but this will not imply or create any continued right 
to use the Software after termination of this EULA.

10. Disclaimer of Liabilities
A) EXCEPT FOR THE EXCLUSIVE REMEDY OFFERED BY SMSI 
ABOVE AND REMEDIES THAT CANNOT BE EXCLUDED OR 
LIMITED BY APPLICABLE LAW, IN NO EVENT WILL SMSI 
OR ITS DEVELOPERS, SUPPLIERS, DIRECTORS, OFFICERS, 
EMPLOYEES, OR SUBSIDIARIES OR AFFILIATES BE LIABLE TO 
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS 
PROFIT, BUSINESS INTERRUPTION, LOSS OF DATA AND/
OR BUSINESS INFORMATION, AND THE LIKE), WHETHER 

FORESEEABLE OR UNFORESEEABLE, ARISING OUT OF THE USE 
OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, 
REGARDLESS OF THE BASIS OF THE CLAIM, EVEN IF SMSI HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR 
FOR ANY CLAIM BY ANY OTHER PARTY.  IN NO EVENT WILL 
SMSI’S AGGREGATE LIABILITY (OR THAT OF ITS DEVELOPERS, 
SUPPLIERS, DIRECTORS, OFFICERS, EMPLOYEES, OR 
SUBSIDIARIES OR AFFILIATES), UNDER OR IN CONNECTION 
WITH THIS EULA, EXCEED THE AMOUNT PAID BY YOU FOR 
THE SOFTWARE, IF ANY.  THIS LIMITATION WILL APPLY EVEN IN 
THE EVENT OF A FUNDAMENTAL OR MATERIAL BREACH OR 
A BREACH OF THE FUNDAMENTAL OR MATERIAL TERMS OF 
THIS EULA.

B) The above limitations will apply even if any warranty 
or remedy provided under this EULA fails of its essential 
purpose.  The above limitations will not apply in case of 
personal injury (including death) only where and to the 
extent that applicable law requires such liability.  Because 
some jurisdictions do not allow the exclusion or limitation 
of implied warranties or liabilities for consequential or 
incidental damages, the above limitations may not apply 
to you.

11. Indemnification
You will indemnify and hold harmless, and at SMSI’s request 
defend, SMSI and its affiliates, successors and assigns 
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from and against any and all claims, losses, liabilities, 
damages, settlements, expenses and costs (including, 
without limitation, attorneys’ fees and court costs) which 
arise out of or relate to any third party claim or threat 
thereof that your use of the Software, Documentation or 
Content is unlawful or not otherwise permitted by this EULA.  
SMSI reserves the right, at its own expense, to assume the 
exclusive defense and control of any matter otherwise 
subject to indemnification hereunder.

12. U.S. Government Restricted Rights
The Software and Documentation are provided with 
RESTRICTED RIGHTS.  The use, duplication, or disclosure by 
the United States Government is subject to restrictions as 
set forth in subparagraph (c)(1)(ii) of the Rights in Technical 
Data and Computer Software Clause at DFARS 252.227-
7013 or subparagraph (c)(1) and (2) of the Commercial 
Computer Software Restricted Rights at 48 CFR 52.227-19, 
as applicable. The Manufacturer is Smith Micro Software, 
Inc., 51 Columbia, Aliso Viejo, CA 92656 USA.

13. Applicable Law
This EULA shall be governed by the laws of the State of 
California, without giving effect to any choice of law 
principles.  This EULA will not be governed by the United 

Nations Convention on Contracts for the International Sales 
of Goods, the application of which is expressly excluded.  
Exclusive jurisdiction over and venue of any suit arising out 
of or relating to this EULA will be in the state and federal 
courts of Orange County, California.  If for any reason 
a court of competent jurisdiction finds any provision, 
or portion thereof, to be invalid or unenforceable, the 
remainder of this EULA shall continue in full force and 
effect.  The waiver by either party of any default or breach 
of this EULA will not constitute a waiver of any other or 
subsequent default or breach.  You may not assign, 
sell, transfer, delegate or otherwise dispose of, whether 
voluntarily or involuntarily, by operation of law or otherwise, 
this EULA or any rights or obligations under this EULA without 
SMSI’s prior written consent.  Any purported assignment, 
transfer or delegation by you will be null and void.  This 
EULA constitutes the entire agreement between the parties 
and supersedes all prior or contemporaneous agreements 
or representations, written or oral, concerning the subject 
matter of this EULA.

14. Other Services and Materials
This Software may enable access to SMSI and/or third 
party services and websites (individually and collectively 
referred to as “Services”).  This EULA does not apply to any 
Services.  You acknowledge and agree that nothing in 
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this EULA guarantees availability or continued availability 
or uptime of any Services.  SMSI has no control over any 
third party Services.  Any terms, conditions, privacy policies, 
warranties, or representations associated with any third 
party Services are solely between you and such third party.  
SMSI makes no representations or warranties as to the 
quality, suitability, functionality, or legality of any third party 
Services, and You hereby waive any claim you might have 
against SMSI regarding any use of any third party Services.  

You understand that by using any of the Services, You 
may encounter content that may be deemed offensive, 
indecent, or objectionable, which content may or may 
not be identified as having explicit language, and that 
the results of any search or entering of a particular URL 
may automatically and unintentionally generate links or 
references to objectionable material. In addition, you 
agree not to use the Software to create content that may 
be deemed offensive, indecent, or objectionable; hateful, 
threatening, or pornographic; incites violence; or contains 
nudity or graphic or gratuitous violence.  Nevertheless, you 
agree to use the Services at your sole risk and that the SMSI 
shall not have any liability to you for content that may be 
found to be offensive, indecent, or objectionable; hateful 
threatening or pornographic; incites violence; or contains 
nudity or graphic or gratuitous violence.

15. Contact Information
If you have questions concerning this EULA or need to 
contact Customer Service, please contact SMSI at this 
address: Smith Micro Software, Inc., 185 Westridge Drive, 
Watsonville, CA 95076 USA (831) 761-6200 phone, (831) 761-
6206 fax; Customer Service (returns, warranty): service@
smithmicro.com; and Legal (EULA questions, illegal activity 
reporting): legal@smithmicro.com.

16. Copyright & Trademark Notice
Smith Micro Software, Anime Studio, Anime Studio Debut 
and Anime Studio Pro are trademarks of Smith Micro 
Software, Inc.  Lost Marble and Moho are trademarks of 
Lost Marble, Inc.  All other product names mentioned in 
the Software, the Documentation, or other documentation 
are used for identification purposes only and may be 
trademarks or registered trademarks of their respective 
companies. Registered and unregistered trademarks 
used herein are the exclusive property of their respective 
owners.  For purposes of Japan law regarding unregistered 
trademarks (e.g., a pending trademark application), the 
right in and to a trademark in Japan may not be exclusive 
until it is validly registered.  You may not remove, modify, 
alter, cover or deface any trademark, trade names, 
product names, logo, copyright or other proprietary 

mailto:service%40smithmicro.com?subject=
mailto:service%40smithmicro.com?subject=
mailto:legal%40smithmicro.com?subject=
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notices, legends, symbols or labels in the Software and 
Documentation.  This EULA does not authorize you to use 
SMSI’s or its licensors’ names or respective trademarks.  
Further, any reference to any third party commercial 
products, processes or services by trade name, 
trademark, logo, and company and/or product/service 
names mentioned or displayed in the Software (and in 
any of its related Documentation and materials in any 
form) does not constitute or imply SMSI’s endorsement, 
recommendation or favoring by SMSI or any of its suppliers/
licensors.

Version: 20140129-AnimeStudio/AnimeStudio
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Anime Studio 
Tools
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Chapter 3: The Draw 
Tools

Draw tools are used to draw and modify vector artwork. 
The following tools are available when you’re working with 
a vector layer. Most of these tools are used by selecting 
them from the toolbar then clicking and dragging in the 
working area of the main window - a few are used simply 
by clicking on them, and this is noted below. If you hold 
the mouse over a tool, a tooltip will appear with the name 
of the tool if you need a quick reminder. Also, most tools 
have a shortcut key that can be used to activate them. If 
a tool has such a shortcut, this will show up in the tooltip as 
well.

If a tool has the following symbol next to it: , then it can 
be used for animation - using the tool at different frames 
in the timeline will cause the object you adjust to change 
over time.

Anime Studio has a smart tool palette, which 
shows and hides tools based on their need. 

The position of the tool shown in the screenshots 
may differ, depending on the selected layer in the 
Layers palette, and the current time in the timeline.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

When drawing with the draw tools, you can manually 
choose to use legacy curves (such as those used in Anime 
Studio 6 and earlier) in the Layer Settings dialog. Select the 
layer you want to change in the Layers window, and open 
the Layer Settings dialog to the Vectors tab. Check the 
Legacy Curves option to use the old method of rendering 
curves.
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 You can choose legacy curves for compatibility with older 
scenes created in Anime Studio 6 and earlier.

 Normal curves (left) vs Legacy curves (right).

Select Points
Shortcut: G

 Select Points
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 Select Points options

Select Points Tool Options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Text Field: Assigns a name to the currently selected 
group of points.

• Create: Creates a group from the selected points.

• Delete: Deletes the currently selected group from the 
selection list.

• Lasso Mode: When checked, allows you to draw a 
lasso around the points you want to select. When 
unchecked, selects a rectangular area.

• Flip Horizontally: Click this button to flip horizontally.

• Flip Vertically: Click this button to flip vertically.

Using the Select Points Tool
Many of the following tools work only on the currently 
selected points. This is the tool you use to select/de-select 
points. This tool can be used in a few different ways.

The most basic way to select points is to drag a rectangle 
around them. Also, using this tool you can click on a single 
point to select it. The third method of selection is to click 
on a curve to select the entire curve. Finally, clicking on 
a filled-in area will select an entire object. Each of these 
selection methods is illustrated below:
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 Selection methods

Below is a short movie clip showing the different ways to 
select points using the Select Points tool.

Different methods of point selection (SWF file)

Modifier keys:

By holding the Shift key, you can add to a selection. 
Otherwise, you will always start a new selection when using 
this tool.

• Holding the Alt key will prevent this tool from selecting 
curves or shapes when you click on them (sometimes 
when things get crowded it’s hard not to click on a 
shape by accident).
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• If you hold down the Ctrl key (Windows) or Cmd key 
(Mac), this tool will work in lasso style. (You can also 
activate lasso style selection by turning on Lasso mode 
in the tool options area.)

The selection commands in the Edit menu are also very 
useful for managing selections. These are described in 
“Chapter 19: Edit Menu” on page 250.

The currently selected points may be deleted by pressing 
the Delete or Backspace keys.

Transform Points
Shortcut: T

 The Transform Points tool is used to move, scale, or 
rotate a group of selected points. It operates only 

on the currently selected points, unless fewer than two 
points are selected - then it operates on the nearest point 
to where you clicked.

It’s important to note that this tool, like most of the Anime 
Studio drawing tools, modifies points, not curves. If you 
select all the points in an object and use this tool, the entire 
object will move, scale, or rotate. However, if you only 
select some of the points, then you’ll end up distorting the 
object (which can be very useful).

 Transform Points

General Options
The following options appear in the left portion of the 
options toolbar when the Transform Points tool is selected:

 Transform Tool general options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.
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The following options appear in the right portion of the 
options toolbar when the Transform Points tool is selected:

 Transform Tool general options

• Auto Weld: When checked, automatically welds a 
new point to an existing point. The existing point is 
highlighted when the mouse hovers over a point that 
can be welded.

• Auto Fill: When checked, automatically fills a closed 
shape when you create it.

• Flip Horizontally: Click this button to flip horizontally.

• Flip Vertically: Click this button to flip vertically.

Translating Points
The following toolbar options are associated with 
translating points:

 Transform Points options for translating

• Position X: Allows you to numerically enter a value for 
the X coordinate.

• Position Y: Allows you to numerically enter a value for 
the Y coordinate.

In the pictures below, the selected points are highlighted in 
red. Notice the effect of using the Transform Points tool on 
these points.

• To constrain vertically or horizontally: Hold the Shift key 
while dragging the selected points left, right, up, or 
down.

• To nudge: You can nudge the selected point(s) 
by small increments by holding down the Ctrl key 
(Windows) or Cmd key (Mac) and pressing the arrow 
keys. Hold down Shift in addition to Ctrl/Cmd to nudge 
the point(s) by a greater increment.
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 Top circle fully selected. Bottom circle partially selected  After translation

• To weld points: The steps differ depending on whether 
the Auto Weld option in the toolbar is enabled or 
disabled:

 � When Auto Weld is off: To weld two points together, 
use the Transform Points tool to drag one point on 
top of another (you must drag just one point to 
weld, not a group of points). While dragging the 
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first point on top of the second, press the spacebar 
to weld them together into one point.

 � When Auto Weld is on: Anime Studio can 
automatically weld points for you. Only the 
endpoint of a curve can be automatically welded. 
To automatically weld the endpoint of a curve, 
just drag it on top of another point and let go of 
the mouse. Below is a movie demonstrating auto-
welding. After dragging each endpoint into place, 
it becomes welded to the existing point, and the 
two can be moved around

 Using Transform Points and auto-weld (SWF file)

Scaling Points
The Transform Points tool also allows you to scale the 
currently selected group of points. Two or more points must 
be selected. The following toolbar options are associated 
with scaling points:

 Transform Points options for scaling

• Scale X: Allows you to enter a numeric value for scaling 
along the X axis.

• Scale Y: Allows you to enter a numeric value for scaling 
along the Y axis.

• Apply: Click to apply the values entered in the Scale X 
and Scale Y fields

When this tool is active, a red box will appear around the 
currently selected group of points. The handles around 
the edges of this box allow you to resize the points. Drag 
a corner handle in and out to scale the points while 
maintaining their proportions. Drag one of the side handles 
to change the horizontal scale, or the top or bottom 
handle to change the vertical scale.
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If you hold the Alt key while dragging a side handle, 
Anime Studio will resize the selected points in such a way 
to maintain the overall volume of the object - this can be 
useful for squash and stretch.

Rotating Points
The Transform Points tool can also rotate the currently 
selected group of points. Two or more points must be 
selected to use this tool. The following toolbar options are 
associated with rotating the selected points:

 Transform Points options for rotating.

• Rotation: Allows you to enter a numerical value for 
rotation.

• Apply: Click to apply the value entered in the Rotation 
field

Click near the outer boundary of the selected group 
of points. Next, drag the mouse in a circle around the 
selection to rotate the points. Holding the Shift key while 

using the Transform Points tool will constrain the rotation to 
45 degree increments.

Add Point
Shortcut: A

The Add Point tool is what you use to draw most curves in 
Anime Studio. Just click and drag in the working area of 
the main window to create a new curve segment. There 
are four variations to using the Add Point tool - they differ in 
where the original click takes place.

 Add Point

The first way to use this tool is to click in empty space and 
drag - this will start a new curve.

The second technique is to click on the end of an existing 
curve to add another segment to that curve.
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Third, click on a curve segment to add a point there, then 
drag it to the final desired position.

Finally, click on a curve midpoint to add a new branching 
curve that is welded to the existing point. Each of these 
uses of the Add Point tool is shown below.

 Uses of the Add Point tool

The Add Point tool can also be used to weld two points. 
Click and drag in one of the ways described above to add 
a new point.

Drag the new point on top of an existing point. If Auto Weld 
is enabled the new point will weld to the existing point. If 
Auto Weld is off, press the spacebar before releasing the 
mouse. An example is shown below. (This works just like the 
Transform Points tool, above. Read about that tool for more 
details on welding.)

 Closing a curve

To prevent the Add Point tool from adding on to an existing 
curve regardless of where you click, hold the Alt key to 
force the tool to start a new line segment.
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The movie below demonstrates the Add Point tool. Notice 
how clicking on different parts of an existing curve causes 
the new point to be added in different ways.

 Using the Add Point tool (SWF file)

Add Point Tool Options

 Add Point Options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Auto Weld: When checked, automatically welds a 
new point to an existing point. The existing point is 
highlighted when the mouse hovers over a point that 
can be welded.

• Auto Fill: When checked, automatically fills a closed 
shape when you create it.

• Sharp corners: When checked, creates sharp corners 
when changing the angle of a line. When unchecked, 
creates smooth transitions when changing the angle

• If you hold down the Command key (Mac) or 
Ctrl key (Windows) while you add a new point, it 

will reverse the Sharp Corners option that you have 
selected in the Options toolbar. This allows you to 
change between peaked and smoothed points 
without interrupting your workflow.

Curvature
Shortcut: C

This tool works on the currently selected points, or on 
the nearest point if less than two points are selected. 
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It adjusts the level of smoothness of the curves passing 
through the selected points. Drag to the left to make the 
curves less smooth, and drag to the right to make the 
curves rounder.

 Curvature

Curvature Tool Options

 Curvature Options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Peak: Creates a peaked (or hard) transition between 
the curves at the point that you click.

• Smooth: Smooths the transition between the curves at 
the point that you click.

Freehand
Shortcut: F

The Freehand tool lets you draw complex shapes by just 
dragging the mouse around. After using the Freehand 
tool, you will often want to go back and use the Delete 
Edge tool to delete unwanted lines. You can also use 
the Transform Points tool to modify the result, delete 
unnecessary points, and weld points together. If you have 
a drawing tablet, the Freehand tool can also use the pen 
pressure from your tablet to control the thickness of the 
lines you draw.

The Freehand tool has been enhanced, such that you 
don’t have to draw shapes precisely while using the tool. 
If you cross a line, the new line automatically welds to the 
line that is crossed if the Auto Weld option is selected. This 
allows you to quickly sketch out shapes without worrying 
about stopping your stroke at precise locations. Later, 
you can use the Delete Edge tool to remove the hanging 
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edges. For more information about the Delete Edge tool, 
see “Delete Edge” on page 41.

When you’re using the Freehand tool, you are primarily 
interested in seeing an accurate display of what you are 
drawing. For this reason, control points are automatically 
hidden when Freehand tool is selected so that you can 
focus on your drawing. You’ll also see a more accurate 
preview of the strokes that you draw, especially when 
drawing wider strokes. When you release the mouse, 
you’ll notice the strokes change slightly due to automatic 
smoothing.

To display the control points, select one of 
the other tools, such as the Transform Points 

tool,

 Freehand

Freehand Tool Options

 Freehand Options

The Freehand tool has been improved to 
give much smoother looking curves. As you 

draw with the Freehand tool it looks like you are 
creating a lot of points, but as you let go it only 
keeps the points that are necessary to represent the 
curve smoothly.

You don’t have to be concerned with 
ending a line exactly on a point, or using the 

Transform Points tool to weld points together. 
Instead, sketch as you normally would sketch with a 
pencil. Any lines that cross will automatically weld 
together, easily allowing you to create closed 
shapes. You can then use the Delete Edge tool to 
delete the unwanted straggling ends that cross the 
lines you want to weld. This allows you to create 
closed shapes quite easily that you can fill later.
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Click the Freehand Options button in the Options toolbar to 
display the Freehand Tool options dialog. The options are 
as follows:

• Freehand Options: Click this button to display the 
following options

 � Variable line width: When set to None, does not 
vary line width between the start and end of the 
line. You can also vary line width based on pen 
pressure when using a pen tablet, or randomly. 
The line width will vary between the minimum and 
maximum width settings that you specify.

 � Width Variation: Controls the amount of difference 
between the narrowest part of the stroke and the 
widest part of the stroke.

 � Taper Start: When checked, tapers the start of 
the line. Enter the starting width of the line in the 
field provided. The taper will be applied after you 
release the mouse.

 � Taper End: When checked, tapers the end of 
the line. Enter the ending width of the line in the 
field provided. The taper will be applied after you 
release the mouse.

 � Reset: If pressed at Frame 0, resets a layer back 
to its default value. If pressed at any other frame, 

resets the layer to the value or values set at frame 
0.

 Freehand options

• Auto Weld: When checked, automatically welds a 
new point to an existing point. The existing point is 
highlighted when the mouse hovers over a point that 
can be welded. When you draw two lines that cross, 
the point at which they cross will automatically be 
welded together when this option is on.
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• Auto Fill: When checked, automatically fills a closed 
shape when you create it.

• Auto-stroke: When checked, automatically creates a 
stroke around the shape that you create. Uncheck this 
option to create a shape that has no outline.

• Auto close: When unchecked, closes a shape when 
the cursor is released over the beginning of the shape. 
When checked, connects the shape from the current 
position to the start point when you release the mouse 
button.

Draw Shape
Shortcut: E

The Draw Shape Tool provides a way to quickly draw 
commonly used shapes: squares, ovals/circles, triangles, 
stars, arrows, and spirals. Each of the shape options are 
shown later in this section.

 Draw Shape

Draw Shape Tool Options

 Draw Shape Options

• Auto Fill: When checked, automatically fills a closed 
shape when you create it.

• Auto-stroke: When checked, automatically creates a 
stroke around the shape that you create. Uncheck this 
option to create a shape that has no outline.
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Rectangle

 Rectangle

The Rectangle tool is a shortcut for creating a rectangular 
shape. Just click and drag to draw a rectangle. Hold the 
Shift key to constrain the shape to a square. Hold the Alt 
key to make the click point the center of the rectangle, 
instead of one of its corners. There’s nothing special about 
rectangles created with this tool - they’re just four points 
and four curve segments and can be manipulated just 
like anything else. You could create the same shape with 
the Add Point tool, but for a simple rectangle, this tool is 
quicker.

Oval

 Oval

The Oval tool is a shortcut for creating an oval shape. 
Just click and drag to draw an oval. Hold the Shift key to 
constrain the shape to a circle. Hold the Alt key to make 
the click point the center of the circle. There’s nothing 
special about ovals created with this tool - they’re just four 
points and four curve segments and can be manipulated 
just like anything else. You could create the same shape 
with the Add Point tool, but for a simple oval, this tool is 
quicker.

Triangles

 Triangles

The Triangle tool is a shortcut for creating a triangle shape. 
Just click and drag to draw a triangle. Hold the Shift key to 
constrain the shape to an equilateral triangle.

Stars

 Stars
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The Stars tool is a shortcut for creating a star shape. Just 
click and drag to draw a star. The star will be drawn from 
the upper point of the star, and all five points of the star will 
be equal in size.

Arrow

 Arrow

Click and drag to draw an arrow shape. Press the Shift key 
to constrain the arrow to a horizontal or vertical line.

Spirals

 Spirals

Click and drag to draw a spiral shape. The number of 
windings increase as you drag outward. By default the 

spiral radiates in a clockwise direction from the center. 
Press the Alt key to create a counter-clockwise spiral.

Delete Edge
Shortcut: D

It’s easy to delete points - just select them and press 
backspace or delete. However, sometimes you may want 
keep two points, but break the curve connecting them. To 
do this, use the Delete Edge tool. Just use it to click on the 
curve segment you want to delete and it will disappear.

You can use the Delete Edge tool to delete unwanted 
lines. For example, you can use the Freehand tool to 
quickly sketch out shapes, and the Freehand tool will 
automatically weld crossed lines together as you draw. 
You can then later clean up the shapes by deleting 
unwanted hanging lines with the Delete Edge tool.

If the edge you delete makes up part of the 
outline of a fill shape, that shape will also be 

deleted.
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The Delete Edge tool is also useful when used 
in conjunction with the Freehand tool. Due to 

the improved welding capabilities of the Freehand 
tool, you can freely sketch a character without 
having to worry about exact placement of lines. Any 
lines that cross will be welded together. You can 
then use the Delete Edge tool to remove unwanted 
straggling ends, simply by clicking on them with the 
Delete Edge tool.

 Delete Edge

Blob Brush
The Blob Brush tool allows you to block shapes out very 
quickly. For example, you can start by blocking in part of 
the character as shown below.

 The first pass of the Blob Brush Tool

You can add additional strokes to refine or add to the 
shape. In the following example, additional strokes with 
different brush sizes add legs and arms to the previous 
shape.
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 Additional passes of the Blob Brush Tool add to the previous 
shape.

You’ll get an accurate preview of the shape as you draw. 
When you release the mouse, a vector outline will be 
generated for the shape. When you choose this tool, a red 
circle gives you a preview of the brush size.

The following keyboard shortcuts can be used with the 
Blob Brush tool:

• You can adjust the size of the brush by using the Brush 
Radius setting in the tool options area, or by pressing 
the Alt key and dragging to resize the brush.

• If you hold down the Command/Ctrl key you can 
erase from the shape, or use the Eraser tool. See 
“Eraser” on page 44 for more information.

• The brush tool can create a lot of extra points. 
You can use the new Point Reduction Tool to 

reduce the number of points. See “Point Reduction” 
on page 45 for more information.

You might notice the viewport jump at times 
when using the Blob Brush tool. This happens 

when you extend your drawing outside the 
boundary of the work area. The viewport resizes to 
bring that additional area into view to ensure that 
the object that you drew will fit on the screen.

 Blob Brush
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Blob Brush Tool Options

• Brush Radius: Sets the radius of the brush. A red circle 
gives you a preview of the brush size. You can also 
adjust the radius by pressing the Alt key and moving 
your mouse left or right.

• Use Pen Pressure: Check this option if you are using the 
brush with a pressure-sensitive stylus and tablet.

 Brush Options

Eraser
The Eraser tool allows you to cut holes in any shape. Simply 
select the shape that you want to modify with the Select 
Shape tool (described in “Select Shape” on page 48). 
Then, switch to the Eraser tool to erase portions of the 
selected shape.

In the following example, the Eraser Tool is used to modify 
the shape of an animal’s tail.

 The Eraser Tool is used to modify the shape of an animal’s tail. 
Before (top) and after (bottom)

You might notice the viewport jump at times 
when using the Eraser tool. This happens 

when you extend your drawing outside the 
boundary of the work area. The viewport resizes to 
bring that additional area into view to ensure that 
the object that you drew will fit on the screen.
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 Delete Edge

Eraser Tool Options

• Eraser Radius: Sets the radius of the eraser. You can 
also adjust the radius of the brush by pressing the Alt 
key and moving your mouse left or right.

• Use Pen Pressure: Check this option if you are using the 
eraser with a pressure-sensitive stylus and tablet.

 Eraser Options

Point Reduction
The Blob Brush, Eraser, and Paint Bucket tools  can 
generate a lot of extra and unnecessary points. The Point 
Reduction tool helps you reduce the point count in any 
vector object so that the shapes are easier to animate.

 Delete Edge

When the Point Reduction tool is selected, the red circle 
gives you a preview of the brush size. You can set the 
radius in the options toolbar, or press the Alt key while 
dragging to resize the brush.

To use the tool, simply paint along the area where you 
want to reduce the number of points. As you paint, the 
brush will leave a trail behind where you have painted. The 
areas that you paint over will be simplified.
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 Before (top) and after (bottom) Point Reduction

Point Reduction Tool Options

• Brush Radius: Sets the radius of the brush.

• Tolerance Angle: If you want to reduce the number 
of points but not change the shape so much, reduce 
the tolerance angle. Lowering the tolerance angle will 
not remove as many points, but it will keep the shape 
closer to what you originally drew.

 Point Reduction Options

Scatter Brush
The Scatter Brush allows you to spray shapes into your 
scene. There are a number of preset shapes, or you can 
also copy any shape to your clipboard and spray multiple 
copies of that shape into your scene.

To use the Scatter Brush tool, try the following:

Copy a vector object into your clipboard, or select one of 
the preset options from the Preset menu.

1. Choose the vector layer that you want to paint into.

2. Set the Min and Max Width settings appropriately for 
the scale of the objects.
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3. Set other options in the Scatter Brush Options panel 
if you want to increase or decrease variation in 
the angle, spacing, or color of the objects you are 
spraying.

 Scatter Brush

Scatter Brush Tool Options

 Scatter Brush Options

• Scatter Brush Options: Click this button to display the 
following options

 � Angle Jitter: Specifies the maximum amount of 
angle variation in the objects that you spray.

 � Spacing: Specifies the minimum amount of space 
between the objects that you spray.

 � Color Jitter: Specifies the maximum amount of 
color variation for the objects that you spray.

 � Flip X: Check this option to flip the objects being 
sprayed along the X axis.

 � Flip Y: Check this option to flip the objects being 
sprayed along the Y axis.

• Preset Menu: Click the Preset menu to choose from 
a number of different presets that you can spray into 
your scene. If you choose Use Clipboard, the Scatter 
Brush tool sprays the contents of your clipboard into 
the scene.

• Min Width and Max Width: Sets the minimum and 
maximum width of the objects that you spray. If you 
want all of the objects to be the same size, set both 
values the same. Higher values create larger objects.
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Chapter 4: Fill Tools
Using the Fill tools for vector layers, you take the drawings 
you created with the Draw tools, and you tell Anime Studio 
which areas should be filled with color, where outlines 
should be placed, and what fill and line styles to use.

The drawings created with Draw tools are only guides. As 
far as Anime Studio is concerned, they’re invisible and they 
won’t show up in the final rendered output. That’s where Fill 
tools come in. Draw tools define the shape of objects, while 
Fill tools define the appearance of those objects. Of course, 
you’re always free to switch back and forth between any 
of Anime Studio’s editing tools at any time.

Anime Studio has a smart tool palette, which 
shows and hides tools based on their need. 

The position of the tool shown in the screenshots may 
differ, depending on the selected layer in the Layers 
palette, and the current time in the timeline.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

Select Shape
Shortcut: Q

This tool is used to select one or more existing shapes (fills or 
outlines).

To select a shape, just click on the desired shape and it will 
be selected.

• To select additional shapes, press the Shift key while 
you click and drag the mouse over each additional 
shape to add to the selection.

• To deselect a shape, press the Alt key while you click 
the shape(s) you want to remove from the selection.

After your shape or shapes are selected, you can press the 
Delete or Backspace keys to delete the shapes, or adjust 
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their properties in the Style Window (see “Chapter 13: 
Style Window” on page 163). Options also appear in the 
properties bar to change the color of the fill or stroke in the 
selected shapes.

After clicking on a shape to select it, you then have the 
option to select shapes lower in the stacking order. Just 
hold down the Ctrl key (Windows) or Cmd key (Mac)  and 
press the down arrow key to select the next shape lower 
down at the point you clicked the mouse. Hold Ctrl/Cmd 
and press the up arrow key to select the next shape higher 
in the stacking order at that same point.

When you change the properties of multiple selected 
shapes, the changes that you make will be applied to all 
selected shapes. For example, you can select shapes that 
have different color fills, and then change the fill color in 
the style window so that all of the shapes are filled with the 
same color.

To illustrate, the following figure shows four different shapes, 
each with different fill and stroke properties.

 Four different layers, each with objects that have different 
shape properties.

If you click on one of the shapes with the Select Shape 
tool, the Style window updates to display the fill and stroke 
properties of the shape that you clicked (color, stroke 
width, brush settings and effects, and so on).

If you hold down the Shift key while using the Select Shape 
tool, you can select multiple shapes. Pressing the Alt key 
will remove a shape from the selection.
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 Multiple shapes selected with the Select Shape tool.

The properties of the first shape that you selected will 
appear in the Style window. Any changes that you make 
in the Style window will be applied to all of the selected 
shapes. The preview window will update as you make your 
style selections.

 The preview updates as you make changes in the Style 
window.

 Select Shape Tool
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Tool Options

 Create Shape Options

• Fill: Check this option to change the fill of the selected 
shape(s).

• Fill Color: Click the color square to select a fill color for 
the selected shape(s).

• Stroke: Check this option to change the stroke of the 
selected shape(s).

• Stroke Color: Click the color square to select a stroke 
color for the selected shape(s).

• Width: Allows you to set a numerical value for the width 
of the stroke. Fractional values are allowed.

Create Shape
Shortcut: U

The Create Shape tool is used to select a region to be filled 
with color, or a set of edges to be drawn as an outline. It 
operates exactly like the Select Points tool described in 
“Select Points” on page 26.

 Create Shape Tool

Using the Create Shape tool, select all the points that form 
the outer border of the shape you wish to create. If you 
select a set of edges that completes an enclosed shape, 
a highlighted checkerboard will show you the extent of 
the region you are creating. Otherwise, you will just see a 
highlighted outline on the selected edges.

When you have the desired region selected, press the 
spacebar or press the Create Shape button in the status 
bar to actually create a shape from the selected edges. 
The Style Window (see “Chapter 13: Style Window” on 
page 163) can now be used to choose the shape’s color, 
line width, style, etc. This is a very important step - until you 
press the spacebar or use the Create Shape button, you 
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are only preparing the selection. A shape is only created 
when the spacebar or button is pressed.

The picture below shows a selection in progress using the 
Create Shape tool. Note that the figure on the left is not 
filled with a checkerboard because its border points are 
not all selected. The checkerboard area indicates the 
region that would be filled if the user hit the spacebar at 
this particular moment. The left figure would only receive a 
partial outline and no fill, since then entire border has not 
been selected.

 Selecting the curves to make up a shape

The next figure shows the result of pressing the spacebar to 
actually create the two shapes that were being prepared 
in the figure above.
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 The two resulting shapes

After creating a shape, if you decide that you only want a 
fill, and not an outline, you can uncheck the Stroke box in 
the Style window. Similarly, uncheck the Fill box in the Style 
window to make your shape have only an outline, and no 
fill color.

Tool Options

 Create Shape Options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Create Shape: Press the Create Shape button to 
complete the shape. This is the same as pressing the 
Spacebar after your selection is made.

• Lasso Mode: The Create Shape tool selects a 
rectangular area by default. Check this option to 
select points by drawing a lasso around the desired 
area.

• Fill: Select this option if you only want to change the fill 
of the selected object(s).

• Stroke: Select this option if you only want to change 
the stroke of the selected objects(s).

• Both: Select this option if you want to change both the 
fill and stroke of the selected object(s).
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Paint Bucket
Shortcut: P

The Paint Bucket tool is used to fill a closed area with color. 
Just click inside a closed shape to fill it with the current 
combination of colors and styles. This can make it much 
easier and quicker to fill shapes than with the Create 
Shape tool, but keep in mind you’re still working with the 
same requirements - a shape must be completely closed in 
order to be filled.

 Paint Bucket

In Anime Studio 10 and later, the lines that 
create the closed shape do not have to be 

welded. For example, you can draw four 
overlapping lines with the Freehand tool with Auto 
Weld off, and then fill the inside of the lines with the 
Paint Bucket tool.

Below are some examples of sets of curves in Anime Studio, 
where the user might click with the Paint Bucket tool, and 
the resulting fills. In each case, the shape on the left is the 
starting shape, the red X indicates the point where the 
user clicked with the Paint Bucket tool, and the result is the 
shape on the right:

 Filling a basic closed outline
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Clicking outside a closed outline (nothing happens - no fill).  A more complex shape. There are some dead-end curves, but 
the overall shape is still closed.
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 A shape with a hole in it.  Clicking inside the hole fills just the hole
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 The shape is not closed (close, but not good enough) - no fill 
is created

If part of the shape is cut off on the edge of the editing 
window, the viewport will change to display the entire filled 
shape after you fill it with the Paint Bucket.

 The viewport adjusts to display the entire filled shape after 
using the Paint Bucket.

You can also draw shapes that overlap, and use the Paint 
Bucket tool to fill within areas that overlap. This allows you 
to quickly create complex boolean shapes.
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 Two overlapping shapes are filled with the Paint Bucket to 
create a boolean shape.

Tool Options

 Paint Bucket Options

• Fill: Select this option to affect fill only.

• Stroke: Select this option to affect stroke only.

• Both: Select this option to affect both fill and stroke.

Delete Shape
To use the Delete Shape tool, click on a fill or outline to 
delete it from the project. Remember, in Anime Studio, the 
shape of an object is separate from its appearance. If you 
use this tool to delete a fill, the underlying points and curves 
will remain. If you want to delete those as well, go back to 
the Draw tools to work with the points and curves.
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 Delete Shape Tool

Line Width
Shortcut: W

The Line Width tool is used to adjust the width of a line as 
it passes through a particular point. Using this tool, you 
can create lines that taper at the ends, get thinner in the 
middle, or change width several times along their length.

Line widths are stored internally in Anime 
Studio as percentage values. For example, a 

value of 100% represents the original line width, and 
a value of 200% represents double line width. The 
width of the line smoothly varies from the 100% (no 
custom width) value.

You can superimpose two strokes, each with 
a different line width, to create parts for 

characters that are made of very few points, 
making them much easier to animate. For more 
information refer to “Tutorial 2.4: Varying Line 
Widths” on page 70 in your Anime Studio Tutorial 
Manual.

 Line Width Tool

To use it, just click on the point you want to adjust, and 
drag the mouse left and right to adjust line thickness. (Be 
sure you first either set up an outline through the point, or 
a fill shape with a non-zero line width - otherwise this tool 
won’t do you much good.)

You can adjust more than one point at a time by selecting 
multiple points with the Select Points tool from the Draw 
tool group.
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Tool Options

 Line Width Options

• Select Group: Used to select a group that was 
previously created with the Select Points tool.

• Width: Allows you to enter a numerical value for the line 
width.

You can also enable the Magnet Mode option and enter a 
radius that determines the area that the magnet will affect.

 Line Width Magnet Mode Options

• Magnet Mode: Check this option to display the cursor 
as a red semi-transparent circle.

• Magnet Radius: The points that appear within the red 
circle area will be affected when you use the Line 
Width tool.  Use the Magnet Radius setting to increase 
or decrease the affected area.

 You can set a magnet radius to affect all vertices beneath the 
magnet.

Hide Edge
Shortcut: H
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Sometimes, you will have the need to create a fill shape 
with only a partial outline. The Hide Edge tool makes it easy 
to accomplish this. After creating the fill shape and setting 
the desired line width, simply click on the edge(s) that you 
want to hide - those edges will simply disappear from the 
outline, without affecting the fill. Below is a before and 
after example:

 Hide Edge Tool
 The Hide Edge tool in action

Working with Fills
To define a region to be filled, you must first select all the 
points along its boundary. That’s what defines a fill region 
- the set of points along its outer edge. We’ll take a look at 
some examples later. You can also create outlines using 
these tools. Outlines are less restrictive than fills - an outline 
is not a set of points along an outer boundary. Instead, an 
outline can be any set of points you choose. The curve 
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segments between these selected points will form the 
outline.

Fills and outlines are stacked on top of each other in the 
order you create them. This determines which fill or outline 
will be visible when two or more overlap. There are tools 
that allow you to change the stacking order of fills and 
outlines, but you’ll learn that you can save yourself a lot 
of time by planning ahead and creating fills in the proper 
order to begin with.

There are a number of different ways to fill shapes in Anime 
Studio:

• Use the Select Shape tool to select the shape you want 
to change. The color and fill properties will be “picked 
up” in the Style window. You can then change the fill 
colors in the Style window.

• Use the Create Shape tool to fill closed outlines that do 
not have any fill. You will need to select the points in 
the outlines before you use the Create Shape tool.

• You can also use the Paint Bucket to fill shapes that do 
not yet have a fill. For example, you can use the Add 
Point or Freehand tool to create a shape that has a 
stroke only, and then later use the Paint Bucket tool to 
add a fill.

• You can also change colors with the Eyedropper. 
Use the Eyedropper to select a color from any of the 
shapes that use the color you want to apply. Then press 
the Alt key and click other objects with the Eyedropper 
to push the selected color to other shapes.

Color Picking
If the Select Shape or Create Shape tools are active and a 
shape is selected, you can quickly set the shape’s color by 
picking it from another shape in the current layer. Just hold 
down the Alt key and click on the shape you want to copy 
the color from. The color (and style) will instantly be applied 
to the currently selected shape.

You can also push a shape’s color and style onto other 
shapes. If you hold down Alt + Ctrl (Windows) or Alt + Cmd 
(Mac) and click on a second shape, the selected shape’s 
color will be pushed onto the shape you click on. This is an 
easy way to propagate one shape’s color and style onto 
several other shapes in the same layer.

There’s no limit to the kinds of shapes you can create this 
way. By adding more boundary curves, you can create 
more and more complex fills - feel free to experiment.
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A Trick: Using Two Fills Instead of One
Sometimes you may want to create an object with parts 
that overlap in complex ways. Consider the image below:

 Two interlocking rings

The red ring is in fact two objects - one behind the blue 
ring, and one in front of it. The next image shows the same 
object, but colored differently so that the two parts of the 
red ring stand out.

 The coloring shows three different shapes

It takes a little more work to set up an object when you 
have to split it into two (or more) parts, but sometimes 
it’s the only way to achieve a certain effect. The picture 
below shows the project in an Anime Studio window, so 
that you can see the arrangement of points and curves. 
Note how the ring on the right has some extra curves set 
up so that it can be split into two fills.
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 Point and curve arrangement.

This technique is also useful in animation, for when you 
want an object to bend backwards and overlap itself. 
Normally, this would cause the fill that defined the object 
to get seriously distorted, or even to break holes in itself. 
However, by building the object out of two or more parts 
and stacking them properly, you can achieve this type of 
effect with no problem.
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Chapter 5: Bone Tools
The following tools are available when working with Bone 
or Switch layers.

If a tool has the following symbol next to it: , then it can 
be used for animation as well. In general, tools that are 
used for bone setup can only be used when the time is set 
to frame 0 - others can be used at any time.

Anime Studio has a smart tool palette, which 
shows and hides tools based on their need. 

The position of the tool shown in the screenshots 
may differ, depending on the selected layer in the 
Layers palette, and the current time in the timeline.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

Select Bone
Using this tool, you can click a bone to select it. You can 
also draw a marquee or a lasso around multiple bones to 
select more than one bone with the Select Bone tool.

You might want to select a bone in order to delete it 
(press the Delete or Backspace keys - all of its children will 
be deleted too). You also might want to select a bone in 
order to add new child bones to it. Click anywhere besides 
a bone to de-select all bones.
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 Select Bone Tool

Tool Options
The following options appear in the Options toolbar when 
the Select Bone tool is active:

 Select Bone Options (Part 1)

• Select Bone: Use the Select Bone dropdown list to 
select a bone by name.

• Bone Name field: Displays the name of the selected 
bone. You can edit the bone name in this field.

• Bone Constraints: Opens the Bone Constraints dialog, 
described in “Bone Constraints” on page 67.

 Select Bone Options (Part 2)

• Lock Bone: When checked, prevents accidental 
changes to the current bone.

• Lasso Mode: When checked, allows you to select 
multiple bones by drawing a lasso around them. When 
unchecked, you can select multiple bones by drawing 
a rectangular selection around them.

• Color: Click the Color selector to choose a 
representative color for the bones: Plain, Purple, Blue, 
Green, Yellow, Orange, or Red. These colors can be 
representative of any category you choose and are 
provided for project organization. The keyframes for 
colored bones will show up in the timeline in specially 
colored channels that match the colors you assign.
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 Color options

Bone Constraints
With the Select Bone tool selected, click the Bone 
Constraints button in the options bar to open the Bone 
Constraint options dialog shown below.

For detailed instructions and examples of the options 
in this dialog, refer to the Angle Constraints section in 

“Tutorial 3.2: Bone Constraints” on page 92 in your Anime 
Studio Tutorial Manual.

 Bone Constraints Options

• Angle constraints: Check this option if you want to limit 
the movement of the bone within certain angles.

• Min/max degrees: Enter the maximum and minimum 
angle range that you want the bone to rotate. For 
example, if you only want the bone to rotate 10 
degrees in either direction, enter -10 in the Min field, 
and 10 in the Max field.
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• Angle/Position/Scale control bone: Allows one bone to 
control the motion of another. Click to select the bone 
that you want to be affected, and then use the drop-
down menu to select the bone that you want to use as 
the controller. Enter the desired control angle (positive 
and negative values are accepted) in the Angle field, 
the X and Y coordinates in the Position fields, or the 
desired scale factor in the Scale field.

• Bone dynamics: Tells Anime Studio to move the 
selected bone automatically, based on values entered 
in the Torque Force, Spring Force, and Damping Force 
values entered. See “Tutorial 3.3: Bone Dynamics” on 
page 102 in your Anime Studio Tutorial Manual.

• Close: Closes the Bone Dynamics palette.

Transform Bone
The Transform Bone tool allows you to translate, rotate, or 
scale a selected bone.

When the Transform Bone tool is selected, two dots appear 
at the ends of each bone. In addition, the cursor will 
change to display the type of transformation that will be 
applied:

 Transform Bone tool indications

• To rotate a bone: Click near the bone, but outside 
of the handles. A rotate cursor will provide indication 
when the mouse is placed correctly. Then drag the 
mouse to rotate the bone.

• To translate a bone: Click and drag the dot at the base 
of the bone.

• To scale a bone: Click and drag the dot at the end of 
the bone.
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 Transform Bone Tool

The following key combinations work while the Transform 
Bones tool is selected:

• Holding the Shift key will cause the bone to only 
translate horizontally or vertically relative to its parent (if 
you click near the base)

• Holding the Shift key while rotating will constrain the 
rotation to 45 degree increments.

• You can nudge the selected bone by small increments 
by holding down the Ctrl key (Windows) or Cmd key 
(Mac)  and pressing the arrow keys. Hold down Shift in 
addition to Ctrl/Cmd to nudge the bone by a greater 
increment.

• If any objects in other layers have been bound to the 
bone, they will not move if the current frame is 0. At 
frame 0, you are modifying the bone layout - at later 

frames you are animating with this tool, and bound 
objects will move with the bone.

Tool Options

 Transform Bone Options (part 1)

• Select Bone: Click this menu button to select a bone 
by name.

• Position X: Allows you to numerically enter a value for 
the X coordinate.

• Position Y: Allows you to numerically enter a value for 
the Y coordinate.

 Transform Bone Options (part 2)

• Length: Allows you to view or enter a numerical value 
for the length of the bone.
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• Reset: If pressed at Frame 0, resets a layer back to its 
default length. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.

• Scale: Allows you to view or enter a numerical value for 
the scale of the bone.

• Reset: If pressed at Frame 0, resets a layer back to its 
default scale. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.

• Angle: Allows you to view or enter a numerical value 
for the angle of the bone.

• Reset: If pressed at Frame 0, resets a layer back to its 
default angle. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.

Add Bone
Use the Add Bone tool to add new bones to a skeleton. 
The location you click will be the base of the bone (the 
point it rotates about), and where you drag to will be the 
endpoint.

When you add a new bone, Anime Studio automatically 
assigns a name to it.  By default, the first bone you add is 
named B1, the second B2, and so on.

If another bone is selected before you click and drag, it will 
be the parent of the new bone you create. Otherwise, the 
new bone will be parentless, a root bone.

 Add Bone Tool

Hold the Shift key to constrain the new bone to point in a 
direction that is a multiple of 45 degrees.

Note that bones don’t have to be touching to have a 
parent-child relationship. In the example shown in “Tutorial 
3.4: Character Setup” on page 109 in your Anime Studio 
Tutorial Manual, the upper arm bones are children of the 
spine, even though they are separated from it by a small 
distance. This will often be the case - arms should rotate 
about the shoulders, not the neck, even though they move 
when the spine moves.
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Tool Options

 Add Bone Options

• Select Bone: Click this menu button to select a bone 
by name.

• Text Field: Allows you to assign a name to the currently 
selected bone, or to edit the name of the bone as 
automatically assigned by Anime Studio.

Reparent Bone
Sometimes when building a skeleton, you may 
accidentally add bones to the wrong parent. Later, when 
you discover the error, deleting bones and adding new 
ones is just too much work. Instead, use the Change Parent 
tool to change a bone’s parent. First, select the bone 
whose parent you want to change (using the Select Bone 
tool). Then, using this tool, click on the new parent bone. 
(The new parent will become highlighted in blue.) If you 
want to turn the selected bone into a root bone (one that 
has no parent), just click on the background.

 Reparent Bone Tool

Tool Options

 Reparent Bone Tool

• Select Bone: Click this menu button to select a bone 
by name.
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Bone Strength
When using bones to control the points in a vector layer or 
to warp an image layer, by default every bone has some 
degree of influence over every point in the vector layer (or 
image). The Bone Strength tool lets you adjust how much 
influence each bone has. When this tool is activated, a 
semi-transparent region appears around each bone - this 
region indicates the strength of the bone. If you drag side 
to side on a bone with the Bone Strength tool, you cause 
the region of influence to shrink or grow. Points that are 
closer to the center of this region move more when the 
bone itself is moved.

 Bone Strength Tool

Although by default, all bones have some influence over 
some points, you can change this behavior. In the Layer 
Settings dialog, under the Bones tab, there are two options, 
Flexible binding and Region binding. Flexible binding 
means that every bone will influence every point. Region 

binding, on the other hand, means that a point will only 
move under the influence of the bone(s) in whose region of 
influence it lies. If that point only lies in one bone’s region, 
it will only move with that bone - if the point is overlapped 
by the regions of two bones, it will move with both of those 
bones.

Flexible binding is the default setting for new bone layers 
because it works reasonably well almost automatically. 
The downside is that it leads to rubbery movement of the 
attached vector artwork. Region binding will give you 
cleaner movement, but takes a little more work to set up. 
”Tutorial 3.4: Character Setup” on page 109 in your Anime 
Studio Tutorial Manual shows you how to use the Bone 
Strength tool together with both types of binding to quickly 
set up a character’s skeleton.

Tool Options

 Bone Strength Options

• Select Bone: Click this menu button to select a bone 
by name.
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• Bone Strength: Allows you to view or enter a numerical 
value for bone strength.

Manipulate Bones
The Manipulate Bones tool has two purposes. First, 
when the current frame is set to 0, it is used to test 

whether a skeleton is set up and working properly. 
Although it moves bones and points around, the changes 
it makes are only temporary. When you switch to another 
tool, the skeleton is reverted back to its original shape.

When working inside a Smart Bone action, 
the Manipulate Bones tool can introduce 

extra unwanted bone motion in the Smart Bone 
action. For this reason, the Manipulate Bones tool will 
be disabled.

 Manipulate Bones Tool

The second use of this tool is at frames greater than 0. If the 
current frame is greater than 0, then this tool will move the 
skeleton in the same way, but the move will introduce a 
keyframe for animation.

To manipulate a skeleton, just click and drag the various 
bones that make it up. If points or other layers have been 
bound to the bones, they will move as well. The way 
the skeleton and the bound points move with this tool is 
exactly the same whether at frame 0 or a later frame. If 
some part of the skeleton doesn’t move correctly, you can 
find out with this tool and fix it before you start animating.

Note: If you only want to rotate a single bone, it’s better to 
use the Rotate Bone tool. The Manipulate Bones tool will 
move a whole chain of bones, which is definitely not what 
you want if you plan to rotate a single bone.

Bind Layer
Other layers can be contained within a bone layer. For 
example, you could create a hand layer and place that 
within an arm layer. To bind the hand to the arm, use this 
tool. Just click on the bone in the parent layer that you 
want to connect to, and the entire layer will move with 
that bone. In the arm/hand example, you would click on 
the bone nearest the wrist to bind the hand to the end of 
the arm.
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Use this tool to bind an entire layer to a single bone. If you 
would rather bind certain points in a vector layer to certain 
bones, then you should use the Bind Points tool instead.

For more information on how to use the Bind Layer tool, see 
the Layer Binding section of “Tutorial 3.1: Bone Binding” on 
page 83 in your Anime Studio Tutorial Manual.

 Bind Layer Tool

Bind Points
The Bind Points tool operates exactly like the Select Points 
tool described in “Select Points” on page 26. Use it to 
select a group of points to bind to a bone. In order to use 
this tool, you must be on Frame 0, and a bone must first 
be selected. When a bone is selected, the points that are 
currently bound to it are automatically selected as well. 
Use this tool to add or remove points from that selected 
group. When the correct group of points is selected that 
you want to bind to the bone, press the spacebar - this 
tells Anime Studio to perform the binding. This technique is 

demonstrated in “Tutorial 3.1: Bone Binding” on page 83 
in your Anime Studio Tutorial Manual

 Bind Points Tool

We don’t usually recommend using the Bind 
Points tool. Instead, the best way to attach 

points to bones is to use automatic bone binding, 
together with the Bone Strength tool.

Offset Bone
The Offset Bone tool lets you add an extra amount of 
bone movement starting at frame 1 of your animation. The 
reason you might want to do this is to simplify the setup of 
a complex character. Often, parts of a character such as 
arms and legs overlap, making it difficult to set up bones 
and attach the proper parts of the character’s body to 
them. The Offset Bone tool lets you draw the parts of a 
character in disconnected positions, set up bones, and 
then move them all back into position.
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It’s difficult to describe the usefulness of this tool without a 
hands-on example, so look in “Tutorial 3.1: Bone Binding” 
on page 83 in your Anime Studio Tutorial Manual.

 Offset Bone Tool

Tool Options

 Offset Bone Options

• Select Bone: Click this menu button to select a bone 
by name.

• Animation Offset X: Allows you to numerically enter a 
value for the amount of offset on the X axis.

• Animation Offset Y: Allows you to numerically enter a 
value for the amount of offset on the Y axis.

• Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.
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Chapter 6: Layer Types
Drawings in Anime Studio are vector-based. Vector 
drawings are different from pixel-based images (like a 
photograph) in that they use lines and curves to represent 
a picture, rather than a grid of colored pixels. This 
difference makes a lot of things easy in Anime Studio that 
would be difficult or impossible to do with a pixel-based 
image.

First of all, since an Anime Studio drawing is represented 
as a bunch of curves, you can reshape the curves at any 
time, without ever losing precision. Also, Anime Studio 
projects are relatively small, even for complex animations 
- this means Anime Studio doesn’t require much memory 
even when working on a long movie. Vectors also have 
benefits when it comes to animation. By moving just a few 
points, you can totally change the shape of an object over 
time.

You’re not restricted to vector artwork, though - Anime 
Studio also has Image Layers. Using this type of layer, you 
can work with regular images within an Anime Studio 
project. So, Anime Studio is not strictly vector-based, but 
you will probably still use mostly vector layers, as image 
layers are not as flexible when it comes to animation.

Of course, most standard image and movie formats 
are not vector-based, so when you’re done working on 
a Anime Studio project, it must be rendered to create 
a traditional pixel-based image. During the rendering 
process, Anime Studio can apply various effects to the 
objects, such as shading and blurring.

Anime Studio is designed in such a way that projects 
are split into layers. You can have many, many layers in 
a Anime Studio project, each representing a different 
element in a scene or animation, such as background 
scenery, a character, or a title. Some layers can even 
contain other layers, so a more complex object, such as 
a character, might contain separate layers for each arm 
and leg.

Layer Types
Anime Studio currently supports the following types of 
layers:

• Vector Layers are used to hold vector-based artwork. 
These are the main type of layer you will use to create 
drawings. See “Vector Layers” on page 77 for more 
information.
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Image Layers can be used to bring in images 
from other applications. Image files created in 3D 
programs or photo editing applications can be used 
in Anime Studio with Image Layers. See “Image 
Layers” on page 78 for more information.

Bone Layers contain skeletons that are used to 
control the artwork in your vector and image layers. 
You manipulate skeletons as if they were “puppets” 
by bending arms and legs to make a character 
move. See “Bone Layers” on page 79 for more 
information.

Right-click a Bone layer in the Layers window 
to quickly convert it into a Switch layer.

Switch Layers are just like Bone layers, except they 
will only display one of their sub-layers at a time. 
Switch layers are an excellent way to perform lip-
sync animation. Which sub-layer gets displayed is 
controlled by a switch data file. You can create this 
data file by hand, or better yet, use a lip-syncing 
program like Papagayo. See “Switch Layers” on 
page 82 for more information.

• Audio Layers allow you to add a sound file to your 
project. When adding an audio layer you will be 
prompted to select an audio file.

Vector Layers
Vector layers are the most common layer in Anime Studio 
projects. Artwork that you create in Anime Studio is always 
contained in a vector layer. Tools are available for drawing 
and editing curves, setting up fills and outlines, and 
connecting your drawings to bones.

 Vector Layers
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The tools available for working with vector layers essentially 
make up a 2D drawing program. You can draw lines and 
curves, re-shape existing curves, and manipulate objects in 
various ways. There are a couple ways that Anime Studio 
differs from other drawing programs. First, everything you 
draw in Anime Studio is a set of points and curves. In many 
programs, when you draw a circle, you get a circle object, 
or you may type some text to create a text object. In 
Anime Studio, once you’ve created the circle or the text, 
there’s no difference between them whatsoever - they’re 
both collections of curves. One happens to be in the 
shape of a circle, and the other in the shape of some text. 
There are advantages in treating all objects the same: first, 
you never have to worry about what type of object you’re 
working with - the answer is always the same: a set of points 
and curves. The other advantage is that any operation you 
can perform on hand-drawn curves can be performed on 
text, or a circle, or whatever.

The other feature of Anime Studio’s drawing mode that 
is different from many other drawing programs is the 
concept of welding. In Anime Studio, two points can be 
welded together into a single point. In fact, any number of 
points can be welded together. When points are welded 
together, moving one of them moves them all, along with 
any curves that pass through that point. This is particularly 
useful when you start to animate objects. For example, if 
you want to move a character’s nose, then welding it to 

the face might not be a bad idea. That way, however you 
distort the nose or the face, they’ll always stay connected.

Image Layers
Image layers are a way of importing artwork into Anime 
Studio that was created in other programs. Any program 
that can produce image files can be used together with 
Anime Studio this way. For example, a painting program, 
photo editor, or 3D modeling program can produce 
images that can be used in an Anime Studio image layer. 
You can’t edit the pixels of one of these images in Anime 
Studio, but you can move, resize and rotate image layers, 
and attach them to skeletons for more complex animation.

When an image layer is first selected, the 
default tool is set to the Transform Layer tool.



Anime Studio Debut 10
Users Manual

79

Chapter 6: Layer Types

 Image Layers

The best image format to use with Anime Studio is PNG. 
PNG files have high quality, good compression, and 
support full alpha channels for transparency effects. 
Although PNG is the preferred format for use with Anime 
Studio, you can also use JPEG, BMP, Targa, or GIF images.

Image layers can also be used to bring external movies 
into Anime Studio. Instead of selecting a still image, select 
a movie file when creating a new image layer. Anime 
Studio can import QuickTime (Windows and Mac OS) 
or AVI (Windows only) movies as image layers. When 
importing a movie file, Anime Studio will use the movie’s 

alpha channel (if present) to composite the movie with 
other elements in the scene.

Bone Layers
Bone layers are similar to Group layers - they can both 
group together multiple sub-layers that can then be 
manipulated as a single object. However, bone layers 
have an additional feature: In a bone layer, you can 
set up a skeleton that can be used to manipulate your 
artwork. A skeleton is exactly what it sounds like - an 
internal structure that can move the outer, visible portion of 
your artwork.

 Bone Layers
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Setting up bones is sort of a pre-animation phase. You 
don’t draw shapes in Bone layers, you set up controls that 
will help you animate later on. The purpose of setting up 
bones is exactly what you might think: creating a rigid 
skeleton inside your drawing. Later on, during animation, 
when you want to move an object, bones make the job 
easy. By moving a single bone in the arm of a character, 
for example, the whole arm will move with it. Around the 
elbow, the drawing of the arm will bend and stay smooth 
(as long as the bones were set up well with the Bone 
editing tools).

Bones by themselves don’t really do much of anything: you 
can move them around, but they’re invisible in the final 
Anime Studio output. To really make use of bones, they 
need to be attached to objects in other layers. This process 
is covered in “Bones” on page 83 in your Anime Studio 
Tutorial Manual, and also “Chapter 5: Bone Tools” on page 
65.

When you create a skeleton out of a group of bones, the 
bones have a hierarchical relationship. Each bone has a 
single parent (or maybe no parent at all, in which case it’s 
called a root bone), and each bone may have multiple 
children. The relationship between parent and children is 
that when a parent bone is moved, all of its children move 
with it. When a child bone is moved however, it’s parent 
remains unchanged.

Below is a picture of a skeleton created in Anime Studio. 
Red arrows have been added that point from each bone 
to its parent (the spine has no parent and is referred to as 
the root of the skeleton). Note that the currently selected 
bone is highlighted in red, and its parent (if it has one) is 
highlighted in blue, as shown below.

 A skeleton hierarchy

When you use bones with a vector layer, you need to 
consider how the bones and curve control points will 
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interact. When a bone moves, it moves the points around 
it as well. Each bone has a region of influence (which 
you can adjust). Points move mostly with the bone whose 
region of influence they fall within, although other bones 
can still have an effect on them. Below is a picture of some 
points and bones. Notice the region of influence around 
each bone. The second picture shows the same object 
after the bones have been moved. Notice how the points 
follow the bones according to regions of influence (and 
how the curves pass smoothly through the points, wherever 
they move to).

 A bone and vector setup
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 Moving bones moves the curve control points

Switch Layers
Switch layers are used to group together multiple layers, 
much like Group layers. However, switch layers have 
an interesting twist: only one of their sub-layers can be 
displayed at a time.

 Switch Layers

One reason you might want to do this is for lip-sync 
animation. In this case, each of the sub-layers would 
correspond to a mouth shape for a particular sound.

Many of the characters in the Library provide switch layers 
for the visemes that Anime Studio supports.  For example, 
if you load Jace from the Version 6 character library and 
expand the Mouth layer, you’ll see support for the following 
visemes and mouth positions: Rest, Etc, FV, L, MBP, O, E, AI, 
U, and WQ.

Anime Studio includes powerful automatic lip-syncing 
which is a big time saver .
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• Anime Studio Debut uses the volume of the audio 
track to determine which mouth shape to use. When 
the audio is quiet, the mouth is more closed. When the 
audio is louder, the mouth is more open.

• Anime Studio Pro uses a production sync library that 
analyzes the audio track to determine the phonemes 
(the basic components of speech) that are being 
used. Results are improved when you enter the 
spoken words into Anime Studio. After the production 
sync analysis is done, Anime Studio Pro applies the 
matching mouth shape.

The mouth shapes supported by the Anime Studio lip 
syncing features follow standards developed by Preston 
Blair, an animator from the early days of Disney.

To set up a mouth that can lip sync, you will 
need to create a switch layer that contains 

at least ten sub-layers with different mouth shapes. 
Shapes should be created for the appearance of 
the mouth when at rest, and when speaking each 
of the 9 before-mentioned phonemes. The Preston 
Blair mouth shapes are discussed in more detail at 
http://minyos.its.rmit.edu.au/aim/a_notes/mouth_
shapes_01.html.

For examples of how lip syncing is used, see 
“Tutorial 5.1: Automatic Lip-Sync” on page 

140 in your Anime Studio Tutorial Manual and 
“Tutorial 5.2: Phoneme Lip-Sync” on page 142 in 
your Anime Studio Tutorial Manual.

If you prefer more control over lip-syncing than what the 
automatic built-in lip-syncing offers, you can take full 
manual control over the process using a separate, and 
free, tool called Papagayo (see http://www.lostmarble.
com/papagayo/). In Papagayo, you type in the words 
that are being spoken. Papagayo then uses a phoneme 
dictionary to break down the words into spoken phoneme 
components. These are lined up on a timeline, along with 
the audio waveform.

Initially, the lineup on the timeline in Papagayo is rough 
and the phonemes are spaced evenly. You then shift 
words and phonemes along the timeline so that they line 
up better with the actual sounds you hear. The final result is 
saved out as a “switch data file” that can be imported into 
Anime Studio.

You can also create a switch data file by hand. To do this, 
the data file should look like this:

MohoSwitch1
1 A
2 A

http://minyos.its.rmit.edu.au/aim/a_notes/mouth_shapes_01.html
http://minyos.its.rmit.edu.au/aim/a_notes/mouth_shapes_01.html


Anime Studio Debut 10
Users Manual

84

Chapter 6: Layer Types

10 B
22 A
37 C
40 C

• The first line is a header that just tells Anime Studio that 
the file is a switch data file.

• The following lines contain two items each:

• The first item is a keyframe.

 � The second item is the name of one of the switch 
group’s sub-layers. (In this example, the switch layer 
should have three sub-layers, named “A”, “B”, and 
“C”.)

If you make changes to the switch data file outside of 
Anime Studio, and you want to incorporate those changes, 
you will need to re-load the data file. To do this, double-
click the Switch layer in the Layers window, and in the 
dialog that opens up, go to the Switch tab, press Source 
Data and re-select the data file.

You don’t have to use a data file to work with Switch layers 
- you can also control them manually from within Anime 
Studio. To control which sub-layer is displayed at any frame 
in your animation, just right-click on the Switch layer in the 
Layers window. A pop-up menu will appear that lets you 
choose which sub-layer to display.

Anime Studio includes several sample mouth sets for doing 
lip-sync with Papagayo - take a look at those files to see 
how a switch layer should be set up. Also, check out the lip-
sync tutorials included in this manual.

Switch layers have a feature that allows for smooth 
switching. To use this feature, all the sub-layers need to be 
Vector layers, and they need to have the same number 
of control points. Then, when switching, Anime Studio 
can smoothly transition between sub-layers. To enable 
this feature, turn on Interpolate sub-layers in the Switch 
layer’s properties dialog. An example of using this feature is 
included in one of the mouth sets mentioned above.

Switch layers can be set up with skeletons, just like bone 
layers. More accurately, a switch layer is a bone layer, just 
a specialized one. If you add bones to a switch layer, you 
can use them (for example) to change the shape of a 
mouth as it speaks, bending it into a smile or a frown.

Don’t feel restricted to lip-sync animation with switch layers. 
They have a lot of potential uses (controlling eyes, syncing 
to music & sound effects, switching between different 
hand gestures, etc.).

Improvements to switch layers now include behaviors that 
will make them work better for frame-by-frame animation. 
These improvements include the following changes and 
enhancements:
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• You no longer need to select a switch layer’s 
active child in the Layers palette. You can now 
simply ALT+COMMAND/CTRL+Right-click on it in the 
workspace.

• When a layer is added to an empty switch group, it 
becomes the active child at frame 0.

• When a new layer is created inside a switch group, 
Anime Studio will assign a unique name (which is 
necessary for proper switch group functionality).

• When a layer inside a switch group is renamed, the 
switch animation channel is updated to use the new 
name to preserve existing switch animation.

• When a new layer is created inside a switch group at 
a frame other than zero, that new layer is not marked 
invisible prior to that time. (The switch layer takes care 
of its visibility, so setting it separately is redundant and 
makes it difficult to re-time the frame-by-frame effect.)

• When a new shape is drawn in a vector layer inside 
a switch group at a frame other than zero, that 
shape will not be set invisible prior to that time. (Same 
reasoning as for new layers.)

If the children of a switch layer have layer 
colors assigned to them (as described in 

“Using Layer Colors” on page 128), the 
corresponding keys in the timeline will have the 
same color when those children are active. This 
makes it easier to see at a quick glance what switch 
layer is active at what time.

Audio Layers
Audio layers allow you to add an audio file to your project. 
You will be prompted to select a file after choosing this 
layer type. A graphic representation of the audio file 
appears in the timeline after the file is selected.
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 Audio Layers
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Chapter 7: Layer Tools
The following tools are available to be used with any type 
of layer. Their purpose is to modify an entire layer, not just 
an individual object in that layer.

If a tool has the following symbol next to it: , then it can 
be used for animation - using the tool at different frames 
in the timeline will cause the object you adjust to change 
over time.

Anime Studio has a smart tool palette, which 
shows and hides tools based on their need. 

The position of the tool shown in the screenshots 
may differ, depending on the selected layer in the 
Layers palette, and the current time in the timeline.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

Transformation
Use this tool to translate, rotate, or scale the entire 
layer. It doesn’t matter what objects are selected - 

everything in the layer will move when you use this tool.

When the contents of the layer are selected, a pair of 
rectangles will surround the items in the layer.
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 Transformation rectangle

• To translate a layer: Click anywhere inside the inner 
rectangle to move the layer to a new location.

• Hold the Shift key while translating to constrain the 
movement to straight horizontal or vertical movement.

 � Hold the Alt key while translating to move the layer 
on the Z (depth) axis.

• To rotate a layer: Click in the area between the inner 
and outer rectangles, and drag up, down, left, or right 
to rotate the layer around its origin point.

• Hold the Shift key while rotating to snap the rotation to 
45 degree angles.

• To scale a layer: Click one of the corner handles to 
scale the layer uniformly. Drag a handle on the top, 
bottom, right, or left edge of the rectangle to scale the 
object horizontally or vertically.

• Press the Alt key while scaling to maintain the volume 
of the object while you scale ... in other words, if 
you increase the height of an object, the width will 
decrease; or if you increase the width of an object, the 
height will decrease.

 Transformation
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When you are working with a 3D camera, the 
original plane of the object might not be the 

best place to move the object. You can use the 
Pan and Tilt camera tools to position the camera 
along the plane in which you want to move the 
object, and then use the Transform Layer tool to 
move the object along the plane of the camera’s 
current view.

If the Show Path box in the tool options area is checked, 
then the motion path for the current layer will be displayed 
in the working area when this tool is active. This makes it 
easier to visualize and plan out the motion of a layer.

Direct Path Editing: To edit the motion path directly, hold 
down the Ctrl key (Windows) or Cmd key (Mac) , then 
click and drag anywhere on the motion path to adjust the 
curve that the layer will follow through space.

Nudging: When this tool is active, you can nudge a 
layer by small increments by holding down the Ctrl key 
(Windows) or Cmd key (Mac)  and pressing the arrow keys. 
Hold down Shift in addition to Ctrl/Cmd to nudge the layer 
by a greater increment.

Tool Options (for Translating)

 Transformation Options for Translating

• Position X: Allows you to numerically enter a value for 
the X coordinate.

• Position Y: Allows you to numerically enter a value for 
the Y coordinate.

• Position Z: Allows you to numerically enter a value for 
the Z coordinate.

Tool Options (for Scaling)

 Transformation Options for Scaling

• Scale X: Allows you to enter a numeric value for 
scaling along the X axis.
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• Scale Y: Allows you to enter a numeric value for scaling 
along the Y axis.

• Scale Z: Allows you to enter a numeric value for scaling 
along the Z axis.

Tool Options (for Rotating)

 Transformation Options for Rotating

• Angle: Allows you to enter a numerical value for 
rotation along the Z axis.

Tool Options (Other)

 Other Transformation Options

• Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.

• Show Path: Check this option to display the motion 
path on the layer. Uncheck the option to turn the 
motion path display off.

• Flip Layer Horizontally: Click this button to flip 
horizontally.

• Flip Layer Vertically: Click this button to flip vertically.

Set Origin
With the Set Origin tool selected, click anywhere in 
the layer to set the origin to that point. The origin of a 

layer is indicated by the crosshair displayed when editing 
that layer. The origin is the point that the layer rotates 
around when using the Rotate Layer tool, and the point 
that the layer resizes around when using the Transform 
Layer tool. The location of the origin can also define how a 
layer will move when it is attached to a group of bones.
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 Set Origin

Although you can change the origin at any time, 
the position of a layer’s origin is not animated. We 
recommend setting the layer’s origin just once, and then 
leaving it alone for the rest of the animation - otherwise 
unpredictable movement can occur. In most cases, you 
will never need to change the origin of a layer at all.

Tool Options

 Set Origin Options

• Origin X: Allows you to view or enter a numerical value 
for the X origin

• Origin Y: Allows you to view or enter a numerical value 
for the Y origin

• Reset: If pressed at Frame 0, resets a layer back to its 
default value. If pressed at any other frame, resets the 
layer to the value or values set at frame 0.

• Flip Layer Horizontally: Click this button to flip 
horizontally.

• Flip Layer Vertically: Click this button to flip vertically.

Follow Path
This tool allows you to assign any layer to follow a path in 
your scene. You will need two layers, one with the path, 
and the other with the object that will follow the path.

Previously, there was no indication that a 
layer was set to follow a path. This could 

make it very confusing when opening a file you 
weren’t familiar with (or hadn’t used in a while). 
Certain layers might move in unexpected ways. 
Now, layers that follow a path get a little extra 
squiggly line (indicating path following) on top of 
their icon in the Layers palette.
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 Follow Path

If a layer follows a path, an extra squiggly line 
will appear on top of their icon in the Layers 

palette.

 Two layers, one with a path, and another with a character or 
object

To use the tool, select the layer that contains object 
that you want to follow the path. Then select the Follow 
Path tool from the Layer section of the toolbox. The path 
appears in the scene after you select the Follow Path tool. 
Click the path in the scene to reposition the object to the 
beginning of the curve.
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You can click and drag left or right with the Follow Path 
tool to position the object along the curve at any point. 
You can then move to a later frame in your animation and 
set the object to a new position. This allows you to animate 
the object travelling along the path.

 The fish before and after it is placed on the path with the 
Follow Path tool

You can set the object to rotate so that it follows the path. 
Double-click the object’s layer in the Layers window, which 
opens to the General tab. Check the Rotate to follow path 
option in the Options section of the Layer Settings dialog 
and click OK. This causes the object to automatically orient 
itself to follow the path to which it is assigned.

 Check the Rotate to Follow Path option in the Layer Settings 
dialog to orient the object to the path
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You can also combine path following with 
the Stroke Exposure tool, and expose the 

stroke of the curve while the object moves along the 
path.

If you hold down the Alt key while clicking on 
a curve, the object will now bend along the 

curve. This allows for text bending, characters that 
warp along a path (like a snake), and so on. You 
can animate this effect. For example if you go to 
another point in the timeline, you can Alt-click 
somewhere else on the curve.

 Press the Alt key while using the Follow Path tool to bend the 
object along the path

Tool Options

 Follow Path Options
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• Percentage: Allows you to enter a numerical value for 
the position of the object on the path. A value of 0 
places the object at the beginning of the path, while a 
value of 100 places the object at the end.

Layer Selector
The Layer Selector helps you quickly find and edit the 
vector, image, and 3D content in your layers. It is very 
helpful, especially when you have dozens or hundreds of 
layers in your project and can’t remember which layer a 
specific shape appears on.

This tool can be also be used by Alt+Right-
clicking on the object that you want to 

select.

You can Alt+Right click any layer type that has visible 
contents. If you click a shape that appears in a Bone 
group, for example, it will select the vector layer that 
appears within that Bone group.

There are no options for this tool. Simply click on the object 
you want to select, and its layer is automatically selected 
for editing. If there are multiple objects in the layer, the 
object that you click on is the selected object.

 Layer Selector

Inserting Text and Word Balloons
Anime Studio allows you to enter text in your projects. While 
doing so, you have the option to automatically create a 
word balloon that encloses the text.

The following example explains how you can add text and 
a word balloon inside a project:

1. Choose one of the following to open the Insert Text 
dialog:

 � Click the Insert Text Tool, located in the Layer Tools 
section.
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 Insert Text

 � Choose Draw > Insert Text

 � Use the keyboard shortcut COMMAND/CTRL+T. The 
Insert Text dialog appears.

 Insert Text Options
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2. The Select Font list displays all of the fonts on your 
system. Select the font that you want to use from the 
list.

 Select Font list

3. Enter the text in the Text field.  The project window will 
update as you type.

Word balloons will automatically resize to 
accommodate the text. If you want to break 

the text into multiple lines, you will need to press the 
Enter key where you want a line break to occur.

 Enter your text in the text field.

4. Use the remaining settings to set additional text 
properties as follows:

 Select fill, stroke, and other font options.
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 � Fill: Check this option if you want your text to be 
filled with a solid color. Uncheck the option if 
you want your text to only use an outline stroke 
(described next). For filled text, click the color 
swatch to select the fill color.

 � Stroke: Check this option if you want your text to 
have an outline. Click the Color swatch to select 
the outline color.

 � Width: Enter the desired pixel width for the outline 
stroke in the Width field.

 � Justification: Click the justification type that you 
want to apply to the text. Choices are Left, Center 
(the default), or Right.

 � Create One Shape: With this option checked, your 
text object will be added to the currently selected 
layer. This text will be added as a vector object 
and will not be editable.

 � If you leave the Create Text Layer option 
unchecked, your text object can be 

manipulated just like anything else. This includes 
using any of the drawing tools to distort its shape, 
or to add new points in the middle of a character. 
This also means that in order to move or rotate a 
text object, you need to select all the points in the 
object. This is easy to do using the Select Points tool 

- just click on the filled in area of the text to select 
all of it.

If your text is added as a vector object, you 
can use the Freehand tool and Delete Edge 

tool to create uniquely colored text. First, create your 
text as normal, making sure that there is a stroke on 
the text. Then use the Freehand tool (with its Auto 
Weld option on) to slice the text or letter up into 
shapes that you can color differently. Finally, use the 
Delete Edge tool to remove the lines that hang out 
from the edges of the text. See “Freehand” on page 
36 and “Delete Edge” on page 41 for more 
information on how to use those tools.
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 Create colorful text using the Freehand and Delete Edge tools 
with the Insert Text tool.

 � Create Text Layer: With this option checked. a 
new text layer will be created, and you can easily 
edit the text afterward. To do so, open the Layer 
Settings dialog and click the Text tab to make your 
changes.

 � Scale: Use the Scale slider to increase or decrease 
the text size, or enter a scale value in the Scale 
field.

 � Leading: Use the Leading slider to adjust the 
spacing that appears between multiple lines of 
text. Move toward the left to decrease space, 

and toward the right to increase space. Negative 
values are also valid.

 � Kerning: Use the Kerning slider to adjust the 
amount of space between letters. Move toward 
the left to decrease space, and toward the right to 
increase space. Negative values are also valid.

5. If you want to use a word balloon to enclose your text, 
select one of the word balloons from the Select word 
balloon type list. Otherwise, choose <none> if you do 
not want to use a word balloon.

6. Additional word balloon options (custom for each 
word balloon type) appear beneath the selection. 
These options allow you to change the appearance of 
the word balloon. For example, you might find options 
that affect the appearance and placement of the 
balloon tail, or whether the outer edges of the balloon 
are smooth or cloud-like. Each of these balloon morphs 
are set to zero, initially. You can move the dials in 
any combination to change the appearance of the 
balloon. The preview window updates as you make 
your changes. The text will appear in your document, 
pre-filled with the current fill color and style, and it can 
be resized and positioned just like any other object.
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 Choose a word balloon type, if desired, and use the balloon 
morphs to customize its appearance.

7. Use the following settings to determine the color and 
size of the word balloon:

 Choose a word balloon type, if desired, and use the balloon 
morphs to customize its appearance.

 � Custom Fill: Check this option if you want to select 
a fill color for the word balloon. Click the color 
swatch to choose the desired fill color.

 � Custom Stroke: Check this option if you want to 
select a stroke (outline) color for the balloon. Click 
the color swatch to choose the desired stroke 
color.
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 � Stroke Width: Enter the width of the stroke used for 
the word balloon in pixels.

 � Size Relative to Text: Use this slider to increase 
or decrease the amount of white space that 
appears between the text and the outer edges 
of the balloon. Move the slider toward the left to 
decrease the amount of space, and toward the 
right to increase the amount of space.

 � Flip Vertical: Check this option to flip the object 
vertically. For example, if the tail is on the bottom 
of the balloon by default, it will place the tail on 
the top.

 � Flip Horizontal: Check this option to flip the object 
horizontally. For example, if the tail is on the left 
side of the balloon by default, it will flip the balloon 
so that the tail is on the right side.

 � Constrain Proportions: Check this option if you 
want to keep an equal amount of white space 
around the width and height of the balloon. When 
unchecked, the height of the balloon will be closer 
to the text, and the width of the balloon will have 
more white space.

8. Press OK to add the text to your project.

 Text added as a text layer.

Eyedropper
To use the Eyedropper, click on a shape to copy its 
parameters.

Hold the ALT key to push the current color.

• Press the COMMAND/CTRL key down while you click 
to pick up the properties of the underlying object. This 
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is not limited to vector layers. For example, if you have 
a Bone Layer active in the Layers palette but click over 
a gradient shape on the stage, the properties of the 
gradient shape will be copied to the clipboard in a 
Web color format. You will then be able to paste that 
property into the Color Picker to assign that color to a 
fill, stroke, or project background color.

 Eyedropper Tool
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Chapter 8: Special 
Tools

Anime Studio includes a number of special tools that are 
available in specific circumstances. These tools appear in 
the Special section of the tool palette when the conditions 
are met. The sections that follow describe how these 
special tools are uses.

Anime Studio has a smart tool palette, which 
shows and hides tools based on their need. 

The position of the tool shown in the screenshots 
may differ, depending on the selected layer in the 
Layers palette, and the current time in the timeline.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

Switch Layer
This is a specialized tool for use with Switch layers 
only. This tool has no effect if you click and drag in 

the workspace. What it does is supply a popup menu in 
the tool options area that lists all the sub-layers of a switch 
group. You can change the active layer by selecting it 
from the menu.

 Switch Layer
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Tool Options

 Switch Layer Options

• Active Child: Use this menu to select the active layer 
for the switch function

Image Masking
Many Anime Studio users do not use Photoshop or other 
similar programs, making it difficult to create images with 
transparent backgrounds. The Image Masking tool assists 
with this task. This tool helps you clear out and remove 
background areas from images that you import into Anime 
Studio.

Image Masking tool

Tool Options

• Clear Mask: Click the Clear Mask button to remove 
all areas from the mask and restore the image to its 
unmasked state.

 Import an image into your Anime Studio scene

After you import an image, select the Image Masking tool 
from the Layers section of the tool box. Click on an area 
that you want to remove from the background. Click and 
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drag left or right to control the sensitivity of the tool. Drag 
toward the left to decrease the sensitivity, and toward the 
right to increase it. Release the mouse button when you 
have masked out the desired area.

 Click with the Image Masking tool to mask out areas of the 
image that you want to hide

Video Tracking
To use the video tracking feature, you need to have a 
movie file in your project. Either import a movie into an 
existing project or open a movie file from scratch. The 
following sections describe the process of how the video 
tracking feature works

Adding Tracking Points
Assume that you have imported a video, and you want 
to eventually add an object that will follow the position 
and rotation of a person’s thumb and wrist. The first step 
of the process is to add tracking points that identify the 
two points you want to follow. The Primary tracking point 
controls the position of the object’s origin. The Secondary 
tracking point controls the angle or scale of the object. 
To add the tracking points, select the Video Tracking tool 
from the Layer panel.

 Video Tracking tool
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Click on the first point you want to track. You can click, and 
then drag to position the point exactly where you want to 
place it. It is optional, but recommended, that you name 
the tracked point in the Tracker Name field of the status 
bar. For example, since we are tracking a thumb here, we 
name the tracking point Thumb.

 The first tracking point is added to the thumb

Now we add the second tracking point for the wrist, and 
name it (appropriately) Wrist.

 The second tracking point is added to the wrist

After you place your tracking points, make sure the Video 
Tracking Tool is still selected. Play the video back and 
watch the tracking points follow the points you selected. 
Playback runs a little slower during video tracking.

As you play the video back, you’ll notice keyframes 
being added to the timeline. While the video is playing, 
watch for any problem spots in the way that the tracking 
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points follow the items you want to track. When you see a 
problem, don’t worry ... there are ways to fix them!

 After the tracking points are added, keyframes are generated 
in the timeline

Fine-tuning Marker Positions
You might notice some places where the tracking points 
seem to drift away from the marker, or stop following it 
entirely. If this happens, stop the video playback. Go back 
to the beginning of the movie. Zoom in more closely to the 
video and use the Video Tracking tool to reposition the 
markers that need to be adjusted.

Choose View > Reset to reset the zoom level of the video 
back to the default. Play the video again and watch for 
any other problems. Keep making adjustments until you 
are happy with the results. The following movie shows our 
markers after they have been adjusted.

 Markers after they are adjusted (SWF file)

Re-syncing Tracking Points
You may also find instances where the tracking points go 
out of sync with the tracked object. The most likely cause 
for this is when the tracked area touches or passes over 
another area in the video that is very close in color. For 
example, when the tip of the thumb goes in front of the 
paper on the wall, there are similar colors in the paper that 
cause the tracking point to go out of sync with the thumb. 
Fortunately, there is a way to fix that. The next movie shows 
one of those problem areas.
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 The tracking point loses focus after reaching the paper on the 
wall (SWF file)

To fix this type of problem, you scrub through the timeline 
until you find the point where it loses track. In the next figure 
you see the spot where the thumb appears to blend in with 
the paper. This is the area that causes the tracking point to 
lose sync with the thumb.

 Find the point where the point loses focus

After you find the problem frame, advance ahead a 
couple of frames until you reach a point where there is 
more contrast. Then drag the tracking point to position it 
where it should be. When you press Play, the tracking point 
will continue tracking from there.
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 Advance the video to a clear spot and adjust the tracking 
point

Sometimes color similarities occur for a period that is longer 
than a couple of frames. For example, in our video there is 
a segment where the thumb passes across the face. This is 
a much larger area where there is very little color contrast 
between the tracked object and the area it passes over.

The solution here is slightly different. You can use 
interpolation to calculate the path between two good 

points. First, move back to find the last good point before 
the thumb crosses the face. Delete the keyframes from 
that point until the thumb passes across the face and 
reaches the other side.

You can use the Animation > Clear 
Animation > From Layer After Current Frame 

or Animation > Clear Animation > From Document 
After Current Frame commands to delete keyframes 
from the current frame to the end of the project.
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Here we move to the point just before the thumb passes over 
the face ..

... and we delete the keyframes that occur until the thumb 
reaches the other side of the face

Jump ahead in the video to a point after the thumb passes 
over the face and reposition the tracking point. When 
you play the video back, Anime Studio will interpolate the 
motion between the keyframes that are missing.
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 On the other side of the face, we reposition the tracking point 
to a good spot

Adjusting Tracking Point Sensitivity
When you add tracking points, you can change the sizes 
of the inner and outer rings to adjust the falloff. Click and 
drag on the edge of the rings to change the size. The inner 
ring defines the region that you are trying to track. For 
example, if you are trying to track an eye, adjust the inner 
ring so that it surrounds the eye.

The outer ring represents how fast the object can move. 
From one frame to the next, the outer ring represents the 
maximum distance that you want the object to move. If 
you have a fast-moving object you may need to increase 
the size of the outer circle for tracking. Expanding the 
search area too much can lead to further errors, so you 
want to keep it as narrow as possible. The default settings 
are generally sufficient for most cases.
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 Two rings control the sensitivity of the tracking point

Assigning the Tracked Layer
After you set the two points on the object you want to 
track, you can then assign the layer that will track those 
points. In our example, we returned to Frame 0 and added 

an exclamation point to a new layer. Now we want the 
exclamation point to follow the hand in the video.

To assign the layer that will track the points, choose 
Animation > Track Layer to Video. The Motion Tracking 
dialog lists the videos in your scene (in this case, there is 
only one).

 Select the movie to track, then choose the primary and 
secondary tracking points

First we’ll assign the Primary Tracking Point, which is 
associated with the origin point of the tracked layer. We 
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want the origin of the exclamation point to track the Wrist 
point. So, we select Wrist here and choose OK. When 
we play the result, the origin of the exclamation point 
(represented by the crosshairs) tracks the wrist.

 The crosshairs of the exclamation point, representing the origin, 
now follow the primary tracking point

The secondary tracking point is optional. You can use it 
to control either the angle or scale of the tracked layer. 
In our case, we want the thumb to control the direction 
of the exclamation point, so we select the thumb as the 

secondary tracking point. Then we check the option to 
control Angle.

 The secondary tracking point can control the angle or scale of 
the tracked layer. We want the thumb to control the angle of 

the exclamation point

The following movie shows the results of our selections. Now 
when you play the movie, the origin of the exclamation 
point follows the wrist, and the angle of the exclamation 
point is follows the angle line from the wrist (primary 
tracking point) to the thumb (secondary tracking point).
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 The exclamation point now follows the wrist, and points in the 
same direction as the thumb (SWF file)

Offsetting the Origin
You can use the Transform Points tool in the Draw panel to 
move the tracked object away from the origin. The origin 
still tracks to the two tracking points, but the object that 
you are tracking can be offset.

 You can offset the object from its origin with the Transform 
Points tool

Once you have applied video tracking points to another 
layer, the two layers are totally independent. The tracking 
feature creates standard keyframes. You can edit, add 
or remove keyframes to the tracked object. You can also 
hide or delete the video layer that was used to initially 
create the tracking points and keyframes. The layer that 
was tracked to the video will still continue to follow the 
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motion. This allows you to use a video file as a reference 
whether or not you want to see the video in your final 
project.
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Chapter 9: Camera 
and Workspace Tools

Camera Tools
The following tools let you move a virtual camera around in 
a scene. Although layers in Anime Studio are primarily 2D, 
Anime Studio’s camera can be moved around in true 3D 
space. The camera tools affect all layers in the document, 
not just the currently active layer.

If a tool has the following symbol next to it: , then it can 
be used for animation - using the tool at different frames 
in the timeline will cause the object you adjust to change 
over time.

Click the tool icon in the properties bar to 
display a submenu. Choose Reset Tool to 

reset the current tool to its default settings. Choose 
Reset All Tools to reset all tools to their default 
settings.

Reset tool options.

Track Camera
This tool moves the camera up and down, and 
side-to-side. By giving the project’s layers different 

depth values, you can create parallax (depth) effects. 
Holding the Shift key while using the Track Camera tool will 
constrain the camera to only move vertically or 
horizontally. Holding the Alt key will move the camera 
forward and back.

If the Show Path box in the tool options area is checked, 
then the motion path for the camera will be displayed 
in the working area when this tool is active. This makes it 
easier to visualize and plan out the motion of the camera. 
(The camera’s motion path is only visible when the Orbit 
Workspace tool has been used to view the scene from 
outside the camera.)
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 Track Camera Tool

Zoom Camera
This tool zooms the camera in and out on the scene, 
just like the zoom control on a real camera. 

Technically, the Zoom Camera tool is changing the field of 
view angle (or focal length) of the virtual camera.

 Zoom Camera Tool

Roll Camera
This tool rolls the camera side to side. Try tilting your 
head side to side, and you’ll understand this tool 

immediately.

 Roll Camera Tool

Workspace Tools
Change your view of the workspace

The last group of tools in the toolbar is always available, 
regardless of the current layer type or the current selected 
object. These are the Workspace tools, and are used to 
control your view of the project, but don’t actually modify 
the project itself.

Pan Workspace
When the Pan Workspace tool is selected, you can click 
and drag in the working area to move the project side 
to side and up and down. Note that this isn’t the same as 
moving the objects in your project - only your view of them 
is changing, not where they appear in the final image. A 
shortcut for the Pan Workspace tool is to click and drag 
in the working area using the right mouse button - it’s a 
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quick way to pan, regardless of what tool is selected in the 
toolbar.

 Pan Workspace Tool

Zoom Workspace
The Zoom Workspace tool is similar to the Pan Workspace 
tool: it moves your view of the project, without modifying 
the objects themselves. With this tool, dragging the mouse 
left or right zooms your view of the project in and out.

A shortcut for the zoom tool is to click and drag left or 
right in the working area using the right mouse button 
while holding down the shift key - it’s a quick way to zoom, 
regardless of what tool is selected in the toolbar.

 Zoom Workspace Tool
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Anime Studio 
Windows
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Chapter 10: Anime 
Studio’s Main Window

Overview
The Anime Studio interface has various windows that are 
used for controlling different aspects of a Anime Studio 
project. In this chapter we’ll briefly describe some general 
components of the Anime Studio project window.

The more complex parts of the Anime Studio interface, 
such as the Layers window, have their own chapters that 
follow this one. Although this chapter will describe how the 
main window works, it won’t go into detail about creating 
a drawing or animation.

 Anime Studio Debut interface

Working Area
Most of the Anime Studio project window is taken up by the 
working area. This is the region where you will create and 
view your drawings and animations. In every project, even 
an empty one, two items will be displayed in this area. The 
first is a cross marking the center of the currently active 
layer. The second is a blue rectangle that indicates the 
visible region of the project. Only objects that are within this 
rectangle will appear in your final animation.
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 Working Area

Although every project has a fixed image size (for example 
640x480 pixels), the working area is basically an endless 
flat space on which you can draw and animate. The 
blue visibility rectangle mentioned above indicates the 
actual image area for the project. While working, you 
may want to zoom in or out to see more or less detail in 
your project. A quick way to do this is by using your right 
mouse button. By dragging the right mouse button in the 

working area, you can move around from side to side. If 
you hold down the shift key while right-clicking and then 
drag left or right, you can zoom in and out. If you want to 
restore a reasonable overall view in the working area, press 
the Escape or Home keys, or choose Reset from the View 
menu (see “Chapter 24: View Menu” on page 272).

The background of the working area is usually just a blank 
color, but if you drag an image file into the working area, it 
will appear in the visibility rectangle. This is a helpful feature 
meant to allow you to trace the image with the drawing 
tools.

The real work that happens in the working area is not 
covered here, but is described in the sections “Anime 
Studio Tools” on page 24, and“Anime Studio Windows” 
on page 119.

Toolbar
The toolbar to the left of the main Anime Studio window 
is where you select which tool you want to work with. The 
available tools will change depending on whether you’re 
currently animating, which objects are selected, and what 
type of layer is currently active. The purpose and use of 
each tool is described in the following chapters:
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• Draw Tools: See “Chapter 3: The Draw Tools” on page 
25

• Fill Tools: See “Chapter 4: Fill Tools” on page 48

• Bone Tools: See “Chapter 5: Bone Tools” on page 65

• Layer Tools: See “Chapter 7: Layer Tools” on page 
87

• Camera Tools: See “Chapter 9: Camera and 
Workspace Tools” on page 116

• Workspace Tools: See “Chapter 9: Camera and 
Workspace Tools” on page 116

 Anime Studio Debut Tools (some tools not shown)
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Status Bar
The status bar along the top of the Anime Studio window 
displays a short description of the currently active tool in 
the toolbar. If you don’t know what a tool does, the best 
thing is to read this manual. However, if you just need a 
quick reminder, the status bar can be helpful.

 Status Bar

Playback Buttons
Near the bottom-left of the main Anime Studio window 
are a set of playback buttons that allow you to play/stop/
rewind/etc. your animation.

 Playback controls

Docking and Undocking Windows
You can dock and undock the windows that appear 
at the sides and bottom of the Anime Studio interface 
to maximize the area that the document window uses. 
The windows that you can dock and undock appear in 
the upper portion of the Windows menu as shown in the 
following figure:
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 Playback controls

Windows that are normally docked (the Tools, Layers, 
Timeline and Style windows) will become undocked if you 
choose the Window menu command associated with 
that window.  Choose the command again to redock the 
windows in their default space.

Windows that are normally hidden (Actions, Library, and 
Audio Recording) will open undocked when choosing the 
command. Choose the respective command again to 
close the window.
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Chapter 11: Layers 
Window

An Anime Studio document is composed of layers, each 
of which can be independently edited and animated. 
Layers can be thought of as transparent sheets of plastic. 
You can draw separately on each of these sheets, and the 
final picture is the composition of all the sheets stacked on 
top of one another.

Layers can be added, removed, copied, and re-ordered. 
The Layers window is where all these operations take place 
in Anime Studio, and is the topic of this section.

Overview
The Layers window has two sections of interest. As seen 
below, these consist of the toolbar and the layer list.

 The Layers window

The Layer List
Most of the Layers window is taken up with the layer list. This 
is a vertical scrolling list of all the layers in the document. 
The layers are stacked in order from bottom to top. That is, 
when the project is displayed, the lowest layer in the list is 
drawn first, followed by the second from the bottom, and 
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so on up to the top. When two layers contain objects that 
overlap, this ordering determines which object is in front 
and which is behind.

Each layer is represented in the list with an entry that looks 
something like this:

 A single layer in Anime Studio

Only one layer can be edited at a time in the Anime Studio 
working area. The layer currently selected for editing (the 
active layer) is displayed in a highlighted color. To select a 
different active layer, just click on its entry in the layer list. A 
layer’s entry provides you with three pieces of information: 
what type of layer it is, its name, and whether the layer is 
visible.

At the left side of a layer’s entry in the list is a visibility 
control, which controls whether a layer is visible or not. If 
a pair of eyes is visible in this box, any objects drawn in 
the layer will appear in the main Anime Studio window, as 
well as in any rendering of the project. If you click this box, 
the layer will turn invisible and will not appear in the main 
Anime Studio window. This can be a convenient way to 
remove clutter in the main window when you don’t need 
to see all the layers at once. Also, only visible layers will 
appear when you render a view of the project or export an 
animation - you can generate test movies much quicker if 
you turn some layers invisible that don’t involve what you’re 
currently working on. Note: the visibility box of the currently 
active layer behaves differently. The currently active layer 
is always visible (how could you edit it if it wasn’t?), and 
clicking its visibility box (while holding the Alt key) will turn all 
the other layers at the same level visible or invisible.

To the right of the visibility control is an icon that indicates 
what type of layer each entry in the layer list is. The different 
types of layers include vector, image, group, bone, switch, 
particle, 3D, and note layers.

Certain types of layers act as groups, and can contain 
other layers within them. (You can think of them like folders 
on your hard drive.) These layers have a triangle on their 
left side. Clicking this triangle opens and closes these group 
layers, allowing you to access or hide the sub-layers they 
contain.
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Layers can be re-ordered simply by dragging one layer 
above or below another layer. Just click and drag the 
layer you want to move - you will see a red insertion bar 
indicate where the layer will be placed when you drop 
it. When the insertion bar appears at the location you 
choose, just drop the layer and you’re done. You can also 
use this method to drag sub-layers into or out of group 
layers. 

The last thing you can control in the layer list is the property 
set of any layer. By double-clicking a layer in the list, a 
dialog will appear with various options controlling the 
appearance and behavior of the layer. This dialog is 
described in the Layer Settings section below.

Layer Toolbar
At the top of the Layer panel is a toolbar that provides 
several layer operations. The buttons in the toolbar are 
described below:

 Layer Toolbar

• New Layer: Adds a new, empty layer to the project. A 
popup menu allows you to choose the type of layer 
you want to add. The new layer is placed directly 
above the current active layer.

• Duplicate Layer: Makes a copy of the current active 
layer and adds it to the project. This new copy is 
placed directly above the current active layer. If you 
duplicate a group layer, all of the sub-layers inside it 
will be duplicated also.

• Delete Layer: Deletes the current active layer. This 
operation cannot be undone, so you will be asked to 
verify if this is really what you want to do.
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• Layer Settings: This command brings up a dialog with 
various controls to modify the layer’s appearance and 
behavior. The next section, Layer Settings, goes into 
detail about these options. The Layer Settings dialog 
can also be invoked by double-clicking the current 
active layer in the layer list.

Using Layer Colors
If you have many different layers in your Layers window, 
you can assign colors to them to help find specific content 
more easily. To do so, double-click the layer in the Layers 
window to open the Layer Settings dialog. In the General 
tab, choose a color for the layer from the Layer Color drop-
down selector. The layer will then be displayed in the Layers 
window in the color that you choose.

 Choosing a layer color
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Chapter 12: Layer 
Settings

The Layer Settings dialog can be invoked either by double-
clicking a layer in the layer list, or by selecting a layer, then 
clicking the Layer Settings button in the layer toolbar. The 
various controls are grouped into tabs that we’ll describe 
in order.

Click the Apply button to apply changes in settings. The 
Layer Settings window will remain open so that you can 
make additional changes.

Editing Multiple Layers
When you select a layer in the Layers palette, you can 
view the settings for that layer in the Layer Settings dialog. 
In Anime Studio 10, you can use the Shift or Command/Ctrl 
keys to make multiple selections in the Layers palette. The 
layers that you select don’t have to be the same type  of 
layer. For example, you can select an image layer and a 
vector layer as shown in the following figure:

 Use the Shift or Command/Ctrl keys to select multiple layers in 
the Layers palette.

When multiple layers are selected, the last layer that you 
select becomes the primary layer. The primary layer is 
displayed in a slightly darker shade in the layers palette. 
Secondary layers are displayed with a slightly lighter 
colored highlight. In addition, a message appears at 
the bottom of the Layer Settings dialog to indicate that 
multiple layers are selected.



Anime Studio Debut 10
Users Manual

130

Chapter 12: Layer Settings

 The Layer Settings window displays a message when multiple 
layers are selected.

The following rules apply when you are making changes to 
multiple selected layers:

• If different layer types are selected, the Layer Settings 
window will only display the tabs that apply to the 
primary layer. For example, if your primary layer is a 
vector layer but you have image layers as secondary 
layers, the Image tab will not be displayed. However, 
you will be able to edit settings that are common to 
image and vector layers in the Vectors tab.

• When you change a setting that is common to all 
selected layer types, those common changes will be 
applied to all of the selected layers when you click the 
Apply or OK button in the Layer Settings dialog. In other 
words, you can change the Blur or Opacity setting in 
the Vectors tab, and then apply that change to all of 
the layers in the selection, whether they are vector or 
image layers.

• If you make settings that are specific to the primary 
layer type, they will not be applied to sublayers of a 
different type. For example, if your primary layer is an 
Image layer and you make changes in the Images tab, 
those changes will not be applied to the vector layers 
in your selection.

• Where settings are grouped, any change to one of 
those grouped settings will cause all settings within 
that group to change on all of the selected layers. 
For example, the Outline section of the General tab 
groups three settings together: Outline On, Width, and 
Color. If you change the outline color, Anime Studio 
will also update the outline state (on or off) and outline 
width to all of the layers when you click Apply or OK. 
Settings are grouped as follows:

 � Outline (“General Tab” on page 131): Outline On, 
Width, and Color.
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 � Colorizing (“General Tab” on page 131): Colorize 
Layer, and Color.

 � Layer Shadow (“Shadows Tab” on page 141): 
Shadow On, Offset, Blur, Shadow color, Shadow 
threshold, Expansion, and Shadow direction.

 � Layer Shading (“Shadows Tab” on page 141): 
Shading On, Offset, Blur, Shading threshold, 
Shading color, Contraction, Inverted, and Shading 
direction.

 � 3D Shadow (“Shadows Tab” on page 141): 
Perspective shadow on, Blur, Shadow threshold, 
Scale, Shear, and Color.

 � Motion Blur (“Motion Blur Tab” on page 145): 
Motion blur on, Frame count, Frame skip, Start 
opacity, End opacity, and Blur radius.

 � Depth Sorting (“Depth Sort Tab” on page 154): 
Sort layers by depth, Sort by true distance, Enable 
animated layer order.

 � Toon Settings (“Image Tab” on page 155): 
Toon effect, Edge level, Gray level, Black level, 
Saturation, Lightness, Quantization.

If you make any settings in the Image tab 
that apply to videos, they will only be 

modified in secondary image layers that have video 
files as their sources.

General Tab
This tab is available for all layer types, and controls general 
layer properties.
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 General Layer Settings

• Name: This field allows you to change the name of the 
layer. You can type in any name for the layer you want 

here, and the name will appear in the layer list after 
you click the OK button. Good names make working 
with large projects much easier. Examples of layer 
names might be Background, Body, or Head.

• Hide in editing view: Turn on this checkbox to hide the 
layer while editing. The layer will still appear in rendered 
output, but will be invisible in Anime Studio’s edit view. 
This can be useful to reduce clutter and improve 
performance. Things you might consider hiding in 
the editing view are background details, texture and 
detail layers, or special effects like particle layers. Note 
that if a hidden layer is the currently active layer, it will 
temporarily un-hide itself so that you can edit whatever 
it contains.

• Don’t render this layer: If this box is turned on, then the 
layer will not appear in any rendered/exported movies. 
This option is usually used for some kind of helper layer. 
For example, you might draw a layer with some guide 
lines to help you draw and animate a scene, but you 
don’t want those guides to appear in the final output. 
Note layers have this option turned on by default.

• Allow animated layer effects: When checked allows 
you to animate layer effects by varying settings 
through the timeline. When unchecked, layer effects 
do not animate.
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• Layer Color: Layer colors are used to help you 
categorize the content in your project using colors of 
your choosing. Use the Layer Color selector to choose 
a color for the current layer. Plain will display the layer 
in the normal Anime Studio interface color. Other 
choices for categorizing your layers are Purple, Blue, 
Green, Yellow, Orange, and Red.

Compositing Effects
This group of controls allow you to change certain layer 
properties over time. When you modify any of these at 
a frame greater than 0, you will add a keyframe to the 
corresponding layer effects channel. For example, if you 
go to frame 1 and uncheck Visible, then go to frame 20 
and re-check Visible, that layer will not appear in the final 
animation until frame 20.

 Compositing Effects

• Visible: Controls whether a layer is visible in the final 
output. It is important to note that this checkbox is 
totally independent of the visibility box displayed in the 
layer list: these are two separate notions of visibility, 
and don’t affect each other at all. The visibility control 
in the layer list is meant for your editing convenience: 
you can turn one layer off while you work on another. 
The visibility checkbox in this dialog is meant to allow 
certain effects during an animation. For example, if 
you had a layer with a drawing of a glowing lightbulb, 
you could uncheck the visibility of this layer at frame 1, 
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then turn it on at frame 10, off at frame 20, on at frame 
30, etc. to create the effect of a blinking light.

• Blur radius: Lets you apply a blur (in pixels) to an entire 
layer to simulate such effects as camera focus. The 
blur can be animated over time to make a layer look 
like its coming in and out of focus. Decimal values 
are allowed to provide smoother transitions during 
animation.

• Opacity: Allows you to modify the transparency of 
an entire layer. An opacity value of 100 will not affect 
the layer at all, while a value of 0 will make it totally 
transparent. By changing the value from 0 at frame 
1 to 100 at frame 10, the layer will seem to gradually 
appear out of nowhere, which in some cases is more 
desirable than the type of on/off visibility provided by 
the Visible checkbox.

• Auto shading radius: Allows you to simulate 2D 
ambient occlusion effects. Double-click the desired 
layer, or highlight a layer in the layers panel. Turn the 
Auto Shading option on and set the radius to a value 
other than zero. A good starting point is somewhere 
between 8 and 16 pixels.

 Without Auto Shading
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 With Auto Shading

• Threshold: Works in conjunction with blur, and can be 
used to produce smoother transitions in corners. The 
more an object is blurred, the more the threshold will 
have an effect. The blur is computed first, and then 
the threshold is added on top of it to smooth out the 
overall shape.

The threshold is applied to the RGB values at 
whatever you add in the threshold field. A 

value of 128 is a midpoint value. If you end up with 
unusual colors after applying the threshold, you can 
use Colorizing to overlay a color on the layer. For 
more information about colorizing, see “Colorizing” 
on page 137.

• Flip horizontally and Flip vertically: Clicking these boxes 
flips the entire layer in the direction specified. (If the 
layer is a group layer, then the sub-layers inside it get 
flipped as well.) This can be convenient in the case 
where you want to duplicate a layer and have the 
second copy face the first one as a mirror image.

Outline
The General Tab of the Layer Settings dialog displays the 
following options for outlines:
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 Outline Options

• Outline on: Check this option to create an outline 
around the objects on the layer.

• Width: Set the desired width of the outline, in pixels.

• Color: Click to set the color of the outline.

You can add an outline to a layer by enabling the option 
in this section and specifying the width and color of the 
outline.

You can set separate colors and widths for each layer to 
add nice effects to your drawings. If you set just one color 

and width on a bone group, but not on each layer of a 
bone group, the layer outline will only be applied to the 
outline of the character (and not each individual part).

After you specify your outline parameters, you will need to 
preview your drawing with the File > Preview command, or 
use the shortcut Cmd+R (Mac) or Ctrl+R (Windows).

 With 10 pixel blue outline around the bone group
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Colorizing
The Colorizing section allows you to overlay a color on the 
selected layer. The options are as follows:

 Colorizing Options

• Colorize layer: Check this option to apply a color 
overlay to the selected layer.

• Color: Click to set the overlay color and properties.

You can use the Colorizing feature to eliminate unwanted 
or objectionable colors that occur after you apply 
thresholding to objects on a layer (see “Compositing 
Effects” on page 133 for information about the Threshold 

settings). The figure shown below shows several objects 
on a layer which have a blur setting applied (top). 
Thresholding is added to soften the shapes between 
the objects. After rendering, you may see unusual colors 
(middle) because the threshold is applied to the R, G, and 
B values in the original object color. To fix this, choose the 
Colorize layer option and select your overlay color. Render 
again to see the final result (bottom).

 Original objects (top); threshold applied (middle); with color 
overlay (bottom)
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Options
The Options section of the General Properties tab provides 
the following options:

 General Options

• Rotate to follow path: When this checkbox is turned on, 
the layer will automatically rotate to follow its direction 
of movement. (Specifically, the up direction will turn 
to follow the direction of layer translation.) This can be 
useful for creating things like flowing arrows that need 
to point in their direction of movement.

• Scale compensation: When this box is checked (as 
it is by default), and you scale an entire layer larger 
or smaller, the lines in the final rendered output will 
automatically get thicker or thinner so that they retain 
their relative weight in the overall image. Also, layer 

effects like blurs and shadows will become larger or 
smaller to match the scale of the layer.

• Use HSV modifier image: This checkbox lets you use an 
image file to distort the colors of the layer. Sometimes 
you may want to do this to break up the solid colors in 
your project and make it look less computerized. The 
exact behavior of this feature is difficult to explain. The 
best way to try it out is to use one of the HSV modifier 
images included with Anime Studio. These images 
should be pretty close to 50% gray. Other images 
may produce bizarre, unexpected results. Feel free to 
experiment - you can always turn off this checkbox if 
you don’t like the results.

• Immune to camera movements: Sometimes you may 
want to make some layers ignore camera movements. 
For example, certain backgrounds or title or logo layers 
you may want to stay in one place on the screen even 
while you move the camera around.

• Embedded Script File: Allows you to attach a lua script 
to a layer. When you play it back in the timeline or 
render a document, the script is executed to go with 
that layer.

• Immune to depth of field: The depth of field function 
(in the Project Settings dialog) lets you simulate the 
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blurring of objects with different distances from the 
camera. This option allows you to turn off this effect for 
any particular layer.

• Rotate to face camera: In previous versions of Anime 
Studio, a layer would pivot only on the Y axis and 
face the center of the camera. In Anime Studio 9.5.2 
or later, you can choose different pivot axes, and 
the layer can face the camera center or the image 
plane. This can be useful when using Anime Studio’s 3D 
camera - especially for scenery-type objects. Trees, for 
example, that always face the camera can save you 
a lot of work. Choose a rotation option from the popup 
menu:

 � No: Turns off the Rotate to Face Camera feature.

 � Pivot X Axis: Rotates the layer on its X (horizontal) 
axis as best it can to make the layer’s Z axis point 
at the camera.

 � Pivot Y Axis: Rotates the layer on its Y (vertical) axis 
as best it can to make the layer’s Z axis point at the 
camera.

 � Free Pivot: Rotates the layer on both its X 
(horizontal) and Y (vertical) axis as best it can to 
make the layer’s Z axis point at the camera.

 � Face Image Plane X Axis: Rotates the layer on its 
X (horizontal) axis as best it can to keep the layer 
parallel to the camera plane.

 � Face Image Plane Y Axis: Rotates the layer on its 
Y (vertical) axis as best it can to keep the layer 
parallel to the camera plane.

 � Face Image Plane Free Rotate: Rotates the layer 
on both its X (horizontal) and Y (vertical) axis 
as best it can to keep the layer parallel to the 
camera plane.

In the diagrams that appear below, the X 
and Z Axes are shown in red and blue. The Y 

axis points straight up, so being that we are looking 
at the scene from the top, the Y axis points at you. 
The black pyramid represents the camera view, with 
the point of the pyramid representing the eye. An 
image plane appears in front of the camera. This 
image plane is like film, and represents where the 
rendered image gets focused.

There are also three layers in the diagrams: Layer A 
is not set to face the camera. Layer B pivots on the Y 
axis so that it faces the center of the camera. Layer 
C is set to Face Image Plane Y Axis.
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In the first image, the camera is in its default position 
and rotation. Layer A, which has the Rotate to Face 
Camera feature off, will not move when the camera 
is moved. Layer B, which is set to rotate on the Y axis, 
turns to face the camera. Layer C, which is set to 
rotate with the image plane, is rotated the same as 
the image plane.

An Anime Studio scene, viewed from the top.

When the camera is moved to the left of the scene, 
and rotated to face the center, the image plane 
also rotates to the same angle. Notice now that 
Layer A remains in the same position because 
Rotate to Face Camera is off. Layer B, which is set 
to rotate with the Y axis of the camera, rotates to 
face the new position of the camera eye. And Layer 
C, which is set to rotate with the Y axis of the image 
plane, rotates in parallel with the image plane.

An Anime Studio scene viewed from the top, with the camera 
moved to the left side

• Layer blending mode: Normally, layers are composited 
on top of each other simply according to the 
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transparency of each layer. The layer blending mode 
popup lets you select a different blending mode 
for each layer. This can be very useful for simulating 
shading and lighting effects.

Shadows Tab
The controls in this tab allow you to apply automatic 
shadows and shading to an entire layer.

 Shadows Layer Settings
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Layer Shadow
This section lets you apply a drop-shadow effect to a layer. 
The options are:

Layer Shadow options.

• Shadow On: Checking the Shadow on checkbox will 
make all objects in the layer cast shadows on the 
layers underneath.

• Offset: Controls how far the shadow appears from the 
actual objects. A larger offset makes objects appear 
higher up above the layers below them.

• Blur: Determines how hard or soft the edges of the 
shadow appear.

• Shadow Threshold: Works in conjunction with blur, 
and can be used to produce smoother transitions in 
corners. The more an object is blurred, the more the 
threshold will have an effect. The blur is computed first, 
and then the threshold is added on top of it to smooth 
out the overall shape.

• Expansion: Allows you to expand the reach of the 
shadow. This can be useful for halo-type effects. Try an 
Offset of 0, Blur of 8, and Expansion of 8.

• Shadow Color: Clicking on the “Shadow color” swatch 
lets you change the color of the shadow that is being 
cast. You can also modify the transparency of the 
shadow with this control.

• Shadow Direction: Controls the direction the shadow 
is cast. Just drag the knob in circles to change the 
direction of the shadow.

Layer Shading
This section is similar to the “Layer Shadow” section above. 
However, instead of producing a shadow effect behind 
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the layer, these controls let you apply a shading effect on 
top of the layer.

Layer Shading options.

• Shading On: Checking the “Shading on” checkbox will 
make all objects in the layer appear shaded, giving 
them a rounded edges effect.

• Offset: Controls how far inside the layer the shading 
appears. A larger offset makes objects appear to have 
more “rounded” edges.

• Blur: Determines how hard or soft the edges of the 
shading appear.

• Shading Threshold: Works in conjunction with blur, 
and can be used to produce smoother transitions in 
corners. The more an object is blurred, the more the 
threshold will have an effect. The blur is computed first, 
and then the threshold is added on top of it to smooth 
out the overall shape.

• Contraction: Allows you to pull the shading further into 
the center of the layer.

• Inverted: Inverts the shading effect so that the object 
looks like it has a rim highlight.

• Shading Color: Clicking on the “Shading color” swatch 
lets you change the color of the shading that is 
applied. You can also modify the transparency of the 
shading with this control.

• Shading Direction: Controls the direction the shading 
appears. Just drag the knob in circles to change the 
direction of the shading.

3D Shadow (Perspective Shadows)
Anime Studio allows you to easily create perspective 
shadows for the objects in your scene. Select a layer from 
the Layers window and open the Layer Settings dialog. 
Click the Shadows tab, and adjust the settings in the 3D 
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shadow area. You can animate this feature by applying 
different settings at different points in the timeline. You 
will not see the shadow until after you render the current 
frame, or all or part of a movie.

The position of the shadow is determined by the Set Origin 
tool in the Layer section of the toolbox. When you set a 
perspective shadow, pay attention to the location of the 
origin of the object. The shadow is cast from the origin 
point. The origin represents the ground point, so you can 
position it to make the object look as though it is resting on 
the ground, or as if the object is floating in the air.

 Position the origin point at “ground” level.

The settings for perspective shadows are as follows:

3D Shadow options.

• Perspective Shadow On: Check this button to turn 
Perspective Shadows on. Uncheck it to turn Perspective 
Shadows off.

• Blur: Sets the amount of blur on the perspective 
shadow. Higher values create a softer shadow.

• Scale: Controls the “depth” of the shadow. Higher 
values make the shadow seem more elongated, while 
lower values make the shadow shorter
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• Shear: Allows you to control the slant of the shadow 
(the direction that the light source is coming from).

• Color: Allows you to select a color for the shadow. 
Default color is black.

Motion Blur Tab
The controls in this tab control the motion blur effect for 
this layer. Motion blur can be turned on and off during the 
course of an animation.

 Motion Blur Layer Settings
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• Motion Blur On: Checking “Motion blur on” turns on the 
effect. The default settings work pretty well for a basic 
motion blur effect.

• Frame Count: Controls how many copies of the layer 
should trail behind itself. The higher this number, the 
longer it will take to render your animation. Sometimes 
a high number may be used for an exaggerated 
anime or cartoon effect.

• Frame Skip: Controls the separation between blur 
frames. A larger number will cause the blur effect to 
trail farther out behind the current position.

• Start Opacity and End Opacity: Control how the blur 
fades away behind the layer. Generally, a motion 
blur effect will fade a bit as it trails behind the layer. 
For some special effects, however, you may not want 
the motion blur to fade at all. In those cases, set both 
values to 100 to keep the motion blur completely 
opaque.

• Blur Radius: Controls the radius (in pixels) of the motion 
blur effect.

Masking Tab
This tab is used to control layer masking. Layer masking 
controls the visible region of a layer - objects in a layer that 
are not within the visible region of the mask will not appear 
in the final output. This tab is available when a group or 
bone layer is selected.
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 Masking Layer Settings

If the layer is a group or bone layer, then the following 
options are available:

No masking in this group: Means that no masking will occur 
in this group.

• Reveal all: Means that masking is on, and by default all 
sub-layers will be fully visible.

• Hide all: Means that masking is on, and by default all 
sub-layers will be invisible (this is the most common 
option when using layer masking).

All other layers inside a group will have the following 
options for layer masking:

• Mask this layer: Clip this layer against the current mask.

• Don’t mask this layer: Skip all masking operations for 
this layer.

• + Add to mask: Add this layer to the mask. Any higher 
layers will be visible wherever this layer is visible.

• + Add to mask, but keep invisible: Add this layer to the 
mask, but don’t show it in the final output.

• - Subtract from mask: Use this layer to cut a hole in the 
current mask.

• + Clear the mask, then add this layer to it: This makes 
the mask identical to the transparency value of the 
current layer.
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• + Clear the mask, then add this layer invisibly to it:

• Exclude Strokes: Check this option to exclude outlines 
from the mask.

• Expand mask by a pixel:  Adds an additional pixel 
around a layer mask.

The masking controls are simple but powerful 
options that can be used for all kinds of 

creative tricks. The best way to explain these is with a 
hands on example. See “Tutorial 2.7: Layer Masking” 
on page 96 in your Anime Studio Tutorial Manual.

Masking Tips and Tricks
When setting up masking in a group, the best approach 
is to first set up the mask, then set up the objects to be 
masked. The bottom-most layers should define the mask 
by either adding to it or subtracting from it. Then the layers 
above that should be masked against the defined mask.

For masking to be fringe-free, try to follow these guidelines:

• Masking should only increase in a one-way direction. 
The alpha channel must increase monotonically.

• Use additive masks only (use Hide All, instead of Reveal 
All)

• Don’t use any of the following modes for child layers in 
the group:

 � Subtract from mask

 � Clear this mask then add this layer invisibility to it

 � Don’t Mask This Layer (unless all other layers in the 
group above this one also use Don’t Mask This 
Layer)

 � Exclude Strokes (unless all layers in the group 
above are set to Masked)

The following examples demonstrate some do’s and don’ts 
in masking techniques.

Simple Masking (Produces No Fringing)

This example starts with a group that contains five layers. 
each with a different shape. This group renders with no 
fringe because it follows the rule of only adding to a mask.
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 A group with five layers, each with a different shape.

To mask an example such as this, use the following settings:

• Group mask: In the Group Mask section, choose Hide 
All. In the Layer Masking section, choose Mask this 
layer.

• Layer 1: Set to +Add to mask.

• Layer 2: Set to Mask this layer.

• Layer 3: Set to Mask this layer

• Layer 4: Set to + Add to mask

• Layer 5: Set to Mask this layer

After you apply the above settings, the end result will look 
as shown in the following figure, when rendered.
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 Result of simple masking.

Mask Reset (Produces Fringing)

This example consists of a group with five layers, each with 
an oval shape. This group doesn’t follow the rules. It renders 
with fringe because Layer 4 is set to “Clear and Add to the 
Mask.”

 A group with five layers, each with a different shape.

This example uses the following settings:
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• Group mask: In the Group Mask section, choose Hide 
All. In the Layer Masking section, choose Mask this 
layer.

• Layer 1: Set to +Add to mask.

• Layer 2: Set to Mask this layer

• Layer 3: Set to Mask this layer

• Layer 4: Set to + Clear the mask, then add this layer to 
it.

• Layer 5: Set to Mask this layer

After you apply the above settings, the end result will look 
as shown in the following figure, when rendered.

 Result of mask reset.

Complex Masking (Produces Fringing)

This example starts with a group that contains three 
layers. each with an oval shape. This masking example 
also renders with fringe, because it breaks the rules by 
combining additive and subtractive masking in the same 
group.
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 A group with three layers, each with a different shape.

This example uses the following settings:

• Group mask: In the Group Mask section, choose Hide 
All. In the Layer Masking section, choose Mask this 
layer.

• Layer 1: Set to +Add to mask.

• Layer 2: Set to -Subtract from mask (this layer will be 
invisible)

• Layer 3: Set to Mask this layer

After you apply the above settings, the end result will look 
as shown in the following figure, when rendered.

 Result of complex masking.

Vectors Tab
This tab is only available for vector layers, and controls 
the appearance of lines and fills in the layer. The controls 
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here enable the vector “noise effect”. By adding “noise” 
to a layer, you can make it look more hand-drawn, or at 
least get rid of some of that pesky computer precision. 
Of course, that’s up to artistic interpretation: if you like 
computer precision, the noise effect may not be the 
feature for you.

 Vectors Layer Settings
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• Noisy Outlines and Noisy Fills: The first two checkboxes 
turn on noise for outlines and/or fills. If you turn on 
both of these, all the shapes in the layer will become 
distorted. However, if you check only one, the effect 
will look like someone was coloring but didn’t stay in 
the lines. The circle displayed on the right side shows a 
preview of what your noise effect settings will do to the 
final drawing. (The best way to understand this feature 
is to just start clicking the checkboxes and watch the 
circle.)

• Animated noise: Controls whether the noise factor will 
vary over time in your animation. This can lead to either 
a very distracting look, or a very sketchy, free-form one, 
depending on your tastes. Again, experiment with this 
and watch the circle.

• Extra Sketchy: (Associated with noise settings). Creates 
gaps in the outlines. If you have a curve being drawing 
you might actually have little gaps in it.

• Offset: Determines how far in pixels (on average) your 
drawing will be distorted from its original shape.

• Scale: Determines the “jaggedness” of the distortion. 
Larger scale numbers will result in smoother, lumpier 
distortion, while smaller numbers will give you a more 
scribbled look.

• Interval (Frames): When vector noise is set to be 
animated, you can set an interval so that the noise 
changes every nth frame, with n being the number 
that you enter in this field. Increase the number to 
reduce the amount of noise.

• Line Count: Tells Anime Studio to draw a number of 
lines, distorting each in a different way.

• Gap Filling: Sometimes two shapes are drawn that line 
up exactly side-by-side with no overlap whatsoever. In 
some situations, a small crack can appear between 
them. Turn this option on to enable Anime Studio to fill 
in these cracks.

• Legacy Curves: Switches a layer back to the curve 
drawing method used in Anime Studio 7 and earlier. 
Documents created in Anime Studio 7 and earlier 
should open in the application with this option turned 
on so that the existing artwork does not suddenly 
change.

Depth Sort Tab
This tab is only available for group and bone layers. Depth 
Sort has two controls that can be used with Anime Studio’s 
3D features.
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 Depth Sort Layer Settings

• Sort Layers by Depth: Allows sub-layers to move in 
front of and behind each other during an animation. 

Normally, layers are drawn in the order they appear in 
the Layers window. However, with this option turned 
on, layers are displayed according to how far they are 
from the camera. Typically, layers are sorted by their 
depth from the camera, but if you’re trying to create 
a 3D object using multiple Anime Studio layers (like a 
cube or pyramid), you may want to turn it on.

• Sort by True Distance: Tells Anime Studio to sort layers 
by the distance from the camera to the layers’ origins, 
rather than by depth. Usually this option will be left 
unchecked.

• Enable animated layer order: During the course of an 
animation, you may want to move objects in front of 
or behind each other. One example is when simulating 
head turns. The children of a group layer have the 
ability to move back and forth in layer order over 
the course of an animation, but you need to turn this 
option on to allow it. If it’s off, then moving one layer in 
front of another affects them for the entire timeline.

Image Tab
This tab is only available for image layers. There are five 
options in this tab.
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 Image Layer Settings

• Set Source Image: Lets you select the image to be 
used in the image layer. Use this if you want to change 
the image, or if it got lost for some reason.

• Reveal Source Image: Click the button to open 
Explorer (Windows) or Finder (Mac) to the folder that 
the current source image is contained within.

• AVI movie has alpha: Turn this on if the image layer is 
using an AVI movie, and that movie includes an alpha 
channel.

• Loop movie indefinitely: When checked, the movie 
plays in a loop for as long as required in the animation. 
When unchecked, the movie plays once and stops 
when it reaches its end.

• Play backwards: When checked, plays a movie layer 
backwards (in reverse frame order).

• Persist First Frame: When checked, displays the first 
frame of a movie continually until the playhead 
reaches the frame at which the movie begins to play. 
When unchecked, the movie will not appear in the 
project until the playhead reaches the first frame in the 
movie.

• Persist Last Frame: When checked, displays the last 
frame of a movie continually after the playhead 
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reaches the last frame of the movie in the timeline. 
When unchecked, the movie will no longer appear in 
the project after the playhead moves beyond the last 
frame in the movie.

• Premultiplied Alpha: If an imported movie has 
an alpha channel and the edges look bad after 
importing, it may be because the movie has 
premultiplied alpha. Check this option to improve 
appearance.

• Movie FPS: Sets the speed of the movie in Frames per 
Second

• Warp using bones: If this box is checked and the image 
layer is placed inside a bone layer, the bones can 
be used to warp the image as if it were printed on a 
rubber sheet.

• Nearest neighbor sampling: When this option is not 
checked, Anime Studio will try to smooth out the areas 
in between pixels when you enlarge the image. If you 
want the images to look blocky when they are resized, 
turn this option on. Anime Studio will not smooth 
the image and it will start to look blocky when it is 
enlarged.

Toon Settings
The Toon Effect filter is used with images and movies. 
Load an image or movie into a new layer. Open the 
Layer Settings dialog to the Image tab and check the 
Toon Effect option. The image or movie will be processed 
through the Toon Effect filter.

 Toon effects on a photograph

When used with videos, the processing can take quite a 
while. When working with videos, open up the movie file 
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and apply the toon effect filter. Immediately afterward, 
import the animation as a new movie file. Use the new 
movie file, with the toon effect applied, in your final project.

Some types of images work better than others. Faces 
should be pretty large in the image. If the face is small then 
a lot of detail will be lost or blurred together.

The Toon Effect filter has several parameters in the Image 
tab:

 Toon settings in the Layer Settings Image tab

• Edge level: Controls the width of the edges in the toon 
effect. Increase the setting to make the edges wider, 
and decrease to make the edges thinner.
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• Gray level: Darkens the middle areas of the toon 
effect.

• Black level: Darkens the dark areas of the toon effect.

• Saturation: Increases or decreases the amount of color. 
Negative values make the toon more black and white.

• Lightness: Increase the setting to make the image 
appear more faded.

• Quantization: Sets the number of colors in the image. 
When set at 0, the quantization works the same as 
found in Anime Studio 7 and earlier. When set to 
a value greater than 1, the value you enter is the 
number of colors in the image.

Switch Tab
This tab is only available for switch layers.

 Switch Layer Settings

• Select Audio Sync Source: Lets you select a data 
file used to control the switch layer. A data file is not 
required (you can control a Switch layer manually by 
right-clicking its entry in the Layers window), but if you 
do want to use a data file you have two choices:
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If you want a quicker lip-sync solution, you 
can use an audio file as a data file. In this 

case, your switch file should contain several version 
of a mouth shape, ranging from closed to wide 
open. The volume of the audio file will control which 
mouth shape is used at which frame. If you do use 
an audio file to control the Switch layer, you can 
either use automatic volume gain (recommended) 
or set the gain manually. The gain controls how wide 
the mouth gets. When using manual gain, start with 
a value of 1 - if the mouth seems too wide, try smaller 
values (0.75 or 0.5). If the mouth isn’t wide enough, 
try higher gain values (1.5 or 2). 

See “Tutorial 5.1: Automatic Lip-Sync” on 
page 140 in your Anime Studio Tutorial 

Manual and “Tutorial 5.2: Phoneme Lip-Sync” on 
page 142 in your Anime Studio Tutorial Manual for 
examples of using audio lip-syncing functions.

• Interpolate sub-layers: If this box is checked Anime 
Studio will do smooth transitions between the sub-layers 
as long as they’re all vector layers and contain the 
same number of points.  Notes Layer Settings

Bones Tab
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The settings in the Bones tab are as follows:

• Binding Mode: Check one of the following to select the 
binding mode that you want to use for bones.

 � Flexible Binding: This option is selected by default. 
This uses Flexi-Binding, which allows greater control 
over how bones affect different layers in a bone 
group. See “Tutorial 3.5: Flexi-Binding” on page 
120 in your Anime Studio Tutorial Manual.

 � Region Binding: Uses the binding style that was 
used by Anime Studio prior to version 9.5. See 
“Tutorial 3.4: Character Setup” on page 109 in 
your Anime Studio Tutorial Manual.

• Allow Nested Layer Control: Allows you to control the 
children of their children, making it easier to work with 
bones on images and vector art.

Anime Studio provides an option that allows 
you to control the children of a bone’s 

children, making it easier to work with bones on 
images and vector art. In other words, if you have a 
group inside a bone layer, and vector layers inside 
that group, the bone layer can warp the artwork in 
those vector layers if Allow nested layer control is 
turned on in the Bones tab of the Layer Properties 
palette and if the group layer is not bound. This 
allows more powerful bone rigging while also 
allowing you to organize your layers in a hierarchy. 
This allows you to have parent bones and 
“Grandpa” bones ... bones that affect more than 
one layer of bones beneath them.
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 Bones Settings  Bones Settings
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Chapter 13: Style 
Window

The Style window is where you set up colors, line widths, fill 
effects, and other properties to control the appearance of 
your vector artwork. The Style window has two views, Basic 
(shown on the right in the following figure) and Advanced 
(shown on the left in the following figure).

The Advanced checkbox in the lower-left corner of 
the dialog will toggle the Styles palette between Basic 
and Advanced views. Check the option to display in 
Advanced view, and uncheck it to display in Basic view.

The options in the Style window are displayed and listed on 
the following page.

When you edit the fill color, stroke color, or brush settings, 
the changes will be displayed live on the canvas so that 
you can see the effects of your changes.
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Style Window Options:
1. Shape selection drop-down menu
2. Window mode indication
3. Name field
4. Fill enable checkbox
5. Fill color selector
6. Fill effect drop-down menus
7. Fill effect settings buttons
8. Stroke enable checkbox
9. Stroke color selector
10. Stroke brush selector
11. Stroke line width field
12. Stroke effect drop-down menu
13. Stroke effect settings button
14. Round end caps checkbox
15. 3D conversion thickness field
16. Color swatch drop-down menu
17. Color swatch
18. Copy button
19. Paste button
20. Reset button
21. Advanced window checkbox
22. Checker selection

 Basic Style Options
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 Advanced Style Options

Shapes

Shape Selection Drop-Down Menu (1)
You can use this menu to select any existing and named 
shape on the current vector layer. Select <None> to 
deselect all shapes.

 Shape Selection Drop-Down Menu

• Shapes:  The fill and/or stroke that make vector 
construction visible when rendering/exporting. For 
example, if you use the Draw Shape (E) tool with the 
Auto-fill and Auto-stroke options unchecked, you will 
create a vector construction without any shape and 
it will not be visible when rendered/exported. You can 
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always use the Create Shape (U) tool to make a shape 
using this vector construction. Enabling either or both of 
these Auto options before using the Draw Shape tool 
will create a visible shape with the properties chosen.

Choose Edit >Preferences... and  in the 
Option tab, you can select Auto-name new 

shapes so that all of your shapes have names when 
created. Refer to “Options Tab” on page 252 for 
more information.

Window Mode Indication (2)
This indicates the current mode of the Style Window. There 
are three modes:

 Window Mode Indication

• DEFAULTS (For new shapes): In this mode the style you 
define will be applied to any new shapes you create. 
This default will retain the style of the last shape you 

had selected. This is the default mode when there are 
no shapes or styles selected.

• SHAPE: In this mode the style you define will edit the 
style of the currently selected shape. Selecting a shape 
in the workspace or in the shape selection drop-down 
menu will enter shape mode.

• STYLE: In this mode the style you define will either 
create a new style or edit an existing one, depending 
on the option you select from the style management 
drop-down menu.

• Name Field (3)

The name field allows you to name or rename any 
selected shape or style and displays any existing name. 

 Name Field
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Fills

Fill Enable Checkbox (4)
This checkbox determines whether a selected shape has 
a fill.

A fill is the color inside of a closed shape. This option is only 
available when you have an existing shape selected.

 Fill Enable Checkbox

Fill Color Selector (5)
This displays the fill color for the default style, the selected 
shape, or the selected style, depending on the style 
window mode. Clicking on it allows you to edit the color 
with the color picker:

 Fill Color Selector

The color picker allows you to select the color and 
transparency of the fill or stroke of your style. The large field 
to the left is where you can chose the color saturation and 
brightness. The vertical colored bar to the right of this is 
where you chose the color hue. The next, checkered bar is 
where you set the color alpha value (opacity). At the top 
right are two color chips. The top one is the current color 
and the lower one is the previous color ( click to restore). 
Below these are manual inputs for the red, green, blue, 
and alpha values. And last is a hexadecimal field where 
you can copy or paste hex values to set the color.
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 Color Picker

Fill Effect Drop-down Menu (6)
These drop-down menus allow you to select two different 
fill effects. There are many effects to chose from:

 Fill Effect Drop-Down Menu

• <plain> indicates that no effect is applied in this drop-
down.

This is followed by a list of fill effects. Some fill and line 
effects can be animated, with keyframes being added to 
the timeline when you change colors, blur radius, angles, 
offsets, blurs, and more.
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 Expanded Menu

Selecting an effect will bring up an effect settings dialog, 
each of which are described in the sections that follow. 
Each effect has a variety of specific parameters for the 
user to adjust, as well as an effect preview that updates as 
changes are made to these settings.

You will only be able to view the results of 
some effects on your shapes by rendering a 

single frame (Cmd/Ctrl+R) or exporting the 
animation (Cmd/Ctrl+E).

Shaded Fill Effects

When you choose Shaded Fill effects, a dialog displays the 
following options:

 Shaded Effect Options
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• Light Angle: Provides a dial that allows you to change 
the direction that the light is coming from. You can also 
enter a numerical value. Zero degrees is located at the 
bottom of the dial.

• Offset: Allows you to assign a value for how far the 
shadow is offset from the filled area

• Blur: Controls the softness of the shadow.

• Shadow Color: Allows you to choose the shadow color 
from a color palette.

• Shadow Only: Check this option to only display the 
shadow, without the fill.

• Threshold: Works in conjunction with blur, and can be 
used to produce smoother transitions in corners. The 
more an object is blurred, the more the threshold will 
have an effect. The blur is computed first, and then 
the threshold is added on top of it to smooth out the 
overall shape.

Soft Edge Fill Effects

When you choose Soft Edge Fill effects, a dialog displays 
the following options:

 Soft Edge Effect Options

• Blur Radius: Allows you to increase or decrease the 
softness, or blur, around the edge of the fill.

• Threshold: Works in conjunction with blur, and can be 
used to produce smoother transitions in corners. The 
more an object is blurred, the more the threshold will 
have an effect. The blur is computed first, and then 
the threshold is added on top of it to smooth out the 
overall shape.
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Halo Fill Effects

When you choose Halo Fill effects, a dialog displays the 
following options:

 Halo Effect Options

• Inset Radius: Adjusts the radius of the inner area

• Blur Radius: Adjusts the softness around the halo

• Halo Color: Click the Color chip to select a color for 
the halo.

• Halo Only: Check this option to only add the halo 
effect without the fill.

Gradient Fill Effects

Gradient fill effects can be animated and can also 
respond to bone warping. You can animate the location 
and color of all of the color markers in the gradient. All 
changes in color will show up in the timeline when added.

This is the dialog used to control the gradient effect. The 
following options appear:

 Gradient Effect Options
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• Type: Allows you to choose one of four types of 
gradient effects:: Linear, Radial, Reflected, or Angle. 
The preview shows an example of each type.

• Allow transparency: Check this option if you want the 
gradient to appear partially or completely transparent 
in some areas.

• Color: Allows you to select a color and transparency 
for the selected gradient marker (below).

• Gradient bar: This bar shows the current gradient.

• Gradient markers: Below the gradient bar are initially 
two markers, one on each end. Selecting one of these 
will fill the arrow above it and display its color in the 
Color selector to indicate it is selected. These markers 
can be moved anywhere along the gradient bar.

• You can also add additional color markers to the 
gradient by clicking anywhere just below the gradient 
bar. You can copy an existing marker by holding the 
Alt key when you select a marker. You can then drag 
this copied marker to a new location on the gradient 
bar, or even click the color selector to change its color.

Image Texture Fill Effects

When you choose Image Texture Fill effects, a dialog 
displays the following options:

 Image Texture Effect Options

• Select Texture: Click this button to choose an image file 
to be used as a texture fill.

• Tile: Choose this option if you want the image to repeat 
more than once to fill the selected area
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• Don’t Repeat: Choose this option if you do not want 
to repeat image used for the fill. The image will be 
rescaled proportionally as needed to fit the width or 
height of the area that will be filled.

Drop Shadow

The Drop Shadow feature allows you to quickly and easily 
create a drop shadow for your objects. The feature allows 
you to set the angle from which the light shines, how much 
the shadow is offset from the object, and the blur radius (or 
softness) of the shadow. In addition, you can set the color 
of the shadow through a color swatch.

When you choose a Drop Shadow, a dialog displays the 
following options:

 Drop Shadow Effect Options

• Light Angle: Provides a dial that allows you to change 
the direction that the light is coming from. You can 
also enter a numerical value. Zero degrees is located 
at the bottom of the dial.
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• Offset: Allows you to assign a value for how far the 
shadow is offset from the filled area

• Blur: Controls the softness of the shadow.

• Shadow Color: Allows you to choose the shadow color 
from a color palette.

• Threshold: Works in conjunction with blur, and can be 
used to produce smoother transitions in corners. The 
more an object is blurred, the more the threshold will 
have an effect. The blur is computed first, and then 
the threshold is added on top of it to smooth out the 
overall shape.

A preview of the settings appears in the preview window 
as you adjust them. When you are satisfied with the 
appearance of your shadow, click OK to apply the 
settings. You will need to preview the frame (Cmd/Ctrl+R) 
or export the animation (Cmd/Ctrl+E) to see the results.

Fill Effect Settings Button (7)
Each of these buttons become active when you have 
an effect selected in the effect drop-down menu next to 
it. These buttons allow you to access and edit the effect 
settings dialog of the selected effect.

 Fill Effects Settings Button

Stroke

Stroke Enable Checkbox (8)
This checkbox determines whether a selected shape has 
a stroke.

A stroke is the outline of a shape. Shapes can exist without 
a stroke or only composed of a stroke. This option is only 
available when you have an existing shape selected.
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 Stroke Enable Checkbox

Stroke Color Selector (9)
This displays the stroke color for the default style, the 
selected shape, or the selected style, depending on the 
style window mode. Clicking on it brings up the color 
picker.

 Stroke Color Selector

Stroke Brush Selector (10)

This displays the current brush used for the stroke of the 
default style, selected shape, or selected style.

 Stroke Brush Selector

Clicking this box opens the Brush Settings dialog:
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 Brush Settings Dialog

• Brush selection menu: This displays all of the available 
brushes. You can click on one to select it for use or 
select None for no brush.

• Current Brush: The name of the currently selected 
brush appears in the line immediately below the brush 
selector.

• Align brush with curve: This option changes the 
orientation of the brush to the vector curve it is applied 
to.

• Brush jitter angle: This option determines how much the 
orientation angle varies, with zero being to variance.

• Brush spacing: This allows you to set the spacing 
between each instance of the brush. Improvements to 
brush spacing have been made so that brush spacing 
remains consistent whether the brush curve follows 
curve points that are either pointed or curved.

• Minimize frame-to-frame randomness: Check this 
option to keep the brush from jittering during the 
animation.

• Tint brush using stroke color: For brushes that are 
colored (not all black) this option allows the brush to 
take on the selected stroke color instead of the color 
displayed in the brush selection menu.
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• Random Order:  When checked, randomizes the order 
of the Multi-Brush shapes while the stroke is painted.

• Brush preview: This displays a preview of the chosen 
brush settings.

Stroke Line Width Field (11)
This field allows you to set the stroke line width of the 
default style, selected shape, or selected style. The 
minimum line width is .25. After clicking in this field you can 
either type in or use the mouse wheel to adjust the value.

 Stroke Line Width Field

Stroke Effect Drop-down Menu (12)
This drop-down menus allow you to select a stroke effect. 
There are many effects to chose from. The stroke effects 
are the same as the fill effects described earlier.

 Stroke Effect Drop-Down Menu

Stroke Effect Settings Button (13)
This button becomes active when you have an effect 
selected in the effect drop-down menu next to it. This 
button allows you to access and edit the effect settings 
dialog of the selected effect.
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 Stroke Effect Settings Button

Round End Caps Checkbox (14) (18)
You’ll notice the addition of a Round Caps option in the 
Stroke section of the Advanced Style window. Check this 
option if you want to use strokes that have rounded ends. 
Uncheck the option to use flat ends on your strokes (similar 
to those used in Anime Studio 7 and earlier).

 Rounded End Caps Checkbox

Older files will open with plain end caps to retain their 
original appearance. New artwork will default to round 
end caps unless the Round Caps option is unchecked.

 Rounded end caps compared to ends that are not rounded.

3D Conversion Thickness Field (15)
This option (20) is only available for the default style or 
selected shapes on vector layers that are using either the 
Extrude or Inflate options of the vector layer Layer Settings 
>  3D Options tab > 3D Conversion drop-down. This field 
displays the 3D thickness of the default style or selected 
shape. After clicking this field, you can type in or use the 
mouse wheel to adjust this value.

These swatches appear in the Color Swatch (22) below.
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 3D Conversion Thickness Field

Swatches

Color Swatch Drop-down Menu (16)
This menu allows you to select from a variety of color 
swatches or select a Custom Image as a swatch.

 Swatches menu

 Expanded menu
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These swatches appear in the Color Swatch (22) below.

Color Swatch (17)
The swatch you select from the color swatch drop-down 
menu shows up here as a simple color picker. You can 
use this as a shortcut for selecting colors for your objects. 
Just click a color in this palette to assign it as the selected 
shape’s fill color. Right-click a color swatch to assign it as 
the selected shape’s outline color.

 Color Swatch

Copy, Paste, and Reset Buttons
There are three buttons that we’ve classified as “other” 
controls:

 Copy, Paste, and Reset buttons

• Press Copy (18) to copy the properties of the selected 
shape or style.

• Press Paste (19) to apply a previously copied set of 
properties to another shape or style.

• Press Reset (20) to switch back to editing the default 
fill and line properties - if a shape or style is currently 
selected, it will be de-selected.

Advanced Window Checkbox 
(21)
As mentioned at the beginning of this chapter, this 
checkbox switches the style window between Basic 
and Advanced views. The basic view minimizes the style 
window to some of the options most used while animating.
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 Advanced Window Checkbox
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Chapter 14: The Library 
Window

The Anime Studio Library window provides access to 
all of the content that ships with Anime Studio such as 
characters, props, images, audio, etc. It has three tabs: the 
Library tab that provides access to the content categories, 
the Search tab which allows you to search your content 
folders for specific files, and the Favorites tab where you 
can gain easy access to your frequently used or favorite 
content items.

The version of Anime Studio Debut that is sold 
through the Mac App store offers most of the 

functionality  described in this section. Differences will be 

noted in this chapter where appropriate.

The Library tab contains eight categories, discussed below. 
Each category is further divided into subcategories. You 
can create and remove categories and subcategories, 
and can add and remove content, including your existing 
content libraries, to/from the Library palette.

The following figure shows the various controls and options 
that are contained in the library palette. Navigate through 
the Library list as follows:

• Use the Up and Down arrow keys to move higher or 
lower in your content tree.

• Use the Right and Left arrow keys to open and close 
folders.

• Click or select an item in the list to expand the display 
and view a larger preview of the content item.

 The Anime Studio Library window
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1. Library Tabs: Allows you to switch between three views 
in the Library Palette: Library, Search, and Favorites.

2. Category Icons: Allows you to select one of the eight 
library categories. From left to right, they are Figures, 
Props, Images, Audio, Video, Effects, Scenes, and 3D.

3. Collapsed folder: Click the right arrow to expand 
the contents of the folder. The number that appears 
in brackets at the beginning of the folder name 
designates the number of items that are contained 
within that folder.

4. Expanded folder: Click the down arrow to collapse 
the contents of the folder. The number that appears 
in brackets at the beginning of the folder name 
designates the number of items that are contained 
within that folder.

5. Selected item: The currently selected item is 
highlighted, and displayed with a larger icon. File 
details appear at the left of the icon that indicate file 
name and other details if available.

6. Content preview: If a content item is not selected, a 
smaller preview icon appears beside the name of the 
file. Click once to select the item to view its details.

7. Double Checkmark (Add button): Click the double-
checkmark icon to add the currently selected item to 
your scene.

8. Create New Folder (+}: Click this button to create a 
new folder or subfolder beneath the currently selected 
library folder. This button appears only when a “My” 
content folder is selected (My Characters, My Props, 
etc.). You cannot add folders to the default library 
categories that are furnished with Anime Studio.

9. Save to Library (+): Click this button to save the scene 
item that is currently selected into the Library.

10. Add to Favorites: Adds the item that is currently 
highlighted in the library to the library’s Favorites tab.

Displaying the Library Window
If the Library Window is not open, select Window > Library 
or use the keyboard shortcut Command/Ctrl+Shift+L.

To resize the Library palette:

• Drag the left or right side to resize the width of the 
Library.
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• Drag the top or bottom edge to resize the height of the 
Library.

• Drag any corner of the Library palette across your 
screen to the desired height and/or width.

• Loading and Managing Items using the Library Icons

The Library icons appear as shown in the following figure. 
These icons appear at the bottom of the palette.

From left to right, these icons are:

 Library Icons

• Double checkmark: The Add to Scene (double check) 
button adds the selected item to your scene. After you 
choose a content category and locate the item you 
want to use in your scene, click the Add to scene icon 
to add the item to your project.

• Create New Folder: Click the Add a Folder (+) button to 
create a folder beneath the currently selected Library 
folder.

• Save to Library: Clicking the Save to Library (+) button 
adds the selected item to the Library palette.

• Delete from Library: Clicking the Delete from Library 
(-) button removes the selected item from the Library 
palette.

The Save to Library and Delete from Library 
buttons allow you to save and delete content 

to your “My” folders only. You will not be allowed to 
save or delete library content from the Anime Studio 
library.

Add to Favorites: Click to add the currently 
highlighted library item to your Favorites list.
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About Library Palette Categories
Anime Studio’s library allows you to quickly select 
categories and the items contained within them:

Click a Category icon to select a Content category. Then 
drill down in the hierarchical list in the Library list to select 
the item you want to add to your scene.

 Category Icons

The default categories are broken down by content type: 
Figures, Props, Images, Audio, Video, Effects, Scenes, and 
3D. When you switch between categories, the Library 
remembers which item was selected the last time you used 
a specific category.

The content items are shown as a series of thumbnails 
arranged in a tree hierarchy. This area is called the 
Content pane.

 Content Pane
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Maintaining Your Content Folders
When you first start Anime Studio, you are prompted 
to create a content folder. The steps are discussed in 
“Creating a Content Folder” on page 7. You can use 
the subfolders in this directory to store your own custom 
Anime Studio-compatible content.

In addition, the Library window allows you to add content 
to your own folders so that you can access this content 
more easily. When you select one of the category icons at 
the top of the Library window (such as Characters, Props, 
Cameras, and so on), you’ll see a “My” folder at the top 
of the content pane. For example, you will see a folder 
named My Characters in the Character category.

You can maintain your Library palette by adding and 
removing items to and from the Library palette, as 
described below.

Creating Subfolders
You can create new subfolders in the library to store your 
content. Follow these steps:

1. Click the category icon that applies to the subfolder 
you want to create. For example, if you will use the 
new folder to store your own characters, select the 
Characters category.

2. Highlight the folder beneath which you want the new 
folder to appear (such as the Anime Characters folder 
shown in the following figure.

3. Click the Create New Folder icon located at the 
bottom of the Library palette. You are prompted to 
enter a name for the new folder.

4. Enter a new folder name and choose OK. The folder 
appears in the Library window.

 Creating a Subfolder



Anime Studio Debut 10
Users Manual

187

Chapter 14: The Library Window

Adding Items to the Library
Saving an item to the Library palette adds the appropriate 
item to the currently selected category/subfolder. To add 
an item to the Library palette:

1. In the Layers window, locate and highlight the 
item that you want to save to the library. Assign a 
descriptive name to the object, if necessary, as the 
Library uses the layer name to identify the Library 
object name.

2. In the Library window, select the desired category/
subcategory by clicking the appropriate Category 
icon (Figures, Props, Images, Audio, Video, Effects, 
Scenes, or 3D).

3. Click the Save to Library icon (+) at the bottom of the 
Library palette. The object is saved to the Library folder 
that you selected.

 Library Icons

Deleting Items from the Library Palette
To delete an item from the Library palette, select it by 
clicking its preview image, then click the Delete from 
Library icon (-) at the bottom of the palette (see below for 
an image of the Library icons).

Deletions are permanent! Be sure you really 
want to delete the selected item. If you have 

not saved your content elsewhere (such as 
archiving the source files), the deleted content will 
be permanently lost. You cannot undo content 
deletions.
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Searching the Library
The Search tab in the library allows you to perform a 
keyword search in all or in selected categories.

 Library Search Tab

To perform a search, follow these steps:

1. Switch to the Search tab in the Library.

2. Enter a keyword (such as anime) or a series of 
keywords (such as outdoor scene) in the Search For 
field.

3. Check or uncheck options as follows:

 � To perform a search throughout all Library 
categories, check the All Categories option.

 � To perform a search in specific categories in your 
Library, uncheck the All Categories option and 
then check or uncheck Characters, Props, Images, 
Audio, Video, Effects, Scenes, or 3D as needed to 
find the content you are looking for.

 Searching specific categories

4. Click the Search (eyeglass) button. Anime Studio 
performs a search for the content that you specified, 
and search results appear in the Content pane.
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Favorites Tab
The Favorites tab allows you to quickly add your favorite 
content to library folders that you create yourself.

To add an item to the Favorites tab:

1. Highlight the library item that you want to add to 
favorites.

2. Click the Add to Favorites button at the bottom of the 
Library palette. An Add to Favorites menu appears 
above the selected item.

3. From the menu, select an existing Favorites category, 
or choose <<New Folder>> to create a new Favorites 
folder. When the New Library Name dialog appears, 
enter a name for your new folder and click OK. The 
new folder appears in the Favorites tab and your item 
appears within it.

 Add to Favorites button

You can also access library content by choosing 
Import > and selecting content from one of the various 
subcategories.
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 Selecting content from the File > Import command
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Chapter 15: The 
Character Wizard

The Character Wizard allows you to quickly and easily 
create characters that you can animate in Anime Studio. 
It consists of several different tabs that allow you to specify 
body proportions, facial features, movement, clothing and 
other styling features.

Using the Character Wizard
You can open the Character Wizard by clicking the 
Character Wizard button that is located in the upper right 
corner of the Anime Studio interface. It appears just to the 
left of the Library button.

The Character Wizard consists of a number of different tabs 
that help you design your own character. There are also a 
few controls that appear from one tab to the next.

 Click the Character Wizard button to open the Character 
Wizard

 The Character Wizard window
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Presets
The Presets drop-Down allows you to choose from a 
number of different character types: Boy Spiky, Creature, 
and Mannequin. Each of these different humanoid 
character types has a different appearance to start with, 
varying in proportion, body shape, head shape, and so 
on. Some presets are more “human” while other are more 
fantasy-like. You can use the other tabs to customize the 
appearance of the Preset even further.

Use the + button beside the Preset drop-Down to create 
your own preset, or the - button to delete a preset that you 
have previously saved yourself. Built-in presets cannot be 
deleted.

The preset will be saved at its current state. If 
you go back and later change the 

character’s appearance (such as changing features 
or colors), the saved preset does not automatically 
update to reflect those changes. You can resave 
the character under its original name to overwrite 
the old one, or save a new preset under a different 
name.

 Presets available in the Character Wizard

Changing the Character Views
On the right side of the Character Wizard, you will see a 
preview of the current character. Beneath the preview is a 
slider, that allows you to view your character in one of eight 
angles. Move the slider to the right or left to change the 
perspective view of the character. The first bar displays the 
character in its front view. As you move the slider toward 
the right, the view changes to reflect 1/8 of a circle (as if 
the character has turned 45 degrees).
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 Changing character views

 Different character views

Exporting Views
After you complete your character in wizard, either with 
a preset or by customizing in the other tabs (described 
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in the sections that follow) you can click OK to exit the 
character wizard and view the character in your Anime 
Studio project.

Before clicking the OK button, you should check the status 
of the Export All Views option beneath the view slider. With 
this option checked, five views of the character will be 
exported to your Anime Studio project (Front, Front 3/4, 
Back, Back 3/4, and Side). With the option unchecked, only 
the currently selected view will appear in your project.

Randomizing Characters
The lower-right corner of the Character Wizard contains 
a Randomize button. When you click this button, the 
Character Wizard combines settings from the different tabs 
to create a totally unique character. This is a quick and 
easy way to generate a customized character or preset as 
a starting point that you can later modify yourself.

 Some random characters

Body Tab
The Body tab allows you to adjust the proportions of the 
various parts of the character’s body. Move the sliders 
left or right to adjust the proportions as described in the 
following sections. The preview window will update the 
character in real time while you make your adjustments.
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 Character wizard Body tab

Proportions

• Height: Move the slider toward the left to make the 
character shorter, or toward the right to make the 
character taller.

• Torso height: Move the slider toward the left to 
decrease the height of the area between the 
shoulders and hip, or toward the right to increase the 
height of this area.

• Leg length: Move the slider toward the left to shorten 
the legs, or toward the right to lengthen them. The feet 
will remain stationary on the ground.

• Head height: Move the slider toward the left to make 
the head smaller, or toward the right to make the 
head larger. The height of the character will remain 
the same.

• Belly width: Move the slider toward the left to decrease 
the width of the waist, or toward the right to increase it.

 Proportion options
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Legs

• Hip width: Move the slider toward the left to decrease 
the width of the hip, bringing the legs closer together. 
Move the slider toward the right to increase the width 
of the hip, creating more space between the legs.

• Leg width: Move the slider toward the left to make the 
legs and hip thinner, and toward the right to make the 
legs and hip wider.

• Leg muscles: Move the slider toward the left to make 
the legs appear less muscular (and more bony). Move 
the slider toward the right to add more muscle to the 
legs.

• Foot length: Move the slider toward the left to 
decrease the size of the feet, or toward the right to 
increase the size of the feet.

• Feet: Use the Feet drop-Down menu to select the 
appearance of the feet. Choose Generic to create 
a simple representation of a bare foot with no toes. 
Other choices include Anime Boy Sneakers, Bare (with 
toes), Bowling Shoes, Female Sandals, Male Sandals, 
Reference, and Simple.

 Leg options

Arms

• Arm length: Move the slider toward the left to shorten 
the arms from the shoulder, and toward the right to 
lengthen them.

• Shoulder width: Move the slider toward the left to 
decrease the width of the shoulder (bringing the 
arms closer toward the body), or toward the right to 
increase the width of the shoulder (moving the arms 
away from the body).

• Arm width: Move the slider toward the left to decrease 
the size of the arms (making them thinner), or toward 
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the right to increase the size of the arms (making them 
fatter).

• Arm muscles: Move the slider toward the left to make 
the arms less muscular and bony, or toward the right to 
make them more muscular.

• Hand length: Move the slider toward the left to 
decrease the size of the hands, and toward the right to 
increase the size of the hands.

• Hands: Use the Hands drop-Down menu to select a 
style of hands for the character. Choose Generic to 
create generic hands that have no fingers. Other 
choices include Anime Boy Mittens, Female Red Nails, 
Long Fingers, Simple, Square, and Toon.

 Arm options

Face Tab
The Face Tab of the Character Wizard allows you to select 
and adjust the facial features, including the head, eyes, 
mouth, and nose. Included at the bottom of the various 
categories are the following sliders:

• Horizontal adjustment: Move the slider left or right 
to position the facial features, if necessary after you 
adjust the head proportions. For example, you can 
move the eyes, nose, and mouth closer to the face 
if they appear to be detached from the face. The 
adjustment slider will be disabled in the Front and Back 
views where it does not apply.

• Vertical adjustment: Move the slider left or right to 
adjust the height of the facial features, if necessary 
after you adjust the head proportions. For example, 
in some cases, the profile of the lips will not match up 
with the line of the mouth and this control can match 
it more closely.
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 Character wizard Face tab

Head

• Head selector: Click the Head drop-Down list to choose 
from a number of preset character heads. Styles range 
from human to fantasy and more. Some characters 
have hair or hats, while others are bald.

• Neck width: When you are working with a head where 
the size of the neck can be adjusted, this dial allows 
you to increase or decrease the width of the neck. The 
option will be disabled when the character does not 
have a resizeable neck.

• Head top: (enabled for Generic head only) Move 
the slider toward the left to decrease the width of the 
crown, or toward the right to increase the width.

• Head middle: (enabled for Generic head only) Move 
the slider toward the left to decrease the width of the 
middle head, or toward the right to increase the width.

• Head bottom: (enabled for Generic head only) Move 
the slider toward the left to decrease the width of the 
lower head, or toward the right to increase the width.

 Head options
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Eyes

• Eye selector: Use the Eyes drop-Down list to select one 
of several different eye shapes.

• Size: Move the slider toward the left to decrease the 
size of the eyes, or toward the right to increase the size 
of the eyes. The size will increase or decrease from the 
center point of each eye.

• Height: Move the slider toward the left to lower the 
eyes, or toward the right to raise the eyes.

• Spacing: Move the slider toward the left to bring the 
eyes closer, or toward the right to move the eyes 
farther apart.

 Eyes options

Mouth

• Mouth selector: Use the Mouth drop-Down list to select 
one of several different mouth shapes.

• Size: Move the slider toward the left to decrease the 
size of the mouth, or toward the right to increase the 
size of the mouth.

• Height: Move the slider toward the left to lower the 
mouth, or toward the right to raise the mouth.

 Mouth options

Nose

• Nose selector: Use the Nose drop-Down list to select 
one of several different nose shapes.
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• Size: Move the slider toward the left to decrease the 
size of the nose, or toward the right to increase the size 
of the nose.

• Height: Move the slider toward the left to lower the 
nose, or toward the right to raise the nose.

 Nose options

Head Prop
Head props are only enabled when the Creature is 
selected as a character preset.

• Prop: Use the Prop drop-Down list to select one of 
several different head props, such as hats, beards, 
curls, and other facial and head features.

• Size: Move the slider toward the left to decrease the 
size of the head prop, or toward the right to increase 
its size.

• Height: Move the slider toward the left to lower the 
head prop, or toward the right to raise it.

 Head Prop options

Movement Tab
The Movement tab in the Character Wizard allows you to 
generate a walk cycle for your character, very quickly and 
easily, through the use of sliders. As you design the walk 
cycle, it will be applied to all of the character views (front, 
back, sides, and quarter-views).
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 Character wizard Movement tab

The following options appear:

• Insert Walk Action: When you check this option, 
your character will be exported with movements. 
If you later decide that you aren’t happy with the 
movement, you will need to delete the keyframes 
associated with it. With the option unchecked, 
keyframes for movement will not be exported.

• Steps per second: Move the slider toward the left to 
make your character walk more slowly, and toward 
the right to make it walk faster.

• Step distance: Move the slider toward the left to make 
your character take shorter steps, and toward the right 
to make your character take longer steps.

• Step height: Move the slider toward the left to keep 
the steps closer to the ground (less knee bend); and 
toward the right to raise the feet more from the ground 
(more knee bend).

• Arm swing: Move the slider toward the left to decrease 
the arm swing (making it stiffer), and toward the right 
to increase the arm swing (making it looser).

• Torso bend: Move the slider toward the left to add 
less bend to the torso (making the posture straighter). 
Move the slider toward the right to add more bend 
(adding more bounce to the walk).
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 Other settings options

Clothing Tab
The Clothing Tab allows you to change the style and colors 
of the pants and shirt that the character wears. There are 
two sections available in this tab.  Character wizard Clothing tab

Pants

• Type selector: Choose whether you want your 
character to wear short or long pants.

• Color: Click the color chip to open the color palette, 
where you can select a new color for the pants.
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 Other settings options

Shirt

• Type selector: Choose whether you want your 
character to wear a short-sleeved shirt or a long-
sleeved shirt.

• Color: Click the color ship to open the color palette, 
where you can select a new color for the shirt.

 Other settings options

Style Tab
The Style tab allows you to change the skin color, hair 
color, and stroke color and width for your character.

 Character wizard Style tab

The settings you select here are as follows:



Anime Studio Debut 10
Users Manual

204

Chapter 15: The Character Wizard

 Other settings options

• Skin color: Click the color chip to open the color 
palette, where you can select a new color for the skin.

• Hair color: Click the color chip to open the color 
palette, and select a new color for the hair.

• Stroke color: Click the color ship to open the color 
palette, and select a new color for the character 
outlines.

• Stroke width: Sets the stroke width size to use as the 
default.

If you have a mouse with a scroll wheel, you 
can increase or decrease this value while 

watching the character update in the preview 
window

• Set as default: Click this button after you change the 
value in the Stroke Width field.

• Randomize line width: With this setting on, the line width 
will vary slightly across the character. With the setting 
off, the line width will be uniform.

• Scale compensation: When checked, the stroke width 
will be proportionally adjusted as the character is 
resized. If you make the character smaller, the strokes 
will get narrower. If you make the character larger, 
the strokes will get wider. When unchecked, the stroke 
width will remain the same when you increase or 
decrease its size, and changes to stroke width will need 
to be made manually.

Designing a Character and Walk 
Cycle
The Walk cycle is a computer generated action. The others 
(Jump, Kick, and Wave) are custom actions that were 
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created in Anime Studio Pro. These actions can be applied 
to any character.

To create a walk for your character, follow these steps:

1. Click the Character Wizard button in the upper-right 
corner of the Anime Studio interface to open the 
Character Wizard.

2. Design your character using the Body, Face, Clothing, 
and Style tabs as outlined in the previous sections. Use 
the view slider beneath the preview window to view 
your character from all directions as you design it.

Pay attention to the adjustments you make in 
height and placement of the facial features. 

Use the Horizontal and Vertical adjustment sliders to 
position the eyes, nose, and mouth in the side and 
quarter-view, and then verify that the changes are 
acceptable for each of those views. In other words, 
if you use the slider to adjust the position of the nose 
and mouth in the side view, also look at how the 
changes affect the placement of the facial features 
in the Front 3/4 and Back 3/4 views.

3. After you design your character, click the Movement 
tab.

 Character wizard Movement tab

4. Adjust the Steps per second, Step distance, Step 
height, Arm swing, and Torso bend sliders until you are 
happy with the walk.

5. The preview window shows a preview of the walk 
cycle as it is applied to your character. You can view 
the walk from several angles by moving the slider right 
below the preview window. Examine your character 
from all directions and make tweaks as necessary 
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before you export it to your Anime Studio project. You 
will export your character in the next tutorial.

6. Click the + button at the top of the Character Wizard 
window. Name your character My First Character and 
click OK to save the preset. Now you will be able to 
reuse that character preset in any of your projects.

 Saving a preset character

7. Click OK to exit the Character Wizard. You will notice 
that the character appears in your scene when you do 
so. The next two tutorials will explain different ways that 
you can export and use the character in your projects.

Making Your Character Walk
In the previous project you designed a character and 
a walk, and saved the preset. When you exited the 

Character Wizard, you noticed that the character that 
you worked on appeared in the project window. However, 
because you saved the character, you can easily reuse 
it at any time in any project you start. We will begin this 
tutorial with a new project, and you’ll reuse the character 
preset that you designed in the previous exercise. In this 
tutorial, you will export only one view of the character: the 
Side view.

1. Start a new empty project in Anime Studio.

2. Optionally, you can shorten the length of the 
animation from its default of 240 frames. To do so, enter 
100 in the end frame field in the timeline.

 Decrease the length of the animation to 100 frames.

3. Click the Character Wizard to open the Character 
Wizard.
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4. From the Presets menu at the top of the screen, select 
the My First Character preset that you created in the 
previous exercise. Your custom character appears in 
the preview area.

 Choosing a preset character

5. Move the View slider so that you see your character in 
the side view.

6. Uncheck the Export All Views option beneath the 
preview window. This will export only the current view, 
which is now set to the Side view.

7. Click OK to exit the Character Wizard. Your character 
now appears in the scene. Press the Play button and 

you will see the character walking in the center of 
the scene. Press the Stop button after you view the 
animation.

8. Click the Rewind button to move the timeline back to 
Frame 0. Then use the Transform Layer tool to move 
your character off the screen to the left.

 Transformation
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 At frame 0, move the character to the left of the screen.

9. Advance the timeline to frame 96, and move the 
character off to the other side.

 At frame 96, move the character to the right of the screen.

10. Press the Play button to view your character as it walks 
across the screen.

Rotating Your Character 360 
Degrees
In this exercise you’ll make your character spin around in a 
full 360 degree circle.

It’s fairly easy to do, if you follow these steps:

1. Start a new empty project in Anime Studio.
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2. Click the Character Wizard to open the Character 
Wizard.

3. From the Presets menu at the top of the screen, select 
the My First Character preset that you created in the 
previous exercise. Your custom character appears in 
the preview area.

4. Select the Front view before you export the character. 
This is the view that will be visible when you initially 
import the character into your scene.

5. Make sure that the Export All Views option beneath 
the preview window is checked. This step will be 
necessary, because you will be working with all of the 
exported views in this project.

6. Click OK to exit the Character Wizard. The character 
appears in your project.

7. The top layer of the character is a Switch layer, and 
the various character views appear as bone groups 
beneath it. With the character’s switch layer selected 
(the topmost layer), use the Transform Layer tool to 
resize your character as needed.

As a general rule, you will want to select the 
Switch Layer (the top layer) when you 

translate, scale, or rotate your character. This applies 
the changes to all views of your character. If you 
want your character to face a different direction at 
a specific point in the timeline, you simply move to a 
later frame, and make the appropriate switch layer 
active. This will be demonstrated in the next few 
steps. For more information about switch layers, see 
“Switch Layer” on page 103.

8. If you are not already at Frame 0 in the timeline, use 
the Rewind button to return there. Your character 
should be facing toward the front.

9. Now, advance the timeline to Frame 6. Expand the 
character’s switch layer so that you see the various 
views, as shown in the following figure. The view that 
has the filled-in bone is the layer that is currently in 
view.
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When you export multiple views of the 
character, you will see the character appear 

as a Switch Layer. Each of the different views of the 
character then appear as individual bone groups 
beneath that layer, as shown in the following figure. 
The view that is currently visible is the layer that you 
had selected at the time you exported the 
character (in this case, the Front view).

 The different views of the character appear as bone groups 
within the switch layer. The layer that shows a highlighted bone 

is the switch layer that is currently visible for the character.

10. At Frame 6, right-click in the Switch layer (shown as 
Man in the above figure), and select the Front 3/4 
view. Your character should rotate to that view and a 
keyframe will appear at Frame 6.

 At Frame 6, right-click the Switch layer (shown here as Man) 
and select the Front 3/4 view.

11. Now move to Frame 12 (the next keyframe), and right-
click to select the Side view in the Layers window. Your 
character will rotate to face the side.

12. At Frame 18, switch to the Back 3/4 view.

13. At Frame 24, switch to the Back view. At this point, your 
character has turned one-half of the circle.
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14. Now select the Transform Layer tool. You won’t 
actually use this tool, but you will use the Flip Horizontal 
button later in this tutorial.

15. Advance to Frame 30. In the Layers window, right-click 
the switch layer, and choose the Back 3/4 view.

16. Next, to make your character continue to spin in 
the same direction (rather than return in the same 
direction from which it came), you’ll need to click the 
Flip Layer Horizontally button in the Transform Layer 
tool option bar, as shown below.

 At Frame 30, select the Back 3/4 view and then flip it 
horizontally.

17. Complete the remaining three frames as follows:

 � Frame 36: Right-click the switch layer to choose 
the Side view.
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 � Frame 42: Right-click the switch layer to choose the 
Front ¾ view.

 � Frame 48: Right-click the switch layer to choose the 
Front view.

18. Save the project if you like, and then play back the 
animation. You should see your character spin around 
in a circle.
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Chapter 16: The 
Timeline Window

The Timeline window is used when animating in Anime 
Studio to control the current time, and to control objects’ 
keyframes.

 The Anime Studio timeline

The Timeline window only displays information about the 
currently active layer in the project. When you switch to a 
new layer, the timeline panel will update its display to show 
the new layer’s keyframes.

Changes are not displayed in the timeline until you actually 
create a keyframe change in a channel. For example, you 
won’t see a change in the Bone channel until you actually 
move a bone.

 Animation channels are not displayed in the timeline until you 
add them to your project

If you then rotate the layer, you’ll see the Rotation channel 
added to the timeline, along with its keyframe.

 A rotation channel added to the timeline
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There is a Preferences option that allows you to consolidate 
timeline channels. This option is off by default in Anime 
Studio Pro, and on by default in Anime Studio Debut.

 Uncheck the Consolidate Timeline Channels option before you 
delete keyframes

This option combines all changes on a single layer into one 
line in the timeline. The following image shows an example 
of a layer that has several channel changes (top), and 

what the layer looks like if the Consolidate Timeline 
Channels option is active (bottom).

 A timeline that is not consolidated (top), and a consolidated 
timeline (bottom)



Anime Studio Debut 10
Users Manual

215

Chapter 16: The Timeline Window

The consolidated timeline view displays a 
keyframe when there is a change in any of 

the consolidated layers. If you delete a keyframe, 
you may not be sure which type of keyframe you 
are deleting , or whether or not there are multiple 
keyframes being deleted at that point. Be sure to 
uncheck the Consolidate Timeline Channels option 
in the Preferences dialog before you remove any 
keyframes from your timeline.

Controlling Time
The top of the Timeline window has controls for setting the 
current time. Whenever you modify an object in Anime 
Studio, the modification is recorded at the current time. 
The process of modifying an object, changing the time, 
and modifying it again is how an animation is created in 
Anime Studio.

Time in Anime Studio is expressed in terms of “frames”, 
where there are x number of frames in a second. By 
default, a new Anime Studio project has 24 frames per 
second, although this value can be adjusted in the Project 
Settings dialog.

The first set of controls for adjusting time is a set of VCR-like 
playback buttons. (These are actually at the bottom of the 

main window, not in the Timeline window itself.) From left to 
right these buttons are: rewind, step back, stop, play, step 
forward, and jump to end.

 Playback controls

Rewind sets the current frame to 0, while jump to end sets 
the current frame to the last one in the animation (the 
length of the animation is defined by the shaded area 
in the time ruler). The step forward and back buttons 
advance and back up by one frame. The play button 
plays back the animation in the main editing area, 
repeating playback in a loop. Finally, the stop button stops 
playback.
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At the top-left of the Timeline window is a text control that 
indicates the current frame number. You can change the 
current frame by typing in a new value here and pressing 
enter.

Directly below the frame field is a sort of ruler that measures 
time. This time ruler has small tick marks, one per frame, and 
has labeled frame numbers at intervals along its length. 
The time ruler also displays the current frame with a red 
triangular marker above the current frame’s tick mark. The 
time ruler is used both as an indicator of the current time, 
as well as a control to adjust it. By clicking (or clicking and 
dragging) anywhere on the time ruler, you can change the 
current frame.

A certain range of frames in the time ruler are shaded with 
a darker color. This shaded region indicates the length of 
your animation. When you play back your animation in 
Anime Studio or export it as a movie file, this shaded region 
is the part that will play back. You can change the start 
and end frames of your animation in the Project Settings 
dialog, or you can Alt-click in the time ruler to set a new 
start and/or end time. Alt-Click with the left mouse button 
to set the start of your animation, and Alt-click with the right 
mouse button to set the end.

Navigating the Timeline with the 
Mouse
To navigate through the timeline with your mouse, you can 
use the following:

• Use the mouse scrollwheel to move the sequencer 
vertically (up and down through the layers).

• Press the Alt key while you use the scrollwheel to move 
the playhead  right and left through time.

• Right-click and drag to pan left or right through the 
timeline.

• Use the mouse wheel in Graph mode to zoom in and 
out of the timeline.

Playing a Partial 
Segment

Sometimes, you may want to play back just a short 
segment of the timeline, instead of your entire animation. 
For example, you may be working on one small move, and 
you want to play it back over and over while you make 
small changes to see when you’ve got it just right.
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To set a limited segment of the timeline for playback, hold 
down the Ctrl key (Windows) or Cmd key (Mac) while you 
click in the time ruler. Click with the left mouse button to 
set the beginning of the segment, and click with the right 
mouse button to set the endpoint. To remove the limited 
playback segment, Ctrl-click on the segment endpoints to 
remove them from the timeline.

Animation Channels
Most of the timeline panel is taken up with animation 
channels, drawn as horizontal bars below the time ruler. 
Each animation channel displays a certain type of 
motion or effect that can take place in an Anime Studio 
animation. These animation channels only appear in 
the timeline if you have keyframes associated with that 
particular animation channel.

Different types of layers have different animation channels 
available. For example, vector layers are the only ones 
with a point animation channel, and bone layers are the 
only ones with bone animation channels. At the left end of 
each animation channel is a small icon that indicates what 
type of channel it is.

Shown below are the icons for the various types of 
animation channels. Note that the red-colored channel 
icons represent animation for the currently selected object. 

(If you’re ever unsure about which channel an channel 
icon refers to, just hold your mouse over it momentarily for 
a tooltip reminder.)

To help reduce visual clutter, not all 
animation channels have to be displayed at 

once in the timeline. For example, you won’t often 
have to refer to the Layer Shading channel in the 
timeline. Hidden channels are still doing their work 
behind the scenes, they just aren’t displayed in the 
timeline.

Layer Motion Channels

Layer Translation

Layer Scale

Layer Z Rotation

Layer Y Rotation

Layer X Rotation

Layer Horizontal Flip
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Layer Vertical Flip

Layer Shear

Layer Effect Channels

Layer Visibility

Layer Blur

Layer Opacity

Layer Shadow

Layer Shading

Layer Motion Blur

Camera Channels

Camera Tracking

Camera Zoom

Camera Roll

Camera Pan/Tilt

Vector-Only Channels

Point Motion

Selected Point Motion

Point Curvature

Selected Point Curvature

Fill Color

Selected Fill Color

Line Color

Selected Line Color
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Bone-Only Channels

Bone Angle

Selected Bone Angle

Bone Translation

Selected Bone Translation

Bone Scale

Selected Bone Scale

Bone Lock

Selected Bone Lock

Switch-Only Channels

Switch Layer

Particle-Only Channels

Particles On/Off

Working with Keyframes
Keyframes are displayed along the length of an animation 
channel. A keyframe represents a point in time at which 
you, the animator, made a modification to an object. 
For example, if you set the current time to frame 24, then 
scale the layer, a keyframe will appear in the layer scale 
channel at frame 24.

Keyframes appear as small markers on the channels. At 
points in time that lie in between keyframes, Anime Studio 
automatically calculates how to move an object from one 
keyframe position to the next.

Keyframes are not just static elements displayed in the 
animation channels. They can be moved, deleted, and 
copied. Anime Studio remembers what key frames are 
selected when you change layers, delete keys, move keys, 
and so on.
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Adding Keyframes
Keyframes are added automatically when you make a 
change (such as position, rotation, scale, etc) on any 
object in your project.

Use the Animation > Add Keyframe command to add 
a new keyframe to any animation that already has 
keyframes.

You can also add a keyframe to the current frame at 
any time by double-clicking the timeline in any animation 
channel. 

Copying and Pasting Keyframes
Another way of creating keyframes is to copy an object’s 
position from another point in time. To do this, first select 
the keyframes you want to copy. Next, press CMD/CTRL+C. 
Now, set the current frame to when you want the copied 
keyframe to appear (using the time ruler or the step 
forward/back buttons). Finally, press CMD/CTRL+V to place 
a copy of the keyframes at the current time. When you 
paste keyframes, they become the new selection so that 
you can move, scale, or finetune them.

Selecting Keyframes
To modify a keyframe, first it must be selected. This is 
accomplished simply by clicking a keyframe in the timeline 
panel. A selected keyframe shows up in a highlighted 
color.

Multiple keyframes may be selected by holding the shift 
key while clicking on keyframes. Alternatively, you can click 
and drag a rectangular selection box around the group of 
keyframes you want selected.

You can also right-click a keyframe and then use the Select 
Keys to Right command in the context menu to select all 
keyframes that appear in time after the currently selected 
keyframe. This helps when you need to add space in the 
middle of a long animation, because you won’t have to 
scroll through to the end of the animation while selecting 
keyframes manually.
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 Keyframe context menu

 Keyframe context menu

Deleting Keyframes
To delete selected keyframe(s), press the Delete key. 
Deleting a keyframe removes motion from an object.

Moving Keyframes
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Keyframes can also be moved by dragging them forward 
and back in time. If you want some motion to take less 
time, drag its keyframe to the left. To take more time, drag 
it to the right.

In Anime Studio 9.5 and later, you can move 
selected keyframes beyond other keyframes.

Coloring Keyframes
You can use color to label the keyframes in your timeline 
in ways that are meaningful to you. For example, you 
can assign one color to keyframes that pertain to a 
particular character in your scene, and another color for 
another character. This helps you visually keep track of the 
movements associated with a particular object or group of 
objects.

To add color to keyframes, select the keyframes that you 
want to assign color to. Then right-click to display the 
Keyframe context menu, and choose Label > followed 
by your color choice (Gray, Purple, Blue, Green, Yellow, 
Orange, or Red).

 Assigning a color label to keyframes

Editing Multiple Keyframes
If you have a number of keyframes that you want to edit. 
you can now select multiple keyframes and edit them 
at the same time. For example, if you want to move an 
object to a different part of the screen but want to keep 
the animation of that object the same, you can select all 
the keyframes and translate them all at the same time. 
Select all the keyframes for that object and use the mouse 
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to move the object to the new location. Then release the 
mouse button to complete the movement.

This works for both layer movement and point movement. 
For example, let’s say that you have a circle that squashes 
and stretches, but you want to turn it into a petal shape. 
You can select all of the keyframes and then reshape the 
object on the first keyframe as needed. Then the reshaping 
will be applied to all of the keyframes that follow.

Hold Durations
There are times when you need to hold an object in the 
same position for a while, before the animation starts. In 
cases like this, you can add a hold duration that keeps 
the object in place for a set number of frames. Place a 
keyframe in the first frame where you want the object to 
stay still, and then add a hold duration for the number of 
additional frames where you want the object to pause.

To directly modify the hold duration for a selected 
keyframe, hold down the ALT/OPTION key while dragging 
the keyframe in the timeline. A red-colored rectangle will 
appear in the frames where the keyframe is held in its set 
position.

You can also right-click the keyframe in the timeline to 
display the keyframe context menu, and then enter a hold 
duration (in frames) in the Hold Duration dialog.

 Hold durations shown in the timeline.

Keyframe Transitions
As mentioned before, Anime Studio automatically 
calculates what happens in between keyframes. However, 
you do have some control over this. By default, Anime 
Studio will compute a smooth transition from one keyframe 
to the next - most of the time, this is probably what you 
want. However, you can change the transition type by 
right-clicking a keyframe and choosing a new method 
from the popup menu that appears. The transition 
methods are: smooth (the default), ease in/out (also a 
smooth motion, but the object starts off moving kind of 
slowly and slows down again as it approaches the next 
keyframe), linear (motion is straight from one keyframe to 
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the next, leading to a somewhat mechanical look to the 
motion), step (there is no transition at all - the object just 
jumps from one keyframe to the next), noisy (the object 
moves in a slightly wobbly motion), and cycle (the value 
from this keyframe to the next will be taken from some 
earlier section of the timeline).

Sequencer
The sequencer provides another view of the timeline. It 
displays each layer as a block of time. Keyframe changes 
are not displayed in the sequencer, but you can create 
keyframe changes in this view.

 The Sequencer

The Sequencer allows you to easily move a layer forward 
or backward in time. Move the clip toward the left to have 
it start sooner, or toward the right to have it start later. 
The green arrow in the time ruler, located at the top of 

the Sequencer timeline, indicates the frame at which the 
currently selected clip will start.

You can also reposition your clips in the 
Channels timeline view. Select the channel 

you want to move, then right-click in the Time Ruler 
to drag the green arrow to the right or left. You’ll 
notice the keyframes and arrow relocate with the 
mouse.

For example, you can reposition a layer from frame 1 to 
frame 38, causing the animation in that layer to start at 
a later time. To move a layer and its sublayers, click the 
topmost layer and move all of them at the same time. To 
move a sublayer, click the desired sublayer to move it on 
its own.

 Select a layer to move it and its sublayers
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 You can also move a sublayer by itself

You can also use the sequencer to show or hide a layer 
at any time during the movie. Advance to the frame 
where you want the layer to become invisible. Open 
the Layer Settings dialog for the layer that you want to 
hide, uncheck the Visible checkbox, and close the Layer 
Settings dialog. The contents in the layer will disappear in 
the project window, and the track in the sequencer will 
appear as though it ends at the point where it was hidden.

 Check or uncheck the Visible setting in the Layer Settings 
dialog to show or hide a layer
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To make the layer reappear later in the timeline, repeat 
the process. Select the layer you want to unhide, open 
the Layer Settings dialog, and check the Visible checkbox. 
After you close the Layer Settings dialog the layer will 
reappear in the sequencer.

 The sequencer shows a break where the layer is hidden

If you import an audio file, it has a fixed duration in the 
sequencer. You can see where the sound effect will 
happen. Say you want a pop to happen when your 

character disappears from the scene. You can place the 
pop in the right place.

It works the same way if you import a video layer. For 
example, if you want an explosion to happen just before 
the pop, you can import a video layer and place it just 
before the sound effect.

 You can precisely place audio and video files in Sequencer 
view
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Chapter 17: Other 
Windows

Audio Recording
Anime Studio allows you to record audio tracks within the 
application. Select Window > Audio Recording to open the 
Audio Recording palette. You will see the following controls 
and settings:

• Record Button: Press the Record button to start a 
recording. After you have recorded the content you 
want to record (speech, sound effects, etc.), press the 
same button to stop the recording.

You can start a recording at any selected 
frame in the timeline. Simply select the frame 

at which you want the recording to begin, and start 
your recording at that frame.

• Play Button: After the recording is complete, press the 
Play button to hear the recording.

• Sync with Timeline Playback: If this box is checked, the 
timeline will play back while you record the audio (and 

when you play back the audio). This lets you record in 
sync with the visuals if you choose to do so.

• Microphone Drop-Down List: Selects the microphone 
that you want to use for audio recording.

• Pitch Shifting: Use the Pitch Shifting slider to raise or 
lower the pitch of the recording. Move the slider 
toward the left to lower the pitch, or toward the 
right to raise the pitch. The Reset button returns the 
recording to its original pitch.

• Add to Project: Once you are satisfied with the 
recording, click this button to save the recording as 
a WAV file. The WAV file also appears in the Layers 
window as a new audio layer, and in the timeline of 
your current project.
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 Audio Recording Window
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Anime Studio 
Menus
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Chapter 18: File Menu

 File Menu

New
Creates a new, empty Anime Studio project using the 
default project settings (NTSC D1, 720 x 534 pixels). Use the 
Project Settings command (“Project Settings...” on page 
233) to change your project settings if desired.

Multiple Document Support
Anime Studio 10 allows you to have multiple documents 
open at the same time. When you create a new 
document, it will open in a new tab and keep existing 
documents open in their own tabs.

You can use the View > Show Document Tabs command 
or the keyboard shortcut Command/CTRL+Shift+J to show 
and hide the document tabs in the interface. If the tabs 
are hidden, you can select documents in the following 
ways:

• Open documents will appear in a list at the bottom of 
the View menu. Select one of the documents in the list 
to bring it to the foreground.

• To switch to the next document press Ctrl+Tab 
(Windows) or Alt+Tab (Mac).
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• To switch to the previous document press Ctrl+Shift+Tab 
(Windows) or Alt+Shift+Tab (Mac).

Autosave files are generated for all open documents. If the 
application doesn’t shut down properly for some reason, 
a dialog will give you the opportunity to reopen them the 
next time you launch Anime Studio. Viewport settings and 
tool selections will also be restored.

Open...
Prompts you to open a Anime Studio project file that was 
previously saved to disk. The Open dialog allows you to 
select multiple documents. You can also drag one or more 
documents from Windows Explorer or Finder to open them 
in Anime Studio. Each document will open in its own tab. 
See “Multiple Document Support” on page 230 for more 
information.

Open Recent
Displays a list of recent files that you can reopen. Files 
that have been moved or deleted since saving them will 
automatically be removed from the list.

To clear the list of recent files, choose File > Open Recent, 
and click the Clear Menu command at the bottom of the 
list.

Close
Closes the current project. You can also close a document 
by clicking the X that appears in the left side of the 
document tab when you hover over the tab.

 Click the X in the tab to close the current document.

Save
Saves the current project to disk.
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Your Anime Studio project is automatically 
saved every 30 seconds while you work, to a 

temporary location on your hard drive. If the 
application crashes, you will be asked if you want to 
reopen the previous project the next time you start 
Anime Studio.

Anime Studio documents are now saved with 
a preview thumbnail. By default the it 

generates a thumbnail that is 128 x 128 pixels. You 
can set thumbnail preferences in the Preferences 
dialog. See “Options Tab” on page 252 for more 
information about thumbnail options.

Save As...
Prompts you for a name and location, then saves the 
project to disk.

Revert
Revert the current document to its last saved state.

Gather Media
When you import something into an Anime Studio project, 
such as an image, movie, or audio file, the original 
locations of the imported objects are only referenced 
within the Anime Studio project. In other words, they are 
not actually part of the project file itself, rather the project 
file links to the files on your disk(s).

If your project contains many external files, we recommend 
that you place them in a common folder. When you do 
that, you have a self-contained folder that you can copy, 
archive, or move the project and the project will still work.

If you haven’t kept your files in a single folder, the File > 
Gather Media command allows you to create a single 
location for all related project files. This is very useful 
if you need to send your project to someone else for 
collaboration or for technical support.
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 Gather Media command

After choosing the command, you are prompted to select 
or create a folder in which to store the project-related files. 
You then enter a name for the gathered project and click 
Save to save it to the selected folder. When you look in 
the folder, you will see the Anime Studio project file, along 
with Audio, Images, and/or Movies folders that store the 
collected media associated with it.

 A Gathered Media folder

Project Settings...
Brings up the project settings dialog. As seen below, the 
project settings dialog lets you control the pixel width and 
height of the project, as well as the number of frames per 
second. You’re free to change these values at any time, 
although it’s easiest if you set up the values you want 
before you start creating your animation (particularly the 
frame rate). Also in this dialog, you can set the start and 
end frames of your animation, defining how long the 
overall animation will be.
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 The Project Settings dialog

Dimensions

• Dimensions menu: Allows you to set Custom 
dimensions, or choose from a wide variety of presets. 
Presets include the following:

 � Custom: Allows you to enter or edit your own 
settings.

 � NTSC D1: 720 x 534 pixels, 24 frames per second

 � PAL D1/DV: 788 x 576 pixels, 24 frames per second

 � 480p Widescreen: 852 x 480, 24 frames per second

 � VGA: 640 x 480 pixels, 24 frames per second

 � Web: 320 x 240 pixels, 24 frames per second

 � Web Widescreen: 426 x 240 pixels, 24 frames per 
second

 � YouTube: 480 x 320 pixels, 24 frames per second

 � iPhone: 480 x 320 pixels, 24 frames per second

 � Android: 480 x 360 pixels, 24 frames per second

• Constrain Proportions: This option allows you to 
maintain the aspect ratio of your animation project. 
When the option is checked, you can enter a 
new width or height, and the other dimension will 
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automatically change to maintain the same width-to-
height aspect ratio. If you choose one of the preset 
configurations from the Dimensions drop-down list, it 
will ignore the Constrain Proportions option and resize 
your project to the dimensions specified in the selected 
preset.

• When you select a preset, the following settings 
appear below.

 � Width: The width, in pixels

 � Height: The height, in pixels

 � Frame Rate: The number of frames per second in 
the animation.

 � Start Frame: The starting frame of the animation.

 � End Frame: The ending frame of the animation.

Background Color

• Background Color: Sets a background color for the 
project - just click on the color swatch.

Other Settings
• Sort Layers by Depth: The “Sort layers by depth” 

checkbox allows top-level layers in Anime Studio to 

move in front of and behind each other during an 
animation. Normally, layers are drawn in the order they 
appear in the Layers window. However, with this option 
turned on, layers are displayed according to how far 
they are from the camera. See “Tutorial 5.5: Sorting 
Layers by Depth” on page 207 in your Anime Studio 
Tutorial Manual for an example of using this feature.

• Sort by True Distance: Typically, layers are sorted by 
their depth from the camera, but if you’re trying to 
create a 3D object using multiple Anime Studio layers 
(like a cube or pyramid), you may want to turn on “Sort 
by true distance”. This tells Anime Studio to sort layers 
by the distance from the camera to the layers’ origins, 
rather than by depth. Usually this option will be left 
unchecked.

• Extra SWF Frame: Check this option to add an extra 
frame at the end of the video

• Save as Defaults: When you create a new project in 
Anime Studio, your animation defaults to 320x240 pixels 
at 24 frames per second. If you create most of your 
projects at different settings, you can change these 
defaults. Just type in new values in this dialog, and 
click “Save As Defaults” to make the new settings the 
default settings for all new projects.
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• Restore Defaults: Resets the project to the default 
values.

Import
Anime Studio can import several kinds of other media files 
into an animation project. The commands in this sub-menu 
let you import these files.

• Anime Studio Object: This command will ask you to 
choose a Anime Studio project file. Once you’ve 
chosen a file, a list of layers in the project will show up 
in the dialog

 The Insert Object dialog

Checkboxes appear to the left of each of the items 
in the scene you want to import. Check one or more 
of the layers to add it to your own project (a preview 
of the selected layer appears on the right side of the 
dialog. The Uncheck All or Check All buttons can be 
used to deselect or select all of the items in the project. 
Press OK to copy the selected layers into your open 
project, including any animation in the layer. This is an 
easy way to share objects between project files and 
reuse bits of animation here and there.

Several files are included with Anime Studio that 
contain scenery, characters, props, etc. You are 
welcome to include these in your own projects by using 
this menu command.

• Image Imports an image file as a new Image layer. The 
most common type of file to import into Anime Studio is 
images. It doesn’t matter how the images are created, 
so feel free to use pictures from digital cameras, 
backgrounds from scanned drawings or painted on 
the computer, textures, computer-generated 3D 
scenery, etc. The image formats supported by Anime 
Studio are: JPEG, BMP, Targa, GIF, and PNG. Generally, 
we recommend PNG, since the PNG format provides 
for variable levels of transparency, allowing you to 
create non-rectangular images that can blend in 
smoothly with other elements in the scene.
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• Movie: Imports a movie file as a new Image layer. 
Anime Studio supports importing QuickTime (Windows 
and Mac OS) and AVI (Windows only) movie files. A 
movie that you import into Anime Studio will play back 
along with the Anime Studio animation, allowing you 
to combine 2D and 3D elements, or to composite an 
Anime Studio animation on top of a pre-recorded 
video sequence. On Windows, if you have problems 
importing QuickTime movies, then you probably need 
to download and install QuickTime (http://www.apple.
com/quicktime/). Anime Studio will also import native 
Moho files (files ending with .moho).

• Audio File: Loads a sound file to be used as a 
soundtrack for the current animation. The audio 
formats supported by Anime Studio are listed in 
“Appendix A: Product Comparison” on page 
285. This command is the same thing as “Select 
Soundtrack” in the Animation menu. Anime Studio has 
limited support for audio, but you can import a single 
sound file as a soundtrack for your animation. Anime 
Studio uses libsndfile to handle sound files (see http://
www.mega-nerd.com/libsndfile/), so any format that 
libsndfile supports is fair game. Generally, it’s best to 
stick with uncompressed WAV or AIFF files.

The lower section of the File > Import menu displays 
several different categories that allow you to open 

content that is furnished with Anime Studio. You will 
also find these items in the Library (see “Chapter 
14: The Library Window” on page 182). In the 
Import menu this content is arranged in the following 
categories: Audio, Characters, Effects, Images, Props, 
Scenes, and Video.

Import Notes and Tips

Referenced Files
Please note that Anime Studio references the directory 
location of images, OBJ’s, sound files and movies files that 
have been imported for use. When exporting into movie 
format, Anime Studio continues to reference this directory 
location. Moving referenced items from one location 
to another will prevent the item from being displayed 
or heard. We recommend that all items used in your 
animations or artwork accompany it’s native file format 
(ANME) and final exported format.

Startup Folder
Adding your own .anme file to the “Startup Folder” 
(located in the root directory of your Anime Studio 
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installation) will always make Anime Studio open this .anme 
document first when it’s initially launched. Please make 
sure to rename your .anme file to “StartupFile.anme”.

Moho Files
Anime Studio will also import native Moho files (files ending 
with .moho).

Library Content
Please read Section 6 of the EULA (End User License 
Agreement) for rules on using the content that has been 
supplied with your version of Anime Studio. Please note that 
when importing existing content/movies from the Anime 
Studio Content Library using the File > Import option, some 
animations/movies exceed the default “End Frame”. This 
will prevent you from seeing the full movie. To adjust the 
default “End Frame” settings, please select File > Project 
Settings and change the field beside “End Frame”. You 
can also double click the movie/content file you would 
like to view from within the Content Library. To access the 
Library, select Help > Open Content Library.

The Library content files (characters, props, 
etc.) are installed in a shared documents 

location on both Windows and Macintosh. This 
allows multiple users on the same computer to share 
library resources, and to install additional content 
that they might download (from Content Paradise, 
for example). On Windows systems in particular, it 
can be difficult to add new files to the Program Files 
directory when running newer versions of the 
Windows operating system, which is why the shared 
documents location is used.

Photoshop Tips

Exporting from Photoshop
Anime Studio is equipped with a Photoshop export script 
that will give you the ability to take your PSD files and 
export them into .ANME format. The .ANME format is the 
native Anime Studio format. This process helps users from 
having to re-draw or export individual layers as images into 
Anime Studio.

The PSD to ANME script is named Export Layers To Anime 
Studio.jsx. To access this script, please make sure you’ve 
configured a content location as described in “Creating 
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a Content Folder” on page 7. The script will be copied 
into that folder.

To use the script within Adobe Photoshop, copy the Export 
Layers To Anime Studio.jsx file to your .../Photoshop/
Presets/Scripts folder. You should then be able to open up 
a Photoshop document, run this script from File > Scripts > 
Export Layers to Anime Studio, and it will generate a new 
Anime Studio file complete with an image layer for each 
original Photoshop layer. Basically, the script converts PSD 
formatted files to .ANME files. It exports every layer that 
was created originally in Adobe Photoshop and makes it 
completely readable when imported into Anime Studio. 
All versions of Adobe Photoshop since version 7 should 
support this script.

The script exports the following 2 things: Firstly, it converts 
the PSD file into a .ANME file. Secondly, all the individual 
layers of the PSD file are converted into individual PNG 
files and are placed in a folder of the same name as 
the .ANME file. The folder with the PNG’s and the newly 
converted .ANME file will be located side by side. It is 
important to note that whenever you open the .ANME 
file, it will reference the PNG folder. So please keep them 
side by side. If the PNG folder and the newly converted 
.ANME are not located in the same folder, the layers within 
your newly opened .ANME will not work properly in Anime 
Studio.

Refresh Media
The File > Refresh Media command (or the keyboard 
shortcut Command/Ctrl+M) causes Anime Studio to 
check the modification dates of all of the media that is 
referenced in the project, and will reload the media that 
has changed.

Preview
Generates a preview image of what your project will look 
like. If you’re in the process of animating your project, 
the image will be of the current frame in your animation. 
A preview image does not contain all the fill styles, and 
is of lower quality, but is quicker to generate than a fully 
rendered image.

When the Preview window opens up to display your work, 
you can save the preview as a still image, using the popup 
menu in the Preview window. By default, the file will be 
named with the name of your project, followed by the 
frame number.

The following options are available in the Preview window:
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 Preview window.

• Render Cache: Click to place a preview render in 
your render cache. By default you can store up to 100 
preview images in your render cache, which has to be 
located in a User Content folder. If you did not set up a 
User Content folder during installation, you can choose 
the Help > Set Custom Content Folder to configure one. 
See “Set Custom Content Folder” on page 283 for 
more information.

The Options tab in the General Preferences 
dialog allows you to specify the number of 

images stored in your Render Cache. See “Options 
Tab” on page 252 for more information.

• Save As: Expand the menu to choose the file format 
(JPG, BMP, Targa, or PNG). You can also copy the 
image to a clipboard and paste it into another 
application.

• Zoom: Move the scrollbar left or right to zoom in 
and out of the image. You can also use the mouse 
scrollwheel to zoom in or out.

• Percentage field: Allows you to enter a zoom 
percentage value.

• Restore Defaults: Resets the preview window to the 
default zoom level.

Export Animation...
This command brings up a dialog that lets you export an 
animated sequence and save it to disk. The Anime Studio 
project file is where your work is saved, but to view the 
animation as a movie, to put it on the web, or to work with 
it in other programs, you have to export the animation.
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 The Export Animation dialog.

The options in this dialog are:

• Start Frame: Enter the start frame for your exported 
movie here.

• End Frame: Enter the end frame for your exported 
movie here.

• Entire Animation: Press this button to reset the start and 
end frames to include all frames in the movie

• Output Format: The options in the Export Animation 
dialog are described in “Saving Movies in Windows” 
on page 242 and “Saving Movies in Mac OS X” on 
page 243:

• Apply layer effects: If this box is unchecked, Anime 
Studio will skip layer effects like layer shadows and 
layer transparency.

• Render at half dimensions: Check this box to render 
a smaller version of your movie. This makes rendering 
faster if you just want a quick preview, and is useful for 
making smaller movies for the web.

• Render at half frame rate: Check this box to skip every 
other frame in the animation. This makes rendering 
faster, and results in smaller movie files.

• Extra-smooth images: Renders image layers with a 
higher quality level. Exporting takes longer with this 
option on.
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When exporting a movie, Anime Studio will include an 
alpha channel if the codec you’re using supports it. This 
makes it possible to composite Anime Studio movies with 
other media in a video editing program.

If you’re using QuickTime, set the color depth to 
“Millions of Colors+”. The “+” is QuickTime’s indication 
of an alpha channel. The codecs that support this 
include Animation, None, PNG, TGA, and TIFF.

AVI on Windows doesn’t include any built-in codecs 
that support alpha channels. However, at least one 
such codec does exist, and you can download it for 
free - the Huffyuv codec found at http://neuron2.
net/www.math.berkeley.edu/benrg/huffyuv.html.

Anime Studio can only export to a maximum size 
of 900 pixels x 900 pixels and 3000 frames. (Anime 
Studio Pro does not have this limitation.)

Saving Movies in Windows
The Export Animation dialog also has several options for 
adjusting the output quality of your animation. These 
default to the highest quality rendering, but you may 

sometimes want to lower the quality to increase rendering 
speed or to output animations with smaller file sizes for 
streaming over the internet. 

Supported formats for Windows include the following:

 Movie Export Formats: Windows.

 � Image: Supported image formats are JPEG, BMP, 
Targa, PNG, or PSD.

http://neuron2.net/www.math.berkeley.edu/benrg/huffyuv.html
http://neuron2.net/www.math.berkeley.edu/benrg/huffyuv.html
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 � MP4 Movie (H.264 AAC): (Windows 7 and higher 
only). Saves the movie in mp4 format using an 
H.264 video and AAC audio codec.

 � iPhone Movie: (Windows 7 and higher only). Saves 
the movie as a 480 x 320 file in m4v format.

 � AVI Movie (DV): (Windows XP and higher only). 
Saves the movie as a 720 x 480 file in avi format.

 � AVI Movie (Uncompressed): (Windows XP and 
higher only). Saves the movie in avi format using 
an uncompressed video codec. Expect these 
movies to be large compared to a compressed 
format like DV.

 � AVI Movie: (Windows XP and higher only). Saves 
the movie in avi format. In the next dialog, the 
user will be prompted for the video codec of the 
export.

 � QuickTIme: (Mac and 32-bit version of Anime 
Studio for Windows only, not available in Anime 
Studio 64-bit Windows). Saves the movie in 
QuickTime (mov) format. In the next dialog, you  
will be prompted for the video codec and quality 
of the export.

On Windows, this output format only appears 
in the 32-bit version of the software and 

QuickTime must be installed

 � Flash (SWF): Exports your animation to a Flash SWF 
file, using the dimensions of your project.

Saving Movies in Mac OS X
When saving movies from Anime Studio on the Mac, you 
can select from the following choices in the Output Format 
menu. 

For further information about these formats, 
see your QuickTime documentation.
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 Movie Export Formats: Macintosh.

• Image formats include JPEG, BMP, Targa, PNG and 
PSD:

• Movie formats include the following:

 � Apple M4V: Available in two formats. H.264-AAC 
and JPEG-AAC.

 � MP4: Available in two formats. H.264-AAC and 
JPEG-AAC.

 � QuickTime: Available in seven formats. H.264-AAC, 
H.264-PCM, JPEG-AAC, ProRes 422-AAC, ProRes 
4444-AAC, ProRes 4444-ALAC, and PNG-AAC.

 � iPhone Movie: Available in 480x320

 � QuickTIme: Saves the movie in QuickTime (mov) 
format. In the next dialog, you  will be prompted 
for the video codec and quality of the export.

When choosing a compression format or 
codec for export, keep in mind that viewers 

must also have the same codec available to view 
the file. We recommend that you select a basic 
compression format/codec that is installed with Mac 
OS X.

 � Flash (SWF): Exports your animation to a Flash SWF 
file, using the dimensions of your project.

Quality choices allow you to choose a range of movie 
qualities between Maximum and Minimum, with the 
default selection being High quality. The higher the quality, 
the larger the file size will be, and the longer it will take for 
others to download.
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After you select your format and quality, choose Save to 
render the QuickTime Movie.

Exporting Flash
Anime Studio can also export Flash files in SWF format. 
Flash is a common vector animation format on the Web. 
When exporting Flash, Anime Studio will also include the 
soundtrack (if any), if the soundtrack is in MP3 format. If you 
plan on exporting Flash files, it is important to read “How to 
Create Efficient Flash Files” on page 246.

If you plan to export your animations to Flash 
(SWF) format, you will need to use MP3 audio 

files instead of WAV audio files. In addition, if you 
plan to render to SWF format, you can only use a 
single audio file in the project.

Flash Tips

Advice for working with Anime Studio and Flash

Among the other export formats that Anime Studio offers, 
you also have the option to output Flash SWF files. SWF is a 
format created by Adobe as a way to deliver animated 
vector artwork and interactive applications. Flash 
animations are very common on the web, and most users 
already have the Flash player installed on their computers. 

Because Anime Studio is also vector-based, there are 
enough similarities to make it possible for Anime Studio to 
export SWF files.

However, Anime Studio and Flash are not completely 
compatible. Therefore, not all the features of Anime Studio 
can be exported successfully to Flash. In addition, because 
Flash is a web format, small file size is important - there are 
certain issues to keep in mind when working with Anime 
Studio if Flash is your intended output format.

When exporting SWF files, you may want to use 
Macromedia’s Flash authoring tool to combine multiple 
SWF files, add extra elements, sound, etc. Be aware that 
Anime Studio’s SWF files are compatible with Flash MX 
and later - Flash 5 and earlier are not able to load Anime 
Studio-created SWF files.

What Can be Exported

Most common objects in Anime Studio can be exported to 
Flash. These include:

• Vector layers

• Fills/Outlines/Colors

• Transparency

• Gradients
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• Variable-width lines (try to use these sparingly - see 
below)

• Bone warping of vector layers

• Image layers (PNG and JPEG only, and only if they are 
not warped by a bone layer)

• Particle layers (careful - a complex particle effect can 
easily overwhelm Flash)

• A soundtrack can be exported if it’s in MP3 format, and 
at either 44100 Hz, 22050 Hz, or 11025 Hz sample rate. 
If you want your SWF file to contain audio, make sure 
that your project contains only one audio track, and 
that the audio track is in MP3 format. In order for Anime 
Studio to play MP3 format audio files, you must have 
QuickTime installed

What Can’t be Exported

On the other hand, some things in Anime Studio are just not 
compatible with Flash, and cannot be exported to a SWF 
file. The following list covers the most important of these 
objects and effects.

• Brushes

• Fill and line effects (except gradients)

• Layer effects (shadows, shading, layer blur, motion blur, 
etc.)

• Image warping or 3D movements in image layers

• Image layers that use progressive JPEG images (Flash 
can’t handle progressive JPEG images)

• Layer masking

• 3D layers

• Multiple audio tracks, or audio tracks other than MP3 
format

How to Create Efficient Flash Files

When you’re creating an animation with the intent to 
produce an SWF file as output, there are several things 
to keep in mind. An important concern with SWF files is 
keeping the file size down. The key way to do this in Anime 
Studio is to keep as many layers “optimized” as possible. An 
optimized layer when exported to SWF will take up much 
less space than a non-optimized one. (For other formats, 
like QuickTime or AVI, it doesn’t matter.) You can tell which 
layers are optimized by looking for a little red dot next to 
the layer’s icon in the Layers window:
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 Notice the red dot by the optimized layer.

A new layer is optimized to start with, but depending on 
the effects you apply, that optimization can go away. 
The following things will “de-optimize” a layer. Note: a 
non-optimized layer will still export to Flash, it just won’t be 
nearly as efficient.

• 3D camera movements (this will de-optimize all layers 
in the project, so it should be avoided if possible when 
targeting SWF)

• 3D layer rotation (X or Y rotation, or perspective 
rotation)

• Layer shear

• A group layer that has 3D rotation or shear will cause 
all of its sub-layers to be non-optimized

• Uneven scaling in the X and Y directions

• Point animation

• Bone animation is a common cause of non-optimized 
layers. What’s happening is that because Flash doesn’t 
have a bone system like Anime Studio, Anime Studio 
needs to export a lot of extra information for Flash to 
be able to produce the same effect. One way to use 
bone animation and to stay optimized is to attach 
a vector layer to a single bone, instead of letting 
the bones warp all the points in the vector layer. The 
vector layer will then remain optimized. While you 
can’t do this in all cases, sometimes you can break up 
a character into multiple body parts - some parts will 
be warped with the bones, and some will be attached 
to a single bone. At least some parts of the character 
can remain optimized.

Here are some other things to think about when exporting 
to SWF:
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• Consider using a lower frame rate (12 fps, for example) 
for your animation. Fewer frames means a smaller file.

• If some of your layers can do without any animation 
at all, or just layer translation/scaling/rotation 
(background scenery, props, background characters, 
etc.), that can save a lot of space.

• If most of a layer is stationary, except for one small 
object, move that object into its own layer if possible. 
Example: a character who is waving his arms, but 
is otherwise still - move the arms into a separate 
layer from the rest of the body. The body will remain 
optimized and take up much less space.

• If an object sits still for a time with no animation, 
consider replacing it with a non-animated object for 
that time period.

What to Avoid

If your goal is to create a SWF animation, there are some 
things you should try to avoid. Besides the effects that 
just are not possible to export, you should try to avoid the 
following effects if possible. These are all things that can be 
exported - it’s just that they make for a less efficient SWF file. 
Of course, you won’t want to avoid all of these things all 
of the time. However, if you plan your animation carefully, 
and use as few of the following effects as possible, the 

resulting SWF file will be smaller, and will load quicker over 
the web.

• 3D camera moves - no Flash optimization is possible 
when you’re moving the camera around in 3D. Simple 
side-to-side pans and zooms are OK, but when you 
start using camera pan/tilt, Flash efficiency goes down 
the drain.

• Try to use as few control points as possible in your 
vector artwork.

• The freehand tool and the insert text dialog can 
generate a lot of points, resulting in a big SWF file.

• Limit the use of variable-width lines. It’s easy to 
overwhelm Flash with the complexity of variable-
width lines, making the resulting SWF file play back 
unpredictably. Read “Flash Movie Size Limit” at http://
kb2.adobe.com/cps/144/tn_14437.html for more 
information. If possible, only use variable-width lines in 
SWF-optimized layers.

• Avoid compound shapes (two adjacent circles filled as 
one, shapes with holes, or figure 8’s).
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Exporting Still Images
Finally, you can export an animation as a sequence of 
numbered still images. This option is not used very often, 
but sometimes for certain post-processing tasks, you may 
prefer to work with a sequence of separate still image files. 
You can choose between JPEG, BMP, PSD, Targa, or PNG.

Upload to YouTube
The File > Upload to YouTube command allows you to 
upload your Anime Studio animation to YouTube. After 
choosing the command you are prompted to locate the 
animation that you want to upload. Before performing the 
upload, you will need to enter your YouTube Username 
and Password in the Web Uploads tab of the Preferences 
dialog, as discussed in “Web Uploads:” on page 255.

Upload to Facebook®
The File > Upload to Facebook command allows you 
to upload your Anime Studio animation to your page 
on Facebook. After choosing the command you are 
prompted to locate the animation that you want to 
upload.

Before using this features, you will need to 
sign in to your Facebook account and 

authorize Anime Studio as an application that can 
upload to your Facebook account.

After logging in to your Facebook account and choosing 
the Upload to Facebook command, your browser will 
display a screen that prompts you to allow the Smith Micro 
Software Video Uploader to upload files to your Facebook 
account. Click the Allow button to enable this feature, and 
then the upload will continue. You should only need to 
authorize the uploader the first time you use it

Quit
Quits Anime Studio. Anime Studio will prompt you to save 
any unsaved projects before closing.
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 Edit Menu

Undo
Choose this command to undo the last operation. You 
may undo up to 8 of your most recent editing operations in 
Anime Studio.

You will not receive a warning when you undo an 
operation. You will be able to undo the operation by using 
the Edit > Redo command.

Redo
This command will redo the last operation that you “un-
did” with the Undo command.

Cut, Copy, Paste
These are the traditional clipboard commands. They can 
be used together with the Draw editing tools for vector 
layers, and operate on the currently selected group of 
points.
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Clear
This command is the same as pressing the backspace or 
delete key: the currently selected object in the working 
area will be deleted from the project.

Select All
Selects all the points in the active vector layer.

Select None
De-selects all the points in the active vector layer.

Select Inverse
Selects the opposite points in the active vector layer. 
Selected points will become de-selected, and de-selected 
points will become selected.

Select Connected
Selects all points that are connected to any other currently 
selected points. For example, if you have a complex shape 
like a character’s head, just select a few points on it, then 

choose this command: if all the points on the head are 
somehow connected together, the whole head will now 
be selected.

Preferences...

Mac users will find the Preferences command 
in the Anime Studio menu category.

Brings up a dialog that lets you customize some aspects 
of Anime Studio, such as the display colors used in the 
working area of the Anime Studio window. Some of these 
features including Edit Colors and GUI Colors are only 
available in Anime Studio Pro.
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Options Tab

 Options

• Auto-assist with bone locking keyframes: Adds an 
extra keyframe when bones are locked or unlocked to 
prevent them from “drifting”.

• Scale compensation for new layers: When a layer is 
scaled up (or down), its lines get thicker (or thinner) 
to match. If you don’t want this behavior, turn off this 

option. You can also control this on a per-layer basis in 
the Layer Settings dialog. This option controls it for any 
new layers you create.

• Show paths for new layers: Determines whether the 
paths (previously called construction curves) are 
displayed for new layers. They’re always shown for the 
selected layer, but usually hidden otherwise.

• Auto-name new shapes: Shapes can be named by 
the user. If this is turned on, all bones and shapes get 
names like “1”, “2”, etc.

Anime Studio names bones automatically as 
you create them. For more information, see 

“Add Bone” on page 70.

• Zoom with drag box: When this option is on, allows you 
to draw a box around the area that you want to zoom 
into, rather than using a continuous zoom.

• Consolidate timeline channels: Instead of showing 
separate channels (point animation, bone animation, 
layer translation, layer rotation, etc.), this option groups 
all channels into one in the timeline palette. This is on 
by default in Debut, and off in Pro.
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• Status bar at top of window: Shows the status bar at the 
top of the window, rather than the bottom. The status 
bar is where tools show their descriptions, like what 
modifiers keys do what, etc.

• Inline Layer Naming: Allows you to name the layer in 
the Layers panel when you create a new layer.

• Automatically check for updates: When this option is 
checked, Anime Studio will automatically check for 
updates upon startup. Uncheck this option if you prefer 
to manually check for updates.

• Highlight frame 0: If on, a red box is drawn on the 
canvas if the current time is set to 0. This can be helpful 
to remind you when you’re working on frame 0 (the 
setup frame) vs. some other frame.

• Enable drawing tools only on frame 0: Creation tools 
(Add Point, Freehand, Draw Shape, Add Bone) are 
only available on frame 0 if this option is on. Otherwise, 
they can be used at any time.

In Anime Studio, there are certain tasks that 
can only be performed on Frame 0, many of 

which pertain to rigging. Beginning with Anime 
Studio 10, when you move to Frame 0 in your 
project, each layer will go to its own “Frame 0,”  
regardless of where it starts in the project timeline. If 
a layer starts before Frame 0, you will now be able 
to make edits to that layer without moving it back 
into the project timeline.

• Use SMPTE timecode: Shows time in the timeline using 
SMPTE timecode instead of frame numbers. SMPTE 
timecode looks like this: 00:02:34:07 That would be 0 
hours, 2 minutes, 34 seconds, and 7 frames.

• Show angles in degrees in timeline: Angle values 
(like layer rotation or bone rotation) are shown in 
radians in the timeline’s Motion Graph. This is because 
angle values in radians are smaller numerically and 
fit in better with other values in the graph. But if the 
user chooses to, they can display these curves using 
degrees with this option.

• Disable custom tool cursors: A long time ago there was 
a bug on some Windows systems where tool cursors 
didn’t display correctly. Turning on this option will 
just use the standard system arrow cursor, regardless 
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of what tool is active on the canvas. It may not be 
needed anymore (I’m not sure if that bug happens for 
anyone these days).

• Disable audio feedback: When welding points, you 
hear a “clicking” sound in Anime Studio. Turning this 
option on will disable the click.

• Legacy curves for new layers: When checked, uses the 
old style curves, rather than the smoother curves found 
in Anime Studio 8 and later.

• Nearest neighbor sampling for new image layers: 
When an image is scaled up larger than its original 
size, Anime Studio will try to smooth out the areas in 
between pixels to create a smoother image. Turn this 
option off if you want the enlarged image to appear 
blocky.

• Auto save for crash recovery: When turned on, Anime 
Studio will automatically save your work every thirty 
seconds to a temporary file. If the application crashes, 
you can recover your work the next time you start the 
application. In the event that you are working on very 
large files and your workflow is slowed down by saving 
every thirty seconds, you can turn this option off to 
improve performance.

• Auto Center New Layers: If the camera is in its default 
position (such as it would be in a new document) this 
option won’t do anything.  The option will become 
noticeable if you have moved the camera (for 
example, if you are looking 90 degrees to the left). If 
this option is unchecked in such a case, new layers 
will be centered at 0,0,0 and will be off-camera. If 
this option is checked in such a case, the new layers 
will appear centered in front of the current camera 
position.

• Confirm before reverting document: When checked, 
Anime Studio will ask for verification before a 
document is reverted to the last saved version.

• Default Startup File: Allows you to start Anime Studio 
with a default startup file, an empty document, or a 
specified project file.

• Document Preview Thumbnail Size: Anime Studio can 
automatically generate thumbnails when you save 
your documents. The default maximum size for the 
thumbnails is 128x128 pixels. Other options are None 
(will not automatically generate a thumbnail), 256x256, 
512x512, and 1024x1024.

• Max Render Cache Size: Enter the number of renders 
that you want to store your Anime Studio render 
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cache. The default setting is 100 images. In order to 
store these images, you must create a user content 
folder. If you did not do this during setup, see “Set 
Custom Content Folder” on page 283.

• Language: Select the desired language for the Anime 
Studio interface. Choices are English, German, Spanish, 
and Chinese.

Web Uploads:
This tab is used to enter your YouTube user account name 
and passwords. Anime Studio will log into this account to 
post YouTube videos when you select the File > Upload 
to YouTube command to send a project file to another 
person.

Enter the following information:

• Username: Enter your YouTube user name.

• Password: Enter your YouTube password.

• Private uploads: Check this option if you want your 
Anime Studio uploads to be private uploads rather 
than public uploads.

 Web Uploads

Editor Colors:
Allows you to change the color scheme for the editor 
window, including various options for background and 
object colors. Press the Reset button to return to default 
application colors. The Default Stroke Width option allows 
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you to specify the default Stroke Width setting that appears 
in the Style window.

 Editor Colors

 Editor Colors

GUI Colors:
Allows you to change the color scheme for the application, 
including various options for background, text, and widget 
colors. A preview of your changes appears in the Sample 
Widget area as changes are made.

• Click the Color Theme button at the top of the GUI 
Colors tab to choose from one of several different 
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color schemes. You can then modify the color scheme 
further if desired.

• Press the Reset button to set the color scheme back to 
the default settings.

• Check the Use Large Fonts option to increase the size 
of the fonts used in the application.

 GUI Colors
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 Draw Menu

Insert Text...
Choose Draw > Insert Text or use the keyboard shortcut 
Command/Ctrl+T to open the Insert Text dialog, which is 
described in “Inserting Text and Word Balloons” on page 
95.

Peak
This command creates a peaked (or hard) transition 
between the curves at the point that you click.

Smooth
This command smooths the transitions between the curves 
at the point that you click.

Raise Shape
Select this menu item to raise a shape in the stacking 
order. This will move it in front of the next higher shape. The 
stacking order only applies to shapes within the same layer 
- all shapes in a layer will appear above any lower layers 
and behind any upper ones, regardless of stacking order. 
Note that if there is no shape overlapping the selected 
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one, you may not see any change when this item is 
selected, even though the shape gets moved higher.

Lower Shape
Select this menu item to lower a shape in the stacking 
order.

Raise to Front
Works like Raise Shape, but raises the shape above all 
others in its layer.

Lower to Back
Works like Lower Shape, but lowers the shape below all 
others in its layer.

Trace Image
Anime Studio has always allowed you to import black 
and white or color bitmap images and work with them. 
However, they are not as flexible as vector objects for 
several reasons. You can’t zoom in an infinite amount, you 
can’t bend them quite as much, and you can’t edit them. 

Anime Studio includes Automatic Image Tracing, which 
allows you to convert a bitmap image to a black and 
white vector object.

For this feature to work its best, you should choose 
drawings that have bold lines, such as those created with 
a felt pen. Pencil sketches will be more difficult to trace.

After you import your drawing into an Image layer, you 
can use the Draw > Trace Image command to display the 
Trace Image dialog. The Trace Image dialog contains the 
following settings.

 Trace Image dialog.
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• Threshold: Adjusting the Threshold value can help 
remove gray areas from the conversion. Move the 
slider toward the left to decrease the threshold value 
(accept less gray), or toward the right to increase the 
threshold (accept more gray). If your image contains 
compression artifacts or subtle color gradients you can 
decrease the threshold value to make the conversion 
cleaner.

 Low threshold (left); high threshold (right).

• Detail reduction: The Detail Reduction is set, by default, 
to accept the most amount of detail possible (the slider 
is fully toward the left). Move the slider toward the left 

to increase the amount of detail in the conversion. This 
creates more points in the vector layer, but appears 
more true to the original. Move the slider toward the 
right to decrease the amount of detail. This creates 
fewer points in the vector layer, but appears less like 
the original image.

 Maximum detail (left); reduced detail (right).

• Fatten Lines: This option controls the width of the lines in 
the black and white drawing. Move the slider toward 
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the left to decrease the width, and toward the right to 
increase the width.

 Default lines (left); thickened lines (right)

After you click OK, Anime Studio traces the image and 
adds a new vector layer to the Layers palette. The image 
layer that contains the original bitmap image is turned off.

 A close-up of the traced result

Hide Selected Points
Sometimes when projects are complex and you have a lot 
of points and bones, you only want to work on one object 
or reshape it. When scenes are complex you sometimes 
select points in the group.
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Select the object you want to work on, then choose Edit 
> Select Inverse to select all the points you want to hide. 
Then choose Draw > Hide Points to hide the selected 
points. The shapes are still there, but the points are hidden 
and you can’t accidentally select them.

Show All Points
Choose Draw > Show All Points to unhide the points that 
were previously hidden with the Hide Selected Points 
command.

Hide Shape
Hides the currently selected shape

Show All Shapes
Shows all shapes that have previously been hidden.

Freeze Points
After selecting points, choose this command to freeze all 
points so that they cannot be edited.

Freeze Selected Points
Adds a keyframe at the current time for all selected points.

Reset Points
Moves the selected points back to their original positions, 
adding a new keyframe for them at the current time.

Reset All Points
Same as above, but moves all points in the layer back to 
their original positions, not just the selected ones.
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 Bone Menu
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Release Points
This command detaches the selected points from any 
bones they may be bound to.

Flexi-Bind Points
This command binds the selected points to bones in such a 
way that they will influenced by all the bones in the parent 
bone layer, depending on the strength and region of 
influence of each bone. This results in more of a “squishy” 
type of motion when the skeleton is animated. This is the 
default behavior for all drawings in Anime Studio, so you 
usually won’t have to use this menu command - the points 
are probably already flexi-bound.

Release Layer
This command detaches the current layer from any bone it 
may be bound to.

Flexi-Bind Layer
This command binds the current layer to the bones in 
the parent layer in such a way that the child layer will 

influenced by all the bones in the parent bone layer, 
depending on the strength and region of influence of each 
bone. This results in more of a “squishy” type of motion 
when the skeleton is animated.

Release Layer And Points
Detaches selected points and layer from any bones that 
they are bound to.

Use Selected Bones for Flexi-
Binding
Assigns the selected bones to the currently-selected layer 
in the Layers palette. For more information, see “Tutorial 3.5: 
Flexi-Binding” on page 120 in your Anime Studio Tutorial 
Manual.

Use All Bones for Flexi-Binding
Reassigns the selected layer in the Layers palette so that it 
is controlled by all bones in the bone group, rather than by 
selected bones that were previously assigned with the Use 
Selected Bones for Flexi-Binding command.
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Hide Selected Bones
Select the bone or bones that you want to hide, and 
choose Bone > Hide Selected Bones. The bones and their 
associated keyframes will be hidden.

Hide Controlled Bones
Hides any bones that are set up to have their angle or 
position controlled by another bone. These types of bones 
are often not animated by the user (their animation is 
“automatic” through the control feature), and hiding them 
can clear up some of the clutter in the workspace. This 
function is not available when the time is set to frame 0.

Show All Bones
Use the Bone > Show All Bones command to redisplay 
bones that have previously been hidden with the Hide 
Selected Bones command.

Track Bone to Video
Allows you to link a bone to the tracking points that you 
defined with the Video Tracking tool. For a description of 
how to use this tool, see “Video Tracking” on page 105.

Freeze Pose
Keyframing can be tricky sometimes for new users of 
Anime Studio, or for those who are new to animation. For 
example, let’s say you move a left foot up on frame 12, 
and then down again at frame 24. At frame 36, you want 
the right foot to move up, and then down again at frame 
48.

The problem is, the right foot will start to move up at frame 
0, and then be fully up at frame 36. In reality, you want the 
right foot to move up from frame 24 through 36, and not 
from frame 0 through 36.

To accomplish this, you choose the Bone > Freeze Pose 
command at Frame 24. This sets a keyframe for every 
part in your animated character or object so that you are 
assured that the pose you want to use is correct for that 
portion of your animation. Then you set the keyframe that 
moves the right foot up at frame 36, and down again at 
frame 48.



Anime Studio Debut 10
Users Manual

266

Chapter 21: Bone Menu

 Freezing a pose

Reset Bone
Moves the selected bone back to its original position, 
adding a new keyframe for it at the current time.

Reset All Bones
Same as above, but moves all bones in the layer back to 
their original positions, not just the selected one.
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 Animation Menu

Allow Frame Skipping
Normally when playing back an animation, Anime Studio 
will display each frame one at a time. Depending on the 
complexity of your animation, the display quality settings, 
and the speed of your computer, the animation may play 
back slower than its specified speed. Select this command 
to force the animation to play back at actual speed. 
In order to accomplish this, Anime Studio may have to 
skip some frames to keep up to speed, so the animation 
will play back at the correct overall speed, but may not 
appear as smooth. The best way to see the animation 
at final speed and quality is of course to use the Export 
Animation command in the File menu.

Reset All Layer Channels
Resets all channels in the current layer to their initial values, 
adding a new keyframe at the current time.

Set Layer Start Time
Offsets the start of an animation within a layer to the 
current selected frame.
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Align Layer with Camera
Allows you to rotate the selected layer to face the camera.

Select All Keyframes

Selects all the keyframes in the current layer. This is useful if 
you want to move all the animation in a layer forward or 
backward.

Rescale Keyframes...
With this command you can rescale a group of keyframes 
so that a portion of your animation takes more or less time.

 The Rescale Keyframes dialog.

Options included in this dialog are:

• Rescale entire document: Check this option to rescale 
all frames in the document.
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• Start Frame: Enter the existing frame number at which 
to start scaling.

• End Frame: Enter the existing frame number at which to 
end the scaling.

• New Start Frame: Enter the new target frame number 
for the start of the scaling.

• New End Frame: Enter the new target frame for the 
end of the scaling.

• Rescale the following channels: Check or uncheck the 
channels that you want to include or exclude from the 
scaling operation. The icons representing the various 
animation channels are described in the Timeline 
Window section.

Examples:

• To reduce the amount of time the animation takes (in 
other words, to speed it up), you could set the start 
frame (and new start frame) to 30, the end frame to 
60, and the new end frame to 45. (45 - 30 = 15, which is 
half as long as 60 - 30 = 30)

• You can shift a section of your animation by changing 
the start time. For example, to shift the range of 
keyframes between 30 and 60, you could set the start 

frame to 30, the end frame to 60, the new start frame 
to 90, and the new end frame to 120. The duration will 
be the same (120 - 90 = 60 - 30), but the animation will 
take place between frames 90 and 120, instead of 30 
and You can rescale a portion of the entire document 
by clicking the “Rescale entire document” checkbox.

• To rescale the current layer, select the animation 
channels that you want to be affected. For example, 
you may want to rescale the bone animation, but 
leave the layer rotation alone.

Copy Current Frame...
With this command you can copy values from the current 
frame in the timeline to any other frame in your animation. 
For example, if you position some objects in a way that 
you really like at frame 243, you can use this command to 
copy that position back to frame 0, to make it the starting 
position as well.
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 The Copy Current Frame dialog.

Add Keyframe
This command adds a keyframe for all channels in your 
project, at the currently selected frame.

Clear Animation
Several commands allow you to clear keyframes from a 
single layer, or from all the layers in your project. Use the 
Animation > Clear Animation commands as follows:

• From Layer: Clears all animation keyframes from the 
current layer. A warning appears to notify you that 
animation will also be deleted from sublayers and 
asks if you want to continue. Choose Yes to clear the 
sublayers, No to keep keyframes in the sublayers, or 
Cancel to exit the dialog without making changes.

• From Layer After Current Frame: Clears keyframes from 
the currently selected layer, beginning with the frame 
after the currently selected frame and including all 
keyframes to the end.

• From Layer Before Current Frame: Clears keyframes 
from the currently selected layer, beginning with 
the frame before the currently selected frame and 
including all keyframes to the beginning.
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• From Layer At Current Frame: Clears the keyframes on 
the currently selected layer, only at the current frame.

• From Document: Clears all animation keyframes from 
the entire document.

• From Document After Current Frame: Clears keyframes 
from the entire document, beginning with the frame 
after the currently selected frame and including all 
keyframes to the end.

• From Document Before Current Frame: Clears 
keyframes from the entire document, beginning with 
the frame before the currently selected frame and 
including all keyframes to the beginning.

• From Document At Current Frame: Clears the 
keyframes in the entire document, only at the current 
frame.

Track Layer to Video
This command allows you to link a layer to tracking points 
that have been set up with the video tracking tool. For 
a complete description of the process, refer to “Video 
Tracking” on page 105.

Mute Audio
Mutes the soundtrack when playing back your project 
in Anime Studio, but the soundtrack is still a part of the 
project. Just un-mute it to hear it again.

Restart Audio Track
Starts the audio track in the selected track over again from 
the beginning. This allows you to add repeats in the audio 
track.

Audio Level
Opens a dialog that allows you to enter a numerical value 
for the audio level.

Restart Movie
Starts the video in the selected track over again from the 
beginning, allowing you to add repeats in the video track.
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Menu

 View Menu

Reset
Resets the view of the working area to the starting pan and 
zoom values. Use this command when you want to jump 
back to the original view of the project.

Zoom In
Use the View > Zoom In command, or the keyboard 
shortcut Command/Ctrl+= (equal sign) to zoom in closer to 
the elements in your scene.

Zoom Out
Use the View > Zoom Out command, or the keyboard 
shortcut Command/Ctrl+- (minus sign) to zoom out farther 
from the elements in your scene.

Show Output Only
In OpenGL mode, this option will use a semi-transparent fill 
so that you can see what is behind it.

Show Output Only
This command will hide all artwork that lies outside the final 
output rectangle. This makes it easy to visualize the final 
staging for your shot. Of course, it’s hard to edit what you 
can’t see, so be sure to turn this option off when you need 
to edit an object that lies outside the visible area of the 
project.
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Show Document Tabs
Open documents appear as tabs in the main window. 
You can show or hide the document tabs with the View > 
Show Document Tabs command, or by using the shortcut 
Command/Ctrl+Shift+J.

Open documents also appear as a list at the bottom of the 
View menu. Select a document in the list at it will appear in 
the view port area.

The following shortcuts allow you to cycle through open 
documents:

• To switch to the next open document, press Ctrl+Tab 
(Windows) or Alt+Tab (Mac). 

• To switch to the previous open document, press 
Ctrl+Shift+Tab (Windows) or Alt+Shift+Tab (Mac).
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Menu

 Window Menu

Tools
Shows/hides the Tools window. The Tools window is shown 
by default when you start Anime Studio. Tools are discussed 
in the section beginning with “Anime Studio Tools” on 
page 24.

Layers
Shows/hides the Layers window. The Layers window 
is shown by default when you start Anime Studio. See 
“Chapter 11: Layers Window” on page 125.

Timeline
Shows/hides the Timeline window. The Timeline window 
is shown by default when you start Anime Studio. See 
“Chapter 16: The Timeline Window” on page 213.

Style
Shows/hides the Style window. The Style window is shown 
by default when you start Anime Studio. See “Chapter 13: 
Style Window” on page 163.

Library
Displays the Library window, which is discussed in “Chapter 
14: The Library Window” on page 182.
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Audio Recording
Displays the Audio Recording window, which is discussed in 
“Audio Recording” on page 227.

Blend Morphs
You can use the Window > Blend Morphs command 
to blend poses (or morph targets) together to create a 
combination pose or morph. This feature in Anime Studio is 
very easy to use.

Anime Studio Debut does not allow you to 
create actions for blending, however you will 

be able to blend poses contained in content that is 
created by others. When you first create a 
character, you’ll notice that the Window > Blend 
Morphs command may not be available. This is 
because you need to use a character that has 
morph targets that you can use for blending.

To blend your morphs, begin by moving to the frame at 
which you want the new morph to appear.

Next, choose the Window > Blend Morphs command. The 
Blend Morphs dialog appears. The sliders in this dialog are 
named the same as the morphs you created in the Actions 

window. Adjust the sliders until you get a combination of 
the morphs that you want to keep. Then click OK to set the 
new combination.

The Default slider is associated with the 
default state of the object at Frame 0. To 

blend the other morphs with this default state, check 
the Relative Blend option.
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 Use the Blend Morphs dialog to combine your morphs together 
in any combination of values.

You can then advance to other frames in your timeline, 
and use the Blend Morphs command to create new 
combinations throughout the timeline. As you scrub 
through the timeline, you should then see morphs blend 
from one to the other.

You can select which animation channels to copy to a 
new frame, or you can copy everything in the document 
by selecting the “Copy entire document” checkbox. 
There doesn’t need to be a keyframe at the current 
frame in order to copy the current value. This command 
will copy the current value, whether it is a keyframe or an 
interpolated in-between value.

An important note about bones: if you 
position a skeleton system during your 

animation, and try to copy that pose back to frame 
0, the bones themselves will take on that pose at 
frame 0, but anything bound to the bones (points in 
vector layers, warped images, other sub-layers) will 
not take on that pose. This is because frame 0 is a 
setup frame - bones are set up at frame 0, but they 
have no influence over other objects at frame 0. If 
you’re trying to copy a pose back to frame 0 in 
order to set up an initial pose, consider copying it 
back to frame 1 instead - frame 1 is actually the 
beginning of the animation, and the bones will 
influence other objects starting at frame 1.
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Layer Settings
Opens the Layer Settings dialog, discussed in “Chapter 12: 
Layer Settings” on page 129.
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 Help Menu

Tutorials
Opens the PDF version of the Anime Studio Tutorial Manual, 
which is installed on your hard disk.

Help
Opens this document, the Anime Studio User’s Manual.

Online Tutorials
Opens a web browser with Anime Studio online tutorials. 
Internet connection will be required.

Welcome Screen
Opens the Welcome Screen.

Register Your Product
Register your product to receive information on updates 
and upgrades. Internet connection will be required.
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Community Forums
Opens your web browser to the Lost Marble forum, where 
you can communicate with your peers and ask for help 
on any topic related to Anime Studio and animation. The 
forum is extremely large with over ten thousand registered 
members.

Technical Support
Opens your web browser to the Smith Micro website where 
you can access FAQ’s, see answers to common issues, get 
help from a customer service representative etc.

Download Bonus Content Pack
Navigates to the Bonus Content Pack page on Content 
Paradise. You will need a Content Paradise account and a 
valid Anime Studio serial number to obtain the content.

Online Video Gallery
Opens your browser to a page that displays some of the 
animations that have been created with Anime Studio. This 

is a great place to get inspired and see what others have 
created with Anime Studio.

About Anime Studio Debut
Displays some information about Anime Studio, including 
which version of Anime Studio you’re running.

About Scripts
Displays some information about all the scripts currently 
loaded by Anime Studio. All of Anime Studio tools, and 
all the entries in the Scripts menu are implemented 
in a scripting language called Lua. Although some 
programming/scripting experience is required, Anime 
Studio users are welcome to write their own scripts to 
extend Anime Studio’s built-in features.

Buy Content
Help speed up your animation workflow with ready to 
use content. Buy content from Content Paradise. Internet 
connection will be required.
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Check For Updates
Check to see if there are any updates for Anime Studio. 
Internet connection will be required.

Upgrade to Professional Version
Upgrade from Anime Studio to Anime Studio Professional. 
Internet connection will be required. To see the differences 
in the two products, see “Product Comparison” on page 
359.

Deactivate License
Choose this command to deactivate the license before 
you uninstall Anime Studio, or if you want to activate the 
license on another computer.

Edit Keyboard Shortcuts
The Help > Edit Keyboard Shortcuts command opens the 
Keyboard Shortcuts dialog shown in the following figure.

 The Keyboard Shortcuts Editor.

By default, the shortcuts that are built-in to Anime Studio 
are displayed in their default configuration, in three 
categories: Menus, Tools, and Windows.

You cannot edit the default configuration. In order to 
create your own shortcut configurations, you’ll need to 
create a custom settings file.
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The following options appear in the dialog:

• Current Settings: Displays the name of the shortcut 
configuration that is currently in use.

• New: Allows you to assign a name to a new shortcut 
configuration. Anime Studio will notify you if the 
filename is too long. After you assign a name choose 
OK. Your new custom file will appear in the Current 
Settings list, and you can begin to assign your custom 
shortcuts.

• Delete: Select a custom shortcut configuration from the 
Current Settings list, and then click this button to delete 
it. You cannot delete the Default configuration file.

• Restore Defaults: Restores all keyboard shortcuts to 
the default values assigned with the Anime Studio 
installation.

• Shortcut List: Displays all shortcuts by category: Menu, 
Tools, and Windows. You can use the scrollbar at the 
right side of the shortcut list to scroll further down the list.  
The left side of the list displays a menu command, tool 
name, or window; and the right side of the list displays 
the associated shortcut if one is configured.

• Scroll To: Jumps to a specific shortcut category. The 
categories are named in the order in which they 

appear in the shortcut list. Select the desired category 
to jump to that location.

• Shortcut Suggestions: Click this button to have Anime 
Studio suggest an unused keyboard shortcut.

• Done: Click the Done button when you are finished 
editing your shortcuts.

Adding Shortcuts
To create a custom keyboard shortcut file, follow these 
steps:

If a user content folder is defined, Anime will 
save custom keyboard shortcuts files to a 

Keyboard Shortcuts folder in the user content folder. 
If names conflict with custom files saved to the 
default location, the user location will supercede the 
default location.

1. Choose Help > Keyboard Shortcut Editor to open the 
Keyboard Shortcut window.

2. If a custom configuration file has not yet been 
created, click the New button to assign a name for a 
new configuration file. Otherwise, select the custom 
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configuration that you want to edit from the Current 
Settings dropdown list.

3. Scroll through the keyboard shortcut list until you find 
the menu command, tool, or window item that you 
want to modify. Click inside the shortcut field to edit it.

4. With the shortcut field selected, press the associated 
keys on your keyboard that you want to assign for the 
command.

Customized shortcuts will override default 
shortcuts unless there is a conflict with a 

default. If a conflict with a default shortcut exists, the 
default shortcut will take precedence over the 
custom shortcut.

It is possible to create duplicate shortcuts. The 
editor will warn you when multiple actions 

have the same shortcut when you assign a shortcut 
that is already used by another action. When 
multiple actions use the same shortcut, the first 
enabled action found will be triggered.

 You will receive a warning when the keyboard shortcut that 
you enter is already in use.

5. After you are finished with your keyboard shortcuts, 
click Done to save the configuration file.

If you change your locale, there may be 
localized shortcuts that conflict with your 

custom shortcuts. Your settings will be updated to 
eliminate conflicts.

Switching from 32-bit to 64-bit or vice versa 
could potentially alter the shortcuts available 

and may lead to a conflict between default settings 
and custom settings. Your settings will be updated to 
eliminate conflicts.
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If shortcuts have changed in the application since the last 
time you updated, a dialog will prompt you to update your 
custom shortcut list accordingly, or to use the new defaults.

 Update Shortcuts dialog.

Set Custom Content Folder
Prompts you to create a content folder, as described in 
“Creating a Content Folder” on page 7.

Open Custom Content Folder
Opens your custom content folder in Explorer (Windows) or 
Finder (Mac)
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Comparison

The differences between Anime Studio Debut and Pro

Feature Comparisons

Feature Anime 
Studio Debut

Anime 
Studio Pro

Animation Length 2 minutes (3000 
frames)

Unlimited

Motion Tracking 3 points Unlimited

Audio Tracks 2 tracks Unlimited

Video Tracks 1 track Unlimited

Physics No Yes

Poser scene import No Yes

3D layer and object support No Yes

Morph targets Read Only Read and 
create

Automatic image tracing Black and white 
only

Black and 
white, color, 
and edges

Particles Read only Read and 
Create

Import Photoshop Files Yes (1) Yes (2)

Real-time media connection No Yes

Patch Layers Read only Read and 
create

3D Video rendering No Yes

Global Rendering Styles No Yes

Scripting No Yes

Layer Outline Yes Yes

64-bit Architecture No Yes

GPU Acceleration No Yes

Wacom Multi-Touch Support Yes Yes

Character Wizard Yes Yes

Render Cache Yes Yes

Separate Batch Export Process No Yes

Separate Render Process No Yes

Preview Animation No Yes

Multiple Document Support 
(Tabs)

Yes Yes

Keyboard Shortcut Editor Yes Yes

Automatic Update Checking Yes Yes

Activation, Serialization, and 
License Management

Yes Yes

(1) Layered using Anime Studio script

(2) Import directly through File menu.
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Window Menu

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Tools X X

Beginner Mode Tools X

Layers X X

Timeline X X

Style X X

Actions X

Library X X

Audio Recording X X

Poser Parameters X

Character Wizard X X (1)

(1) Character Wizard in Pro lets you use and create 
reusable actions that can be applied to any character 
created with the Wizard.

Vector Drawing Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Text X X

Select Points X X

Transform Points X X

Add Point X X

Hide/Show Points X X

Delete Edge X X

Curvature X X

Freehand X X

Multi-brushes X X

Blob Brush X X

Eraser X X

Rectangle X X

Oval X X

Arrow X X

Shear Points X X

Shear Points Y X

Perspective Points H X

Perspective Points V X
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Bend Points H X

Bend Points V X

Noise X

Magnet X

Snap to Grid X

Reset Line Width X

Random Line Width X

Variable Width Curve X X

Vector Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Peak X X

Smooth X X

Flip Points Horizontally X X

Flip Points Vertically X X

Fill Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Select Shape X X

Select Multiple Shapes X X

Create Shape X X

Paint Bucket X X

Delete Shape X X

Line Width X X

Hide Edge X X

Stroke Exposure X

Curve Profile X

Texture Transparency X

Fill Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Lower Shape X X

Raise Shape X X
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Bone Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Select Bone X X

Transform Bone Tool (Translate, 
Scale, and Rotate)

X X

Add Bone X X

Hide/Show Bones X X

Reparent Bone X X

Bone Strength X X

Manipulate Bones X X

Bind Layer X X

Bind Points X X

Offset Bone X X

Bone Physics X

Bone Constraints X

Smart Bones X

Smart Bones Setup X

Color Bones X X

Bone Labels X

Nested Layer Controls X X

Layer Features
Feature Anime 

Studio 
Debut

Anime 
Studio Pro

Set Origin X X

Transformation X X

Switch Layer X X

Rotate Layer X X

Rotate Layer Y X

Shear Layer X X

Shear Layer Y X

Particle Layer X

Follow Path X X

Poser X (1)

Image Masking X X

Video Tracking X (2) X

Audio Layers X (3) X

Layer Selector X X

Undo/Redo Layers X X

Layer Comps X

Layer Colors X X

Flexi Binding X X
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Depth Shifting X

Fade Unselected Layers X

Multiple Layer Editing X X

Colorize Layer X X

(1) Requires Poser 7 or newer

(2) Limited to 3 tracking points

(3) Limited to 2 audio layers

Layer Modifiers

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Flip Layer Horizontally X X

Flip Layer Vertically X X

Layer Types

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Vector X X

Image X X

Bone X X

Switch X X

Group X

Particle X

3D X

Physics (Layer property) X

Note X

2D to 3D Layer Conversion X

Patch X

Text Layer X X

Camera Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Track Camera X X

Zoom Camera X X

Roll Camera X X

Pan/Tilt Camera X
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Workspace Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Pan Workspace X X

Zoom Workspace X X

Rotate Workspace X

Orbit Workspace X

Depth of Field X

Timeline Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Keyframes X X

Playback Controls X X

Animation Channels X X

Ruler X X

Onionskins X

Graph Mode X

Smooth Interpolation X

Linear Interpolation X

Ease In/Out Interpolation X

Bezier Interpolation X

Step Interpolation X

Noisy Interpolation X

Bounce Interpolation X

Elastic Interpolation X

Stagger Interpolation X

Sequencer X X

Keyframe Hold Duration X X

Colored Keyframes X X

Action Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Store Reusable Animation X

Edit Reusable Animation X

Delete Reusable Animation X
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Style Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Save Style X

Pattern Brush X (1) X

Blur X X

Threshold X X

(1) Pro version contains more brushes

Preferences

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Options X X

Editor Colors X X

GUI Colors X X

GUI Color Themes X X

Project Settings

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Save Project Settings X X

Edit Dimensions X X

Background Color X X

Depth of Field X

3D Camera X

Stereo Rendering X

Sort Layers by Depth X X

Sort by True Distance X X

Noise Grain X

Up to 120 Frames/Second 
Maximum

X X

Maximum export size (pixels) 900 x 900 9000 x 9000

Maximum number of frames 3000 Unlimited
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Content

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Built in Content X X

Third Party Content X X

3D Object X

Character Wizard X X

Scripts

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

3D X

Camera X

Draw X

Image Sequences X

Layer Effects X

Particle Effects X

Sound X

Warp X

Visibility X

Script Writing X

View

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Grid X

Adjust Grid Size X

Side by Side View X

Over Under View X

Four-Way View X

Display Quality X

Advanced Current Layer View X

Import

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

2D FORMATS
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JPEG X X

BMP X X

PSD X (1) X (2)

PNG X X

TGA X X

EPS, AI, Tracing Image X

3D FORMATS
OBJ X

Poser Files and Scenes (Poser 7 
and newer)

X

SOUND FORMATS
WAV (Windows & Mac) X X

AIFF (Windows & Mac) X X

MP3 (Windows & Mac) X X

M4A (MPEG-4) X X

MOVIE FORMATS
MOV (Mac and Windows) X X

AVI (3) X X

MP4 Video X X

MOHO FORMAT
MOHO File Format X X

(1) Layered using Anime Studio script.

(2) Directly through File menu.

(3) AVI Import works on Windows, and on Macintosh 
systems depending on codecs. If you can play the AVI file 
in QuickTime on a Mac, you should be able to import it into 
Anime Studio.

Export Formats

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

IMAGE FORMATS
JPEG X X

BMP X X

PSD (Layered) X

PNG X X

TGA X X

Batch Image Export X

MOVIE FORMATS
SWF (1) X X

MOV (Macintosh and Windows) 
(2)

X X

AVI (Windows) X X
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MP4 X X

Sequential JPEG X

Sequential BMP X

Sequential PSD X

Sequential PNG X

Sequential TGA X

Batch Movie Export X

TV FORMATS
NTSC Format X X

PAL X X

HD movies X

(1) SWF: Vector animations only; image layers can be used 
as long as they are not warped by bones. See “Exporting 
Flash” on page 245 for more information.

(2) MOV: If you are using a 64-bit Windows operating 
system, you will need to use the 32-bit version of Anime 
Studio Pro to export in MOV format.

Upload Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

Upload to Facebook® X X

Upload to YouTube™ X X

Optimization Features

Feature Anime 
Studio 
Debut

Anime 
Studio Pro

64-bit Architecture X

GPU Acceleration X

Render Cache X X

Separate Batch Export Process X

Separate Render Process X

Preview Animation X

Multiple Document Support 
(Tabs)

X X

Keyboard Shortcut Editor X X

Automatic Update Checking X X

Activation, Serialization, and 
License Management

X X
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Support

User Manual
The first source of help when using Anime Studio is the 
manual that you are reading now. We have also included 
a Tutorial Manual that you can view by choosing Help > 
Tutorials from the Anime Studio menus. If you’re just getting 
started and need some basic tips on how to use Anime 
Studio, begin with “Quick Start” on page 3 in your 
Anime Studio Tutorial Manual.

For more in-depth instructions on using Anime Studio, the 
sections “Anime Studio Windows” on page 119 and 
“Anime Studio Menus” on page 229 go into great detail 
about performing specific tasks in Anime Studio and what 
all the user interface elements are used for, respectively.

Anime Studio on the Web
Another good source is the Smith Micro web site at http://
anime.smithmicro.com. There you will find product 

information and a variety of tutorials. We plan to keep this 
updated with questions and answers and new sample files.

To view in-depth product descriptions, online video gallery, 
and more, visit http://anime.smithmicro.com.

Anime Studio Discussion Forum
Share tips and tricks with other Anime Studio users on the 
online discussion forum: http://www.lostmarble.com/
forum/. Smith Micro staff members also participate in this 
online group, and are happy to share techniques and 
answer questions. News about the latest Anime Studio 
updates is first posted to the online forum.

Email Support
You can also get your questions answered by email. If you 
have a question, feature request, or would like to report a 
bug, contact us at cs@smithmicro.com. Please provide us 
with as much detail about your problem as possible, so that 
we can understand exactly what’s happening and more 
quickly come up with a solution for you.

http://anime.smithmicro.com
http://anime.smithmicro.com
http://anime.smithmicro.com/
http://www.lostmarble.com/forum/
http://www.lostmarble.com/forum/
mailto:cs%40smithmicro.com?subject=


Anime Studio Debut 10
Users Manual

296

Appendix C: Acknowledgements

Appendix C: 
Acknowledgements

Some parts of Anime Studio are based on libraries written 
by third party organizations. Below is a list of libraries used 
by Anime Studio.

• Anti-Grain Geometry http://www.antigrain.com 
Copyright © 2002-2004 Maxim Shemanarev (McSeem).

• FreeType http://www.freetype.org Portions of this 
software are copyright © 1996-2002 The FreeType 
Project. All rights reserved.

• libjpeg http://www.ijg.org This software is based in 
part on the work of the Independent JPEG Group. 
Copyright © 1991-1998, Thomas G. Lane.

• libpng http://www.libpng.org Copyright © 1998, 1999, 
2000 Glenn Randers-Pehrson.

• libsndfile http://www.mega-nerd.com/libsndfile/ 
Copyright © 1999-2005 Erik de Castro Lopo.

• Lua http://www.lua.org Copyright © 2004 Tecgraf, 
PUC-Rio.

• Ming http://www.libming.org/ Copyright © 2001 
Opaque Industries.

• PortAudio http://www.portaudio.com Copyright © 
1999-2000 Ross Bencina and Phil Burk

• zlib http://www.zlib.net Copyright © 1995-2002 Jean-
loup Gailly and Mark Adler.

Artist Acknowledgements
Smith Micro and Lost Marble would like to thank the 
following artists for contributing to the content section. To 
access these files, open Window > Library and navigate to 
a “Partners” Folder. Their creations will be displayed within 
a folder with their name as the title.

• DK Toons http://www.contentparadise.com/Search.
aspx?searchText=DKToons

• Cartoon Solutions http://www.cartoonsolutions.com

• ToonProps http://www.toonprops.com

• Víctor Paredes (Studio: Taza Triste): http://www.
youtube.com/tazatriste

http://www.antigrain.com
http://www.freetype.org
http://www.ijg.org
http://www.libpng.org
http://www.mega-nerd.com/libsndfile/
http://www.lua.org
http://www.libming.org/
http://www.portaudio.com
http://www.zlib.net
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.cartoonsolutions.com
http://www.toonprops.com
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• Hubumedia http://www.hubumedia.com (tweet: 
www.twitter.com/hubumedia)

• Charles Kenway (Studio: Square Brush): http://
squarebrush.com/

• The Pirate, Monster, Monster and Rabbit was Illustrated 
by Óscar Chávez: http://www.flickr.com/chavezonico

• The Carnivorous Plant was illustrated by Alfredo 
Cáceres: http://Alfredocaceres.tumblr.com

• The Pirate, Monster, Monster, Rabbit and Carnivorous 
Plant rigging and animation was made by Víctor 
Paredes: http://www.youtube.com/tazatriste

• The Smith Micro Content Team

Smith Micro would like to thank the following artists for 
imagery used in collateral and Promos.

• DK Toons http://www.contentparadise.com/Search.
aspx?searchText=DKToons

• Cartoon Solutions http://www.cartoonsolutions.com

• Cartoon Workshop Sdn Bhd: http://www.
cartoonworkshop.com.my

• ToonProps http://www.toonprops.com

• Hubumedia http://www.hubumedia.com (tweet: 
www.twitter.com/hubumedia)

• TUI Studios http://www.tuistudios.com

• Freakish kid http://www.freakishkid.com

• Naive: http://www.naive.se

• Mike Scott Animation http://www.909pop.com

• Curious Projects: http://www.curiousprojects.com

• Dave Cockburn’s Squeaky Pictures: http://www.
squeakypics.co.uk/

• Charles Kenway (Studio: Square Brush): http://
squarebrush.com/

• Víctor Paredes (Studio: Taza Triste): http://www.
youtube.com/tazatriste

Content Acknowledgements
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http://squarebrush.com/
http://www.flickr.com/chavezonico
http://Alfredocaceres.tumblr.com
http://www.youtube.com/tazatriste
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.contentparadise.com/Search.aspx?searchText=DKToons
http://www.cartoonsolutions.com
http://www.toonprops.com
http://www.hubumedia.com
http://www.tuistudios.com
http://www.freakishkid.com
http://www.909pop.com
http://www.squeakypics.co.uk/
http://www.squeakypics.co.uk/
http://squarebrush.com/
http://squarebrush.com/
http://www.youtube.com/tazatriste
http://www.youtube.com/tazatriste
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Appendix D: Anime 
Studio Shortcuts

How to Work Quickly in Anime 
Studio
Once you’ve been using Anime Studio for a while, you’ll 
probably want to find ways to speed up certain operations. 
Luckily, Anime Studio provides several shortcuts for 
common operations, such as activating tools, navigating 
the workspace, and entering data.

Menu Shortcuts

File Menu

Windows Mac Command
Ctrl+N Cmd+N File > New

Ctrl+O Cmd+O File > Open

Ctrl+W Cmd+W File > Close

Ctrl+S Cmd+S File > Save

Ctrl+Shift+S Shift+Cmd+S File > Save As

Ctrl+Alt+G File > Gather Media

Shift+Ctrl+P Shift+Cmd+P File > Project Settings

Ctrl+R Cmd+R File > Preview

Ctrl+E Cmd+E File > Export Animation

Ctrl+Q Cmd+Q File > Quit

Edit Menu

Windows Mac Command
Ctrl+Z Cmd+Z Edit > Undo

Shift+Ctrl+Z Shift+Cmd+Z Edit > Redo

Ctrl+X Cmd+X Edit > Cut

Ctrl+C Cmd+C Edit > Copy

Ctrl+V Cmd+V Edit > Paste

Ctrl+A Cmd+A Edit > Select All
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Ctrl+I Cmd+I Edit > Select Inverse

Draw Menu

Windows Mac Command
Ctrl+T Cmd+T Draw > Insert Text

Ctrl+P Cmd+P Draw > Peak

Ctrl+M Cmd+M Draw > Smooth

Shift+Ctrl+H Shift+Cmd+H Draw > Hide Shape

Shift+Ctrl+U Shift+Cmd+U Draw > Show All Shapes

Ctrl+F Cmd+F Draw > Freeze Points

Bone Menu

Windows Mac Command
Ctrl+Shift+F Shift+Cmd+F Bone > Use Selected Bones 

for Flexi-Binding

Ctrl+Shift+Y Shift+Cmd+Y Bone > Freeze Pose

View Menu

Windows Mac Command
Ctrl+J Cmd+J View > Show Output Only

Window Menu

Windows Mac Command
Ctrl+[ Cmd+[ Window > Timeline

Ctrl+] Cmd+] Window > Style

Shift+Ctrl+L Shift+Cmd+L Window > Library

Shift+Ctrl+B Shift+Cmd+B Window > Blend Morphs

Shift+Ctrl+I Shift_Cmd+I Layer Settings

Keyboard Shortcuts
Many tools and features in Anime Studio can be accessed 
quickly by pressing a single key. These shortcuts make 
working with Anime Studio much faster than the regular 
method of moving the mouse to a toolbar and clicking 
a button, and are worth learning to reduce your drawing 
and animation time. However, all these features are 
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also available through standard user interface elements 
(buttons and menus), so learning these shortcuts isn’t a 
requirement to using Anime Studio.

These shortcuts are not the same as “menu 
shortcuts” listed above.

Main Window

Windows Mac Function
Alt+Shift+Ctrl+E Alt+Shift+Cmd+E Open/Close Tools Palette

Alt+Shift+Ctrl+K Alt+Shift+Cmd+K Open/Close Layers Palette

Alt+Ctrl+[ Alt+Cmd+[ Open/Close Timeline

Alt+Ctrl+] Alt+Cmd+] Open/Close Style Window

Alt+Shift+Ctrl+L Alt+Shift+Cmd+L Reload Tools and Brushes

Shift+Z Shift+Z Activate Previous Tool

Main/Current Editing View

Windows Mac Function
Alt+Shift+{ Alt+Shift+{ Rotate View Left

Alt+Shift+} Alt+Shift+} Rotate View Right

Style Window

Windows Mac Function
] ] Decrease Line Width

[ [ Increase Line Width

Timeline Shortcuts

Windows Mac Function
Ctrl+1 Cmd+1 Set Interpolation Linear

Ctrl+2 Cmd+2 Set Interpolation 
Smooth

Ctrl+3 Cmd+3 Set Interpolation Ease 
In/Out

Ctrl+4 Cmd+4 Set Interpolation Ease In

Ctrl+5 Cmd+5 Set Interpolation Ease 
Out

Ctrl+6 Cmd+6 Set Interpolation Bezier

Ctrl+7 Cmd+7 Set Interpolation Step

Ctrl+8 Cmd+8 Set Interpolation Noisy

Ctrl+9 Cmd+9 Set Interpolation Cycle

Shift+{ Shift+{ Previous Selected Key

Shift+} Shift+} Next Selected Key

Alt+Shift++(plus) Alt+Shift++(plus) Zoom In
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Alt+Shift+_
(underscore)

Alt+Shift+_
(underscore)

Zoom Out

Shift+Ctrl+=(equal) Shift+Cmd+=(equal) Pan Up

Shift+Ctrl+-(minus) Shift+Cmd+-(minus) Pan Down

Shift+~(tilde) Shift+-(tilde) Auto Zoom

Tool Shortcuts
Many of the keyboard shortcuts in Anime Studio are used 
to activate a tool in a toolbar. If you want to know whether 
a tool has a shortcut, hold the mouse over the tool, and 
watch the tooltip that appears. If the tooltip has a single 
letter at the end (ex: “Transform Points (T)”), then that key 
can be used as a shortcut to activate the tool.

The keyboard shortcut of Shift-Z toggles 
between the currently selected tool and the 

previous tool selection.

Anime Studio auto-reverts to the previous tool 
selection when a shortcut for a different tool is 

selected and held for two or more seconds, or if held 
and a mouse click occurs on the canvas before the 
shortcut is released.

 Press the T key to activate the Transform Points tool.

Draw Tools

Tool 
Shortcut

Tool

G Select Points

T Transform Points

A Add Point

F Freehand

J Blob Brush

S Draw Shape

E Eraser

R Point Reduction

D Delete Edge

C Curvature

X Magnet
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Fill Tools

Tool 
Shortcut

Tool

Q Select Shape

U Create Shape

P Paint Bucket

W Line Width

H Hide Edge

Special Tools

Tool 
Shortcut

Tool

A Video Tracking

Bone Tools

Tool 
Shortcut

Tool

B Select Bone

T Transform Bone

A Add Bone

P Reparent Bone

S Bone Strength

Z Manipulate Bones

I Bind Points

Layer Tools

Tool 
Shortcut

Tool

M Transformation

0 (number) Set Origin

L Eyedropper

Camera Tools

Tool 
Shortcut

Tool

4 Track Camera

5 Zoom Camera

6 Roll Camera

7 Pan/Tilt Camera

Workspace Tools

Tool 
Shortcut

Tool
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8 Rotate Workspace

9 Orbit Workspace

Common Shortcuts
Some keyboard shortcuts work all the time, and some 
only apply in while using certain tools in Anime Studio: the 
sections below lists all the shortcuts and when they can be 
used.

The following keyboard shortcuts can be used at any time:

Keyboard 
Shortcut

Function

Escape Automatically adjust the view to see everything in 
the active layer - hold the shift key to zoom in on 
the currently selected points

Home Reset the view to see the overall project

Enter/Return De-select all points

Tab Select all points that are connected to the current 
selection

Left Arrow Step back one frame in the timeline - hold shift 
to rewind

Right Arrow Step forward one frame in the timeline - hold shift 
to advance to end of animation

Left Bracket [ Decreases the line width setting in the Style 
window

Right Bracket ] Increases the line width setting in the Style window

Working with Vector Layers

Keyboard 
Shortcut

Function

Delete/
Backspace

Delete the currently selected points

Spacebar Weld two points together - usually used with the 
Translate or Add Point tools

Working with Fill Tools

Keyboard 
Shortcut

Function

Delete/
Backspace

Delete the selected shape

Spacebar Define a shape based on current selection

Up Arrow Raise selected shape up one level - hold shift to 
raise to top

Down Arrow Lower selected shape down one level - hold shift 
to lower to bottom
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Working with Bone Tools

Keyboard 
Shortcut

Function

Delete/
Backspace

Delete the selected bone (and any child bones)

Spacebar Bind points to selected bone

Up Arrow Select parent of current bone

Down Arrow Select child of current bone (only works if current 
bone has just one child)

Working with the Timeline Window

Keyboard 
Shortcut

Function

Alt/
Option+Backspace

Delete the selected keyframe(s)

Alt/Option+C Copy the selected keyframe(s)

Alt/Option+V Paste the previously copied keyframe(s)

Spacebar Play/stop the animation

Page Up When in graph mode, zoom in on the timeline 
- hold shift to move the graph up

Page Down When in graph mode, zoom out from the 
timeline - hold shift to move the graph down

End: Auto-zoom the timeline, based on the active 
animation channel (when in graph mode)

Working in the Layers WIndow

Keyboard 
Shortcut

Function

Alt-Click If you Alt-Click a layer in the Layers window, 
it will hide all of the other layers and keep the 
layer that you clicked visible. Alt-Click again to 
display all layers again.

Mouse Shortcuts
There are a few shortcuts that take advantage of the 
mouse, making work in Anime Studio more convenient 
once you learn them.

Workspace Navigation
The right mouse button can be used to navigate the main 
Anime Studio workspace.

To pan the workspace, click and drag with the right mouse 
button.

• If you hold down the spacebar while you click 
and drag any tool with the mouse, it will let you 

pan the workspace. This is similar to the panning 
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navigation in Photoshop and other graphics 
applications.

• To zoom the workspace, hold the shift key while 
dragging left or right with the right mouse button. You 
can also zoom the workspace by rolling the mouse 
wheel back and forth over the workspace.

• To rotate the workspace, hold down the control key 
while dragging with the right mouse button.

• To fit the view to a selected layer, select the layer that 
you want to view in the Layers window. Then press the 
Esc key to fit the selected layer into the view.

Timeline Scrubbing
To scrub the timeline in small increments, press Alt and roll 
the mouse wheel back and forth.

Numeric Fields and Angle Knobs
An easy way to make small adjustments in numeric text 
fields and angle knobs is to hold the mouse over the control 
and spin the mouse wheel back and forth. Of course, you 
can still enter values into a text field by typing them, but 

this method lets you make small adjustments and view the 
changes immediately.

• On a Windows PC, when using the mouse wheel 
to modify the value in a text field, holding the Ctrl 
key halves the increment, holding Shift doubles the 
increment.

• On a Macintosh, when using the mouse wheel to 
modify the value in a text field, holding the Cmd 
key halves the increment, holding Alt doubles the 
increment.

This feature may seem cute but unimportant. However, 
it’s actually very useful when working with the tool info 
panels in Anime Studio. By using the mouse wheel, you can 
see your changes take effect immediately. If you enter 
the number by hand, the change won’t take effect until 
you press tab or enter. An especially helpful place to use 
this feature is when setting bone angle constraints - these 
numbers can be tricky to figure out, but spinning the mouse 
wheel you can see exactly what’s happening.

Finally, you can adjust the value of a text field by dragging 
in it side-to-side with the right mouse button. With a regular 
mouse, the mouse wheel is probably more convenient, but 
this feature was added specifically for animators working 
with tablets. A drawing pen usually has no mouse wheel, so 
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right-dragging allows you to adjust the value of a text field 
without having to switch back to the keyboard.

Multi-touch Support
Certain tools support Wacom multi-touch tablets and allow 
you to use multi-touch gestures to perform tasks in Anime 
Studio. Red screen dots on screen identify the location 
of your fingers on the tablet. The following general notes 
apply to multi-touch features:

Use the Multitouch checkbox (located above 
the Timeline on the left side) to enable or 

disable Multitouch support.

If you experience problems accessing 
Wacom touch support, you should make sure 

you have the latest drivers installed, and restart 
Anime Studio or your computer if needed.

If the currently selected tool does not support multi-
touch, then the multi-touch events will be used to 
navigate the workspace.

• Multi-touch events can be used for workspace 
navigation, regardless of whether or not the current 
tool supports multi-touch events. Hold down the 
spacebar while using the multi-touch tablet to use it for 
workspace navigation.

• Smoothing and zooming support has been enhanced 
to support multi-touch actions, and should also work 
better with the touch ring on Wacom tablets.

The following tables outline the tools that offer this support.

Draw Tools

Draw tools that support multi-touch actions are Transform 
Points, Transform Points, Transform Points, Select Points, 
Freehand, and Draw Shape.

Multi-touch 
action

Function

One finger gesture Translates selected points

Two-finger gesture Scales or rotates selected points

More than two 
fingers

Behaves similarly to two-finger gestures

Layer Tools

The Transform Layer tool supports multi-touch actions.
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Multi-touch 
action

Function

One finger gesture Translates selected layer

Two-finger gesture Scales or rotates selected layer

More than two 
fingers

Behaves similarly to two-finger gestures

Four-finger drag Allows you to rotate an object in 3D

Camera Tools

Camera tools that support multi-touch actions are Track 
Camera, Roll Camera, and Zoom Camera.

Multi-touch 
action

Function

One finger gesture Tracks or Pan/Tilts camera

Two-finger gesture Rolls or zooms camera

More than two 
fingers

Behaves similarly to two-finger gestures

Workspace Tools

Workspace tools that support multi-touch actions are Pan 
canvas.

Multi-touch 
action

Function

One finger gesture Pans the canvas

Two-finger gesture Scales or rotates the canvas

More than two 
fingers

Behaves similarly to two-finger gestures

Five fingers down 
on tablet

Resets the canvas.

Other Actions

Multi-touch 
action

Function

Two-finger 
double-tap

Resets whatever property you are currently 
editing.
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3D Shadows  143

A
Acknowledgements  296
Add Bone Tool  70
Add Point Tool  33
Ambient occlusion  134
Animation channels  217
Animation Menu Commands  

267
Align Layer with Camera  268
Audio Level  271
Blend Morphs  275
Clear Animation  270
Copy Current Frame  269
Rescale Keyframes  268
Reset All Layer Channels  267, 268
Restart Audio Track  271
Select All Keyframes  268
Set Layer Start Time  267
Track Layer to Video  271

Animations
Exporting  240

Anime Studio Discussion Forum  
295

Anime Studio Web Support  295
Applied Styles  178
Arrows  41
Audio Recording  227
Audio Sync Sources  159
Automatic Update Checking  11
Auto shading  134

B
Background color  235
Beginner Mode  9
Bind Layer Tool  73
Bind Points Tool  74
Bone Menu Commands  263

Flexi-Bind Layer  264
Flexi-Bind Points  264
Freeze Pose  265
Hide Controlled Bones  265
Release Layer  264
Release Points  264
Reset All Bones  266
Reset Bone  266
Track Bone to Video  265

Bone-Only Channels  219
Bone Strength Tool  72
Bone Tools  65

Bonus Content  7
Downloading  279

Brush Tool  42

C
Camera Channels  218
Camera movements

Layers immune to  138
Camera Tools  116
Category Icons  183
Character Wizard  191

Arms  196
Body Tab  194
Changing character views  192
Clothing Tab  202
Exporting views  193
Eyes  199
Face Tab  197
Head props  200
Legs  196
Making a character walk  206
Mouth  199
Movement Tab  200
Nose  199
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Shirt  203
Style Tab  203
Walk Cycles  204

Checker Selection  181
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Color Swatch  179, 180
Compositing Effects  133
Content Folder

Creating  7
Maintaining  186

Content Paradise  7
Create Shape Tool  51
Curvature Tool  35

D
Delete Edge Tool  41
Delete Shape Tool  58
Depth of field

Layers immune to  138
Draw Menu Commands  258

Freeze Points  262
Freeze Selected Points  262
Hide Shape  262
Lower Shape  259
Lower to Back  259
Peak  258
Raise Shape  258
Raise to Front  259
Reset All Points  262
Reset Points  262
Show All Shapes  262
Smooth  258

Draw Shape Tool  39

Draw Tools  25
Drop Shadow  173

E
Edit Menu Commands  250

Clear  251
Copy  250
Cut  250
Paste  250
Preferences  251

Options Tab  252
Web Uploads  255

Redo  250
Select All  251
Select Connected  251
Select Inverse  251
Select None  251

Effects Tutorials  191
Email Support  295
Embedded script files  138
Eraser Tool  44
Exporting

Still images  249
Eyedropper Tool  59

F
Facing a camera  139
File Menu Commands  230

Close  231
Gather Media  232
Import  236
Open  231
Open Recent  231
Preview  239
Save  231
Save As  232
Upload to Facebook  249
Upload to YouTube  249

Fill Color Override  168
Fill Color Selector  167
Fill effects  168
Fill Enable  167
Fill Properties  167
Fills

Picking colors  62
Using two  63

Fill Tools  48
Flash

Exporting  245
Flip horizontally  135
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Follow Curve Tool  91
Following a path  138
Freehand Tool  36
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Halo Fill Effects  171
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About Anime Studio Debut  279
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Register Your Product  278
Upgrade to Professional Version  

280
Welcome Screen  278

Hide Edge Tool  60
Hold Durations  223
HSV modifier images  138

I
Image Layers  78
Image Texture Fill Effects  172
Insert Text Tool  95
Introductory Tutorials  7

K
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Bone Tools  304
Common  303
Fill Tools  303
Timeline Window  304
Vector Layers  303

Keyframes  219
Adding  220
Coloring  222
Deleting  221
Editing multiple  222
Hold durations  223
Moving  221
Selecting  220
Transitions  223

L
Layer blending  140
Layer blur radius  134
Layer Effect Channels  218
Layer List  125
Layer Motion Channels  217
Layer opacity  134
Layers

Animated effects  132
Colorizing  137
Creating new  127
Deleting  127
Duplicating  127
Hiding  132

Naming  132
Rendering off  132
Settings  128

Layer Settings
Bones Tab  160
Depth Sort Tab  154
General Tab  129, 131
Image Tab  155
Masking Tab  146
Motion Blur Tab  145
Shadows Tab  141
Switch Tab  159
Vectors Tab  152

Layer Shading  142
Layer Shadows  142
Layers Window  125

Shortcuts  304
Layer Toolbar  127
Layer Tools  87
Layer Types  76
Library Tabs  183
Library Window  182

Adding an item to Favorites  183
Adding items to Favorites  184
Adding items to scene  183, 184
Adding items to the Library  187
Categories  185
Collapsed folders  183
Content previews  183
Creating new folders  184
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Deleting items  187
Deleting items from library  184
Displaying and hiding  183
Expanded folders  183
Favorites Tab  189
Loading items  184
Saving items to library  184
Saving items to Library  183
Searching  188
Selected item  183

Line Width Tool  59

M
Manipulate Bones Tool  73
Markers

Fine-tuning  107
Masking

Tips and Tricks  148
Motion Graph  227
Mouse Shortcuts  304

In Angle knobs  305
In numeric fields  305
Timeline Scrubbing  305
Workspace Navigation  304

Move Layer Tool  87, 90
Multiple layers

Editing  129
Multi-touch support  306

O
Offset Bone Tool  74
Origins

Offsetting  114
Outline  135
Ovals  40

P
Paint Bucket Tool  54
Pan Workspace Tool  117
Particle-Only Channels  219
Playback Buttons  123
Point Reduction Tool  45
Points

Translating  30
Preferences  251
Product Comparison  285
Project Settings  233

R
Rectangles  40
Registration  7
Reparent Bone Tool  71
Roll Camera Tool  117
Rotate Points Tool  33

Rotating to face camera  139
Rotating to follow path  138
Round End Caps  178

S
Scale compensation  138
Scale Points Tool  32
Scatter Brush Tool  46
Select Bone Tool  65
Select Points Tool  26
Select Shape Tool  48
Sequencer  224
Set Origin Tool  90
Shaded fill effects  169
Shapes

Shape Selection  165
Shortcuts  298
Soft Edge Fill Effects  170
Special tools  103
Spirals  41
Standard Mode  9
Stars  40
Startup Mode  8
Stroke Brush Selector  175
Stroke Color  175
Stroke Enable  174
Stroke properties  174
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Threshold  135
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Animation channels  217
Navigating with mouse  216
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Toolbar  121
Toon Settings  157
Track Camera Tool  116
Tracked Layers

Assigning  112
Tracking Points

Adding  105
Adjusting sensitivity  111

Re-syncing  107
Transformation
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Rotating  90
Scaling  89

Transform Bone  68
Translate Points Tool  29
Triangles  40
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Vector Layers  77
Vector-Only Channels  218
Video Tracking Tool  105
View Menu Commands  272

Show Output Only  272
Visibility in rendering  133

W
Window Menu Commands  274

Audio Recording  275
Layers  274
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Windows
Main Window  120
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Creating  101
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Z
Zoom Camera Tool  117
Zoom Workspace Tool  118


